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1 What is Data Control Tower (DCT)?

Today’s application and data landscape is an increasingly complex ecosystem of hosting architectures, often
represented by a multi-cloud landscape coupled with an explosion of different platforms and services. This
fragmented picture of heterogeneous silos makes data governance, automation, and compliance a herculean, if
not, an impossible task.

Multicloud Increases Data Complexity, Risk

Every cloud offers proprietary point solutions with differing functionality, APls

On Premises Cloud
Private Datacenter SaaS, PaaS, laaS

—: | & aws A 3

Data Monolithic, Siloed Apps DataPlex
Governance and Data Sources SFDC Platform AWS DataZone Azure AD Data Catalog
Data Manual, Ticket-Driven GCP DM
Automation Workflows Sandbox AWS DMS Redgate e
Data i 5 ic i
) SR, SHELE DataMask AWS DDM Purview ElfEiy
Compliance Infrastructure Masking

Data Control Tower (DCT) is an enabling Delphix platform that introduces a data mesh to unify data governance,
automation, and compliance across all applications and cloud platforms.

Data governance is achieved through operational control and visibility of test data across multicloud applications,
databases, environments, and releases. DCT brings data cataloging, tagging, and data access controls for central
governance of all enterprise data, while providing the right data at the right time to development teams.

Data automation at Cl/CD speed and enterprise scale is easier and more powerful, by combining DCT with
Continuous Data. A unified API gateway, self-service automation tools, and plug-and-play DevOps integrations
streamline the initial configuration and day-to-day workflows.

DCT with Continuous Compliance provides robust data compliance in lower environments, all while reducing
costs and enabling fast, quality software development.
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2 Release notes

This section is used to learn what the newest version of Data Control Tower has to offer. In addition, the fixed and
known issues per version are detailed.

2.1 New features

2.1.1 Release9.0.0

Jenkins support

An official Jenkins plugin is now available for Data Control Tower, joining the existing ServiceNow and
Terraform integrations. This plugin helps automate the use of data in your CI/CD pipelines and includes
support for provisioning and destroying VDBs.

DCT Toolkit

We’ve launched a new command line interface (CLI) offering, the DCT Toolkit. The DCT Toolkit allows for
remote operation and control of Data Control Tower via your local terminal. Over time, this will replace the
previously available DxToolkit.

Infrastructure wizard

The create infrastructure flow now supports adding Windows standalone and cluster hosts, as well as Linux
cluster hosts. This is expanded from the previous flow that supported standalone Linux hosts. This differs
from the workflow on the Continuous Data engine in that it represents a single place to create environment
host connections for all connected Delphix engines.

Provisioning wizard

The data provisioning workflow now includes additional database types, including Oracle Single Instance
Multi-tenant, Oracle Multiple Instance Single Tenant, and SQL Server Multiple Instance Single Tenant.
Operations dashboard improvements

Previously, all users could view all operations run by any user on the Operations page. Role-based access
can now be provided to different users, showing only operations the user has access to. Simplified text is
now used to define the Type column, as well as the Type and Engine Name in the details page.

Activity Audit Log Summary report

The Activity Audit Log Summary provides a high-level audit log summary capturing the utilization of DCT by
displaying user activity and the historical count of actions executed within the platform.

Replication mappings

This feature helps users differentiate between replicated objects and original objects, in the case of parent
and replicated engines, both are registered with DCT.

2.1.2 Release 8.0.0

Operations dashboard

Monitor and manage enterprise data activities in real time using a new central view. This provides visibility
to the current status across the full complement of Delphix transactions, including provision, refresh,
teardown, and compliance jobs.

Provisioning wizard enhancements

The data provisioning wizard has been expanded to support additional types, including Oracle Single
Instance Linked CDBs and Microsoft SQL Server Single Instance workflows. This will now allow you to
provision more data types directly from Data Control Tower.

Advanced search tags support

The advanced search capabilities now support all user-generated tags. You can use personalized tags
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related to your unique business needs to refine your search results, such as team names or other specific
data points.

2.1.3 Release 7.0.0

Provision VDB Ul

Extending the Developer Experience capability in DCT, users can now provision single-tenant Oracle
databases from the user interface using an intuitive wizard workflow.

Refresh VDB Ul enhancements

The VDB list can now be opened in a searchable, paginated list selector from within a dialog by clicking
the select button in the input. Additionally, refreshing a VDB by a bookmark is now available.

VDB template import

Importing and removing imported VDB templates from connected engines is now an available action from
the "VDB Config Templates" page.

Environment details enhancements

Managing cluster environment infrastructure has been made easier with the ability to edit host details
directly from the page.

2.1.4 Release 6.0.0

Developer Self-Service Ul

Developers and admins now have the ability to centrally orchestrate common Continuous Data and
developer operations from the DCT Ul. This includes the ability to refresh, rewind, bookmark, and bookmark
share (refresh to relative). This functionality also exposes the notion of time flows (non-active timelines),
which is a critical tool for viewing past work on a VDB, such as the chronology of test results.

Central compliance orchestration

The compliance job Ul now enables job orchestration and reporting. This includes Job Copy and Execute
functions as well as a complete historical job execution log within each compliance job’s details view.
Bookmark Ul

Developers and admins now have added visibility of bookmarks, both globally and contextualized, to
individual VDBs. These visualizations are dual purpose; for administrators, these screens help with reporting
and tagging on bookmarks, while for developers, these screens act as a catalog of actionable data
references.

Global Bookmark List

View all bookmarks across your entire connected Delphix ecosystem. This screen will show bookmarks for
both single VDBs and VDB groups.

VDB Bookmark List

See all bookmarks tied to this individual VDB. This is helpful for sharing bookmarks with team members who
have a compatible VDB (same parent and provision point).

Environment details page

Users can now orchestrate common environment actions via the DCT Ul including enable, disable,
environment refresh, and delete, as well as editing host details. Note, editing host details is only applicable
to standalone environments at this time.

Access visibility

Object detail pages will include an access tab that provides visibility to user access and the associated
permissions for each user. This is a critical enabler for permissions visibility and auditing.

Copy/delete functionality on role scopes

Scoped roles can now be copied and deleted within the DCT UI. This will enable easier administration,
especially around the use of custom roles, as admins can now copy and modify new roles from templates.
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« External Postgres DB support
DCT now supports the use of an external Postgres database to house DCT metadata. Previously, DCT
supplied and managed its own database, requiring persistent storage within the container platform.

2.1.5 Release5.0.1

2.1.5.1 Enhancements

« Data scoped Access Group
« Enhancementinroles
Associated permissions in roles are changed from 'string' type to 'permission object' type. For details,
see the Role schema in the API References(see page 187).
+ Custom roles
In addition to the 5 pre-seeded fixed roles (Admin, Monitoring, DevOps, Masking, and Owner), DCT
provides flexibility to create new custom roles as per user need. Users (Accounts) can create new
custom roles by encapsulating any combination of permissions. The custom roles can be configured
through a Ul configuration screen (screenshot below), in addition to a set of APIs to manage roles. For
details, see the AP References(see page 187).
« Updates to existing RBAC model
For better usability and allow to set more granular permissions there are following enhancements in the
RBAC model:
+ Renamed Access Group "Policy" to Access Group "Scope"
+ Renamed the following APIs related to Access Group actions
« Add scope to an Access Group

POST: /access-groups/{accessGroupId}/policies — POST /access-
groups/{accessGroupId}/scopes
+ Remove scope from Access Group
DELETE /access-groups/{accessGroupId}/policies/{policyId} -
DELETE /access-groups/{accessGroupId}/scopes/{scopeld}
» Get Access Group scope
GET /access-groups/{accessGroupId}/policies/{policyId} — GET /
access-groups/{accessGroupId}/scopes/{scopeld}
« Update Access Group scope
PATCH /access—-groups/{accessGroupId}/policies/{policyId} -
PATCH /access-groups/{accessGroupId}/scopes/{scopeld}
« Add object tags to Access Group scope
POST /access-groups/{accessGroupId}/policies/{policyId}/object-
tags — POST /access-groups/{accessGroupId}/scopes/{scopeld}/
object-tags
+ Remove object tags from Access Group scope
POST /access-groups/{accessGroupId}/policies/{policyId}/object-
tags/delete — POST /access-groups/{accessGroupld}/scopes/
{scopeld}/object-tags/delete
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+ Add objects to Access Group scope
POST /access-groups/{accessGroupId}/policies/{policyId}/objects

— POST /access-groups/{accessGroupId}/scopes/{scopeld}/objects
+ Remove objects from Access Groups scope
POST /access-groups/{accessGroupId}/policies/{policyId}/objects/

delete — POST /access-groups/{accessGroupId}/scopes/{scopeId}/

objects/delete

« Renamed the "everything" flag to "scope_type"
In order to make it more understandable, we have renamed the everything flag to scope_type. There
are three possible values for scope_type i.e. SIMPLE, SCOPED and ADVANCED. The value SIMPLE
corresponds to everything=true and SCOPED corresponds to everything=false. The value ADVANCED
for scope_type is new enhancement to setting permissions which allows users to set permissions
(e.g. READ, DELETE) for an object. There is more information about ADVANCED scope in next section.
« Access Group Scope: Advanced scope type
In Add objects to access group scope API, now user can define permissions level checks as well for an
object. For example, earlier when object_id and and object_type are provided in request payload, all
permissions that are defined in scope are applied to this object. But now user can define specific
permissions.
Masking jobs
« CRUD APIs, COPY, Connectors CRUD
Masking job execution
« Connector Credentials
« Execution API

2.1.5.2 Custom roles

Accounts can create new instances of role encapsulating any combination of permission.

Role name must be unique.

Custom roles can be updated. Accounts can add or remove permissions to/from the custom roles.
Custom roles can be deleted. (If they are not associated with any Access Group).

2.1.6 Release 4.0

Environment Overview List
Un-virtualized Source Sizing Report
Global VDB Templates

Scoped Access Control

LDAP/AD and SAML/SSO Configuration Ul

2.1.7 Release 3.0

Cluster Node (RAC) management APIs

Ability to disable username/password authentication globally
LDAP/Active Directory groups

CDBs/vCDBs APIs

VDB Provisioning / update for EDSI (AppData) platforms
Engine registration wizard

Access Groups Management Ul
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+ Compliance Engine Management

2.1.8 Release 2.2

2.1.8.1 Deployment
« Introducing Kubernetes and OpenShift support

2.1.8.2 APIs

+ Registration of Continuous Compliance Engines

+ Masking Connectors

+ “Move Masking Job”

+ Masking of mainframe objects

+ Provisioning enhancements for Oracle multi-tenant and RAC

« LDAP/Active Directory authentication

+ Password management

« Initial access management by Permissions, Roles, Policies, and Access Groups (permissions applied to all
objects of a type e.g. Stop VDB permission on all VDBs)

« Distributed tracing and logging (Trace ID propagated down call stack)

+ Bulk delete of tags

2.1.8.3 Ul

« Continuous Data
« Added tag support to the Infrastructure page
« New dSources page
» New VDBs page
« Insights
« Added an export behavior to the Storage Summary report
« New dSource Inventory report
» New VDB Inventory report
+ Admin
» New Accounts page

2.2 Fixed issues

2.2.1 Release 9.0.0 changes

Bug Number Description
APIGW-3772 Replicated VDBs/dSources are now identified in the Provisioning wizard.
APIGW-3931 Fixed a null pointer exception during LDAP configuration without a domain.
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Description

Fixed an issue where the Import VDB Configuration templates dialog was

showing the engine ID in error messages. It is now changed to show engine

APIGW-3983

names.

Fixed an issue where a new masking job could not be started from DCT

when the previous job was cancelled on the masking engine.

APIGW-4009

APIGW-4010

2.2.2 Release 8.0.1 changes

Bug Number

APIGW-4324

APIGW-4317

2.2.3 Release 8.0.0 changes

Bug Number

APIGW-3764

APIGW-3771

APIGW-3783

APIGW-3985

APIGW-3990

Fixed an issue where the first and last name will be cleared if incorrect
names were entered for SSO.

Fixed an issue in the Ul where first and last name attributes cannot be reset.

Description

Fixed an issue where users who upgraded to DCT 8.0.0 were not able to
interact with the Ul or connect to the GraphQL service container.

Fixed an issue where an error would occur when searching for a VDB in the
relative refresh UL.

Description

Removed THE requirement on setting credentials if a masking job
execution happens on the origin engine.

Allows the policy name to be empty when provisioning a VDB.

Allows for an existing ImagePullSecret to be provided to to pull docker
images.

Fixed the "VDB Container is part of a container" error while refreshing
from bookmark directly on the VDB > Bookmark tab.

Fixed the broken view for a bookmark that has multiple VDBs on the Data
> Bookmark tab.
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2.2.4 Release 7.0.1 changes

Bug Number Description

APIGW-3592, Previously, a non-admin user that was granted access to a VDB, but not its

APIGW-3594 environment, would get an error accessing the VDB overview. A fix has been
implemented to show that the access error is with the environment and not
the VDB.

APIGW-3775 Fixed an issue where refreshing from the bookmark wizard was not showing

compatible bookmarks.

APIGW-3831 Fixed a certificates import failure if the truststore is on OpenShift.

2.2.5 Release 6.0.1 changes

Bug Number Description
APIGW-3460 Fixed a request timeout issue.
APIGW-3395 Fixed an issue where the refresh wizard did not update snapshots when

selecting different datasets.

2.2.6 Release 6.0.0 changes

Bug Number Description

APIGW-3223 Fixed an issue where DCT failed to get info from detached dSources.

2.2.7 Release 5.0.3 changes

Bug Number Description
APIGW-3344 Fixed an issue causing provision failure from RAC dSource to non-RAC
target.
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2.2.8 Release 5.0.2 changes

Bug Number Description
APIGW-2979 VDB refresh will no longer fail if the refresh target name is not unique.
APIGW-2981 Fixed an issue where all the Compliance jobs and source jobs on the

engine will be deleted when a Compliance engine is unregistered.

2.2.9 Release 5.0.1 changes

Bug Number Description

APIGW-2463 The default docker-compose.yaml file is now provided with log size and
rotation configured for all containers.

APIGW-2735 Fixed an issue where DCT migration failed with "could not create unique
index environments_host_pkey".

APIGW-2828 Helm chart now allows cronjob resource limits to be set via the
values.yaml.

2.2.10 Release 3.0.0 changes

Bug Number Description
APIGW-1785 Fixed an issue where Nginx sometimes failed to start after a server
restart.

2.3 Supported versions and upgrade matrix

Data Control Tower has minimum engine versions that are actively tested against to ensure optimal
interoperability. Please ensure that all connected engines meet the version requirements:

Delphix Engine Version
Continuous Data 6.0.0.1 or higher
Continuous Compliance 6.0.13.0 or higher
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Users can upgrade directly between DCT versions without needing an interim step (i.e., upgrading to a median
version before upgrading to the latest).

Version Release date Can upgrade to
2.0.0 Jun 27th, 2022 2.1.0-9.0.x
2.1.0 Sep 8th, 2022 2.2.0-9.0.x
2.2.0 Oct 17th, 2022 3.0.0-9.0.x
3.0.0 Dec 15th, 2022 4.0.0-9.0.x
4.0.0 Jan 19th, 2023 5.0.0-9.0.x
5.0.x Feb 16th, 2023 6.0.0-9.0.x
6.0.x Mar 29th, 2023 7.0.0-9.0.x
7.0.x May 9th, 2023 8.0.0-9.0.x
8.0.x Jun 22nd, 2023 9.0.x

9.0.x Jul 26th, 2023 N/A

Where x represents patch version releases (i.e. 5.0.1, 5.0.2, etc.).
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3 Getting started

Planning your Deployment

Data Control Tower (DCT) represents a Delphix-wide control plane. It simultaneously powers data governance,
automation, and compliance workflows to enable the efficient operation of a broad, complex Delphix deployment
at scale. In order to deliver scalability, service-level performance tuning, and robust resiliency, DCT leverages
container technology to deliver a bespoke experience for administrative teams based on their own internal
guidelines.

(® Before starting a DCT deployment, please contact your enterprise IT organization to determine what
container platforms, configurations, and policies apply for container-hosted applications. It is helpful to
include a container administrator as part of the DCT install process.

3.1 Container Platform Support

Data Control Tower (DCT) supports the most popular distributions of Kubernetes and Openshift. If you do not see
your distribution or platform of choice, please reach out to your account team for more details.

3.1.1 Kubernetes Support

DCT currently supports all popular deployment models of Kubernetes as long as the service runs a minimum of
Kubernetes 1.25 and above. This includes Amazon Elastic Kubernetes Service (Amazon EKS), Azure Kubernetes
Service (AKS), and beyond.

3.1.2 Openshift Support

DCT also supports all popular deployment models of Openshift as long as the service runs a minimum version of
4.12 or above. This includes Red Hat OpenShift on IBM Cloud and any other cloud provider’s service.

3.1.3 Docker Compose

DCT supports Docker Compose but only recommends using this platform for testing/non-production purposes due
to the inherent limitations to deployment scalability. Note - DCT has documentation on migrating deployments
from Docker Compose to Kubernetes and Openshift.

3.2 Data Control Tower Deployment Architecture

Whether an organization wants to deploy a Data Control Tower (DCT) per business unit (organizational silos), per
network (datacenter-specific DCT), or globally (the most common option), DCT can adapt to many deployment
scenarios.

(® Delphix recommends to deploy a single, global DCT for all Delphix Engines for the purposes of achieving a
single control plane and data governance solution.

DCT-based communication is lightweight, requiring simple commands or a small telemetry payload to facilitate
most workflows. The below graphic demonstrates this style of communication:
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DCT Requests a Telemetry Bundle

[

A

Engine Responds with metadata

DCT simply logs into the engines as a user would and leverages engine APIs to perform commands or extract
metadata. Note: DCT requires HTTP/HTTPS to facilitate communication with engines and requires ports 80/443 to
reach engines in other networks.

(® DCT does not directly interface with business-critical databases, it will only communicate with engines to
perform operations and inquire about system statuses. The Delphix engine, which is generally co-located
with your data does all of the heavy lifting.

3.3 Planyour Tagging Strategy

DCT tags serve as the Delphix-wide business metadata system. These Key:Value pairs can be applied to any object
and can be used to search and filter in virtually every DCT workflow from automation to administration all the way
to access control.

@ Itis paramount to develop a tagging strategy prior to deployment in order to develop a scalable metadata
solution.

Some examples of popular tagging strategies:

Theme sub topics Tag (Key:Value) Example
Owner Application, Business, Project, (Owner: Finance App), (Owner:
Team (scrum, ga,...) AppTeam Alpha), (Owner: John

Doe), ...

Application (Application: Alpha)

Environment (Environment: Non Production)

Location Data Center, Region, Name, Cloud (Geo: West Coast), (Data Center:
Azure WC), ...

In addition to designing what tags to implement, please consider who will have access to creating tags (developer
access versus admin only), which will impact how teams are able to collaborate with one another.

Also, Delphix recommends that the DCT administrative team creates Delphix-wide documentation on these tagging
standards to reduce the risk of deviation.
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Data Control Tower implements a model that you might find in other types of software called Attribute Based
Access Control (ABAC). This model is incredibly flexible but requires detailed configuration to perfect your use
cases. In DCT’s model, there are four entity types which are defined below. Understand each entity as they are the
foundational blocks of DCT’s ABAC model.

Entity

Accounts
(aka Users)

Access Groups

Roles and Permissions

Objects

Description

Asingle or shared user who can
authenticate with DCT (Ul or API).

A collection of accounts that share one
or more characteristics, such as a Team
or Permission set. Equivalent to an
Active Directory group.

The collection of read, write, and delete
permissions forms a reusable, named
role.

Units, such as VDBs, Bookmarks, and
Environments, that are managed across
the Delphix Platform.

Managed By

Create manually or via Identity Provider
(1dP), such as SSO or LDAP. Accounts are
independent of Delphix Engines.

Manually created. Populated manually
or via the ‘login_groups’ tag.

Some roles are provided out of the box,
but Admins can build their own from the
available permissions. Individual
permissions are immutable.

Automatically identified by DCT from the
connected engines. Assigned to Roles via
various models. The CD and CC Engines
supply these objects.

Each entity is linked to another through manual or automated assignment. A manual (or direct) assignmentis a
good approach for early implementations. However, it can be challenging to maintain as teams grow. As an
alternative, Tagging is suggested as it performs automatic assignments based on your custom configuration. The
below diagram shows how each entity is linked together. The directions below start with Accounts creation to

Access Groups with Role assignments and finish with Object mappings.

Getting started - 23



N

Direct Assignment

Data Control Tower - Data Control Tower Home

Roles

Access Groups

Direct
Assignment

Tagging
(ex login_groups)

Accounts
(Users and API Keys)

Manually

580, LDAP,
Created

AD, etc

User List
Adam
Betsy

(Default and Custom)

Simple Tagaging Elsr:;;tnmen i Advanced

aaa

Understanding your team structure is imperative to identify the best access model. Usually, organizations have
existing groupings defined in their Identify Provider (IdP). These groups are typically organized in one of two ways
(a) ateam dedicated towards a central goal (such as a product development team) or (b) a group of individuals with
similar permissions (such as Security Administrators). Understanding the purpose of each group should be a guide
in how the Roles and Permissions are designed. For example, the Alpha product development team might have full
permission to manage existing VDBs and create new bookmarks for their team’s “Alpha” objects. On the other
hand, Security Admins might have sweeping read and disable access across the entire platform to ensure
compliancy. Iterating through each Access Group and designing custom, but re-useable roles, based on the
Principle of Least Privilege!, will produce a streamlined rollout.

1 https://en.wikipedia.org/wiki/Principle_of_least_privilege
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4 Deployment

Data Control Tower is a container-based architecture and is currently certified with Kubernetes and OpenShift to
align with common enterprise container standards. The DCT architecture is comprised of multiple micro-services
that are each run on individual pods. This lends DCT to be a highly flexible and resilient deployment by enabling
customers and IT organizations to enact their own backup, scaling, and resiliency standards associated with
hosting container-based applications. Below is an architectural diagram of all the services that make up DCT as well
as the persistent storage for maintaining relationship metadata.

Kubernetes Cluster
Worker Node \
Namespace \
CEiSEpices @ ul 7@ data-bookmarks ITD

/®@Graphm 7@ data-library < _.‘@ Po@
@ @& , %,\

Port 443, 80 ] o jobs >

Y

Port 443, 80

N @ Y,

@ Persistent Storage v \
gateway-data _— gwdatabase-data
L 9 (168) = (wGB)/
-

DCT is multi-cloud enabled, which means that a single DCT instance can be deployed to orchestrate (via HTTPS)
Continuous Data and Continuous Compliance workloads with Delphix engines located in other networks.
Alternatively, DCT can be localized to engines located within a network. DCT is a lightweight management
application, which means that it does not require a highly performant connection to complete its work and can
serve as a central management layer for Delphix engines globally.
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C )( ) Delphix

Continuous Data Engine

This section will explain all of the required steps to deploy DCT on your container platform of choice.

4.1 Kubernetes

4.1.1 Installation and setup for Kubernetes

(@ Before getting started, Delphix recommends that you engage your Kubernetes Admin for deployment
guidance on available Kubernetes deployment platforms (AKS, EKS, etc.), node sizing, and persistent
volume settings.

4.1.1.1 Hardware requirements

The hardware requirements for Data Control Tower (DCT) on Kubernetes are listed below. In addition to these
requirements, inbound port 443 must be open for API clients, and outbound port 443 to engines. This is the
minimum total resource request for the Kubernetes deployment of DCT. Individual service-level resource requests
are contained in values.yaml file and can be overridden during deployment.

CPU: 4-Core
Memory: 16GB
Storage: 50GB
Port: 443

The recommended minimum 50 GB of storage is shared across the Kubernetes cluster (i.e. hosts). All pods and/or
services use this storage for mounted volumes and other utilities including image storage. In a single node cluster,
if shared volumes are not externalized the host requires the full 50 GB. If the persistent volume is mounted
externally, the host requires 39 GB of storage, since the default storage required by the database (10 GB) and
gateway (1 GB) draws from the external storage. The default storage configuration for the database and gateway
can be modified in values.yaml.
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4.1.1.2 Kubernetes Overview

Data Control Tower can be deployed in a manner of minutes once a Kubernetes cluster has been identified and
deployment details have been aligned with your Kubernetes administrator. The installation consists of three
components:

« Kubernetes Cluster - the identified infrastructure to which you will deploy DCT.
« HELM - This deploys DCT as a Kubernetes application by referencing helm charts (.yaml files) that make up

the DCT install either by an external helm repository https://dlpx-helm-dct.s3.amazonaws.com? (Note: this is
the quickest path to installing DCT as it largely automated) or via local install (this is accomplished by

downloading the helm charts directly via the DCT .tar file on download.delphix.com?3)
+ kubectl - is a command line tool that enables administrative communication with the deployed pods (most
useful post-deployment or after an upgrade)

4.1.1.3 Installation requirements (Kubernetes)

DCT requires a running Kubernetes cluster; This could be an on-premises cluster, Azure AKS or AWS EKS cluster.
DCT also requiresa kubectl command line tool to interact with Kubernetes cluster and HELM for deployment on
to the cluster.

Requirement DCT Recommended Comments
Version
Kubernetes Cluster 1.25 or above
HELM 3.9.0 or above DCT also requires access to the HELM repository

from where DCT charts can be downloaded. The
HELM repository URL is https://dlpx-helm-

dct.s3.amazonaws.com?.

If an intermediate (local) HELM repository is to be
used instead of the default Delphix HELM
repository, then the repository URL, username, and
password to access this repository needs to be
configured in the values.yaml file under
imageCredentials section.

2 https://dlpx-helm-dct.s3.amazonaws.com/
3http://download.delphix.com
4 https://dlpx-helm-dct.s3.amazonaws.com/
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Requirement DCT Recommended Comments
Version
kubectl 1.25.0 or above HELM will internally refer to the kubeconfig file to

connect to the Kubernetes cluster. The default
kubeconfig file is present at location: ~/.kube/

config

If the kubeconfig file needs to be overridden while
running HELM commands, set the KUBECONFIG
environment variable to the location of the
kubeconfig file.

To install kubectl follow the instructions at https://
kubernetes.io/docs/tasks/tools/ .

4.1.1.4 Installing DCT

The latest version of the chart can be pulled locally with the following command (where X.0.0.tgz should be
changed to the version of DCT being installed):

curl -XGET https://dlpx—helm-dct.s3.amazonaws.com/delphix-dct-X.0.0.tgz -o delphix-
dct-X.0.0.tgz

This command will download a file with the name delphix-dct-7.0.0.tgz in the current working directory. The
downloaded file can be extracted using the following command (where X.0.0.tgz should be changed to the
version of DCT being installed):

tar -xvf delphix-dct-X.0.0.tgz

This will extract into the following directory structure:

delphix-dct
|- values.yaml
|- README .md
|- Chart.yaml
|- templates
|-<all templates files>

For pulling the Docker images from the registry, temporary credentials would need to be configured/overridden in
the values.yaml file. For getting the temporary credentials, visit the Delphix DCT Download® page and login with
your customer login credentials. Once logged in, select the DCT Helm Repository link and accept the Terms and
Conditions.

5 https://download.delphix.com/folder/1144/Delphix%20Product%20Releases/DCT
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Once accepted, login credentials will be presented. In version 8.0.0 and above, instead of username/password, an
option is available to use credentials from a pre-existing Kubernetes Secret®. To do so, instead of providing a
username/password, users must create the Kubernetes Secret in the same namespace as the one used for DCT, and
reference the registryKey like this:

imageCredentials:
# registry to pull docker images from.
registry: 762392488304.dkr.ecr.us-west-2.amazonaws.com/delphix-dct
# username to login to docker registry. Do not set if registryKey is set.
username:
# password to login to docker registry. Do not set if registryKey is set.
password:
# Name of an existing docker registry key to use to pull images.
registryKey: <insert-secret-name-here>

After extracting the chart, install it using the following command:

helm 1dinstall dct-services delphix-dct

a delphix-dct is the name of the folder which was extracted in the previous step. In the above directory
structure, the values.yaml file contains all of the configurable properties with their default values. These
default values can be overridden while deploying DCT, as per the requirements. If the values.yaml file
needs to be overridden, create a copy of values.yaml and edit the required properties. While deploying
DCT, values.yaml file can be overridden using the following command:

helm install dct-services -f <path to edited values.yaml> <directory

path of the extracted chart>

Once deployment is complete, check the status of the deployment using the following command (where X.0.0
should be changed to the version of DCT being installed):

helm 1list

NAME NAMESPACE REVISION UPDATED

STATUS CHART APP VERSION

dct-services default 1 2023-01-10 19:33:41.713202 -0900
deployed delphix-dct-x.0.0 x.0.0

Assuming an ingress controller configuration on the Kubernetes cluster is present, when accessing DCT
after the deployment, the ingress controller rule needs to be added for proxy service, along with port 443
(if SSL is enabled) and port 80 (if SSL is disabled).

6 https://kubernetes.io/docs/concepts/configuration/secret/
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4.1.2 Bootstrapping API keys

4.1.2.1 API Keys

APl keys are the default method to authenticate with DCT. This is done by including the key in the HTTP
Authorization request header’ with type APK. A cURL example using an example key of
1.0p9PMkZ04Hgy0ezwjhX0OFi41lEKrD4pflejgqjdopfKtywlSWRIGOfIaWajuKcBT3 would appear as:

curl —--header 'Authorization: apk
1.0p9PMkZ04Hgy0ezwjhXOFi41EKrD4pflejgqjdOpfKtywlSWROGOfIaWajuKcBT3"

cURL (like web browsers and other HTTP clients) will not connect to DCT over HTTPS unless a valid TLS certificate
has been configured for the Nginx server. If you haven't performed this configuration step® yet, and understand the
risk, you may disable the check in the HTTP client. For instance, this can done with cURL using the ——insecure
flag.

() cURL version >7.43 is recommended.

Bootstrap First APl Key

There is a special process to bootstrap the creation of the first API key. This first API key should only be used to
create another key and then promptly deleted, since the bootstrap APl will appear in the logs. This process can be
repeated as many times as needed, for example, in a case where existing API keys are lost or have been deleted.

Once the application is started, edit the values.yaml file and modify the following lines, to set the
apiKeyCreate tothestringvalue true . Toggle this value to create/seed bootstrap APl key:

apiKeyCreate: true

Upgrade DCT with:

helm upgrade dct-services <directory path of the extracted chart>

If the values.yaml file needs to be overridden from outside, then use:

helm upgrade dct-services -f <path_to_values.yaml> <directory path of the extracted
chart>

You will see the following output in the logs for the gateway pod (the key will be different from this example):

7 https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/Authorization
g https://docs.delphix.com/display/dctmc/Authentication?src=contextnavpagetreemode#Authentication-replace-
https
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NEWLY GENERATED API KEY: 1.0p9PMkZO4HgyOezwjhXOFi41EKrD4pflejgqjdopfKtywlSWRIGOFIaWaj
uKcBT3

Logs for a gateway pod can be accessed using:

kubectl logs <gateway-pod-name> -n dct-services

gateway-pod-name will be of the format gateway-xxx and can be found using the following command:

kubectl get pods -n dct-services

Copy the API Key, it can now be used to authenticate with DCT. Remember that the APl Key value must be prefixed
with APK. An example cURL command with the above API Key appears as follows:

curl —--header 'Authorization: apk
1.0p9PMkZ04Hgy0ezwjhXOFi41EKrD4pflejgqjdOpfKtywlSWRIOGOfIaWajuKcBT3"

Edit the values.yaml file to set the apiKeyCreate environment variable value backto false andupgrade
DCT again with:

helm upgrade dct-services <directory path of the extracted chart>

If the values.yaml file needs to be overridden from outside, then use:

helm upgrade dct-services -f <path_to_values.yaml> <directory path of the extracted
chart>

Create and manage API Keys

The initial API key created should be used to create a new admin secure key. This is done by creating a new Account
entity and setting the generate_api_key. The "username" attribute should be the desired name to uniquely identify
the account.

@ Ifthe cURL version is below 7.43,replace -—-data-raw optionwith --data.

curl --location --request POST 'https://<hostname>/v2/management/accounts' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
-—header 'Authorization: apk
1.0p9PMkZ04Hgy0ezwjhXOFi41EKrD4pflejgqjdopfKtywlSWROGOfIaWajuKcBT3"' \
--data-raw '{

"username": "secure-key",
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"generate_api_key": true

} ]

A response should be received similar to the lines below:

{
"id": 2,
"token": "2.vCfCOMnpySYZLshuxap2aZ7xqBKANQvV7hFnobe7xuNTHSOAF2NQNVIOXXw4UyET6"
"username'":"secure-key"

}

Now that the new and secure API key is created, the old one must be deleted for security reasons since the key
appeared in the logs. To do this make the following request:

curl --location --request DELETE 'https://<hostname>/v2/management/api-clients/<id>'
\

--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

-—header 'Authorization: apk

2.vCfCOMnpySYZLshuxap2aZ7xqBKAnNQvV7hFnobe7xuNTHS9AF2NQnVIXXw4UyET6'

The 1id referenced above is the numeric id of the Account. It is the integer before the period in the token. For

example, theid of 1.0p9PMkZ04HgyOezwjhXOFi41EKrD4pflejgqjdOpfKtywlSWROGOfIaWajuKcBT3
is 1.

Finally, to list all of the current Accounts, make the following request:

curl --location --request GET 'https://<hostname>/v2/management/accounts/"' \
--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

--header 'Authorization: apk <your API key>'

4.1.3 DCT logs for Kubernetes

All DCT containers log to stdout and stderr so that their logs are processed by Kubernetes. To view container level
logs running on the Kubernetes cluster use:

kubectl logs <pod_name> -n dct-services

Log aggregators can be configured to read from stdout and stderr forall of the pods as per the
requirements.
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4.1.4 Admin topics for Kubernetes

4.1.4.1 Deployment upgrade for Kubernetes

This article covers the upgrade process for DCT deployments on Kubernetes.

Create a new folder called dct-x.0.0, where x.0.0 should be changed to the version of DCT being installed (i.e. if
on 5.0.2, it would be 6.0.0).

$mkdir dct-x.0.0

Download the new version of chart using the following command in tandem with the newly created folder (where
x.0.0 should be changed to the version of DCT being installed):

$cd dct-x.0.0
$curl -XGET https://dlpx-helm-dct.s3.amazonaws.com/delphix-dct-x.0.0.tgz -o delphix-
dct-x.0.0.tgz

E This command will download a file named delphix-dct-x.0.0.tgz in the folder dct-x.0.0.

The downloaded file is then extracted using the following command (where x.0.0 should be changed to the
version of DCT being installed):

$tar -xvf delphix-dct-x.0.0.tgz

Which will extract into the following directory structure:

delphix-dct
|- values.yaml
|- README .md
|- Chart.yaml
|- templates
|-<all templates files>

Copy the values.yaml file from the previous version parallel to the dct-x.0.0 folder.
a This values.yaml file contains modified values from the existing previous version of deployment.

Since the Docker Registry (AWS ECR) expires after 12 hours, the Docker Registry should be modified in the
values.yaml (from the previous existing version) with the latest password. It can be obtained from https://
download.delphix.com®. Here are some notes in regards to this step in the process:

9 https://download.delphix.com/
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+ This password update in values.yaml is only required if the user using Delphix provided a Docker Registry
directly in the deployment (i.e. values.yaml).
+ In case a user is using their internal Docker Registry, they should first pull the next version of the Docker
images from the Delphix provided registry, using a new password.
+ Stepsto pull Docker images from the Docker Registry:
Docker login command (password from https://download.delphix.com??)

$docker login --username AWS --password [PASSWORD] 762392488304.dkr.ecr.us-west-2.ama
zonaws.com/delphix-dct

Pull Docker images of DCT Services:

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:nginx-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:app-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:data-bookmarks-x.0.0
$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:delphix-data-library-x.0.0
$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:graphql-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:ui-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:jobs-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:postgres-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:virtualization-x.0.0

The last step is to run the helm upgrade command:

helm upgrade -f values.yaml dct-services delphix-dct

4.1.4.2 Factory reset DCT for Kubernetes

To clean DCT installation run following command:

helm delete dct-services

& This process will delete services pod and database both.

10 https://download.delphix.com/
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4.2 OpenShift

4.2.1 Installation and setup for OpenShift

4.2.1.1 Hardware requirements

The hardware requirements for Data Control Tower to deploy on OCP are listed below. In addition to these
requirements, inbound port 443 or 80 must be open for API clients. This is the minimum total resource requirement
for the deployment.

CPU: 4-Core
Memory: 16GB
Storage: 50GB
Port: 443

4.2.1.2 Installation requirements (OpenShift)

DCT requires a running OpenShift cluster to run, oc command line tool to interact with OpenShift cluster, and
HELM for deployment on to the cluster.

Requirement DCT Recommended Version Comments
OpenShift Cluster 4.12 or above
HELM 3.9.0 or above HELM installation should support

HELM v3. More information on
HELM can be found at https://
helm.sh/docs/ . To install HELM,
follow the installation instructions
at https://helm.sh/docs/intro/
install/ .

DCT also requires access to the
HELM repository from where DCT
charts can be downloaded. The
HELM repository URL is https://
dlpx-helm-
dct.s3.amazonaws.com?!?.

oc 4.11.3 or above To install oc follow the instructions
at https://docs.openshift.com/
container-platform/4.8/
cli_reference/openshift_cli/
getting-started-cli.html.

11 https://dlpx-helm-dct.s3.amazonaws.com/
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If an intermediate HELM repository is to be used instead of the default Delphix HELM repository, then the
repository URL, username, and password to access this repository needs to be configured in the
values.yaml file under imageCredentials section.

4.2.1.3 Installation process
Jumpbox setup
OC login

Run the OC login command to authenticate OpenShift CLI with the server.

oc login https://openshiftl.example.com --token=<<token>>

Verify KubeConfig
HELM will use the configuration file inside the $SHOME/.kube/ folder to deploy artifacts on an OpenShift cluster.

Be sure the config file has the cluster context added, and the current-context is set to use this cluster. To verify the
context, run this command:

oc config current-context

Create a new project

Create a new project named dct-services using the command below:

oc new-project dct-services --description="DCT Deployment project" --display-name="dc
t-services"

Installing Helm
Install HELM using the following installation instructions mentioned at https://helm.sh/docs/intro/install/.

DCT also requires access to the HELM repository from where DCT charts can be downloaded. Run the following
commands to add the repository (where x.0.0 should be changed to the version of DCT being installed):

curl -XGET https://dlpx-helm-dct.s3.amazonaws.com/delphix-dct-x.0.0.tgz -o delphix-
dct-x.0.0.tgztar -xvf delphix-dct-x.0.0.tgz
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Find and update fsGroup values.yaml file

The fsGroup field is used to specify a supplementary group ID. All processes of the container, the owner of the

volume, and any files created on the volume are also part of this supplementary group ID.

For OpenShift deployment, this value need to be specified in the values.yaml file.

Find the allowed supplementary group range:

oc get project dct-services

Aresponse should appear as follows:

-0 yaml

apiVersion: project.openshift.io/vl

kind: Project
metadata:
annotations:

openshift.io/description: ""
openshift.io/display-name: ""

openshift.io/requester:

openshift.io/sa.scc.mcs:

cluster-admin
s0:c32,c4

openshift.io/sa.scc.supplemental-groups: 1001000000/10000

openshift.io/sa.scc.uid-

range: 1001000000/10000

creationTimestamp: "2023-01-18T10:33:04Z"

labels:

kubernetes.io/metadata.name: dct-services

pod-security.kubernetes.
pod-security.kubernetes.
pod-security.kubernetes.
pod-security.kubernetes.

name: dct-services
resourceVersion: '99974"

io/audit: restricted
io/audit-version: vl1.24
io/warn: restricted
io/warn-version: v1.24

uid: ccdd5c9f-2ce5-49b4-91a7-662e0598b63b

spec:
finalizers:
- kubernetes
status:
phase: Active

Copy the first value from the openshift.io/sa.scc.supplemental-groups line, before the slash (e.g.

1001000000).

Paste this value in the values.yaml file:

# Define SecurityContextConstraints for the pod

podSecurityContext:
fsGroup: 1001000000
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Create values.yaml file

Create a values.yaml file and update the properties according to your environment. A sample values.yaml file can
be downloaded below.

values.yaml

(see page 35)

Deploy DCT

Run the following command to deploy the DCT chart (where x.0.0 should be changed to the version of DCT
being installed):

helm install -f <path to edited values.yaml> dct-services apigw-repo/delphix-dct -
version=x.0.0

Verify deployment

All the images will be downloaded and then deployed. If some pods restarted at the startup, this is expected. After
some time, a total of 9 pods will be in running status and one job pod will be in completed status.

oc get pods -n dct-services

Find APl key

For the very first deployment bootstrap APl key will be printed in logs, please view gateway pod logs and find for
“NEWLY GENERATED API KEY”. the value is the API key.

oc logs <gateway-pod-name> -n dct-services

4.2.1.4 Configure Ingress
DCT only works with HTTPS Ingress, the Ul does not support HTTP.
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Creating route
To create a route, you can use the OpenShift console and create a new one for the DCT service.

If SSL is terminated at this route, only then should the useSSL value in values.yaml be updated to false, so that 80
port will be exposed in proxy service and can be used to configure the route. The following screenshot shows the
route that forwards requests to 80 port of proxy service:

RedHat

OpenShift

%2 Administrator Project: apigw-services ¥

Configure via: @ Form view YAML view
Home

Name *
Operators TIer

Route within

Workloads

Hostname

detdelphixcom
Metworking -

Services

Path
Routes
Ingresses Path that the router watches to route traffic to the service
NetworkPolicies Service *

© proxy -

Storage

© Add alternate Service
Builds
Target port *
10 — BOB3 (TCP) -
Observe B0 — BOB3 (TCP)
Compute Security

Secure Route

User Management .
o5 can be secured using several TLS termination types for serving certificates.

) . TLS termination *
Administration

Edge -
Insecure traffic

Redirect -

If SSL is not terminated at the Route level, then create a PassTrough route and use 443 port of the proxy service, and
configure the SSL certificate and key in the values.yaml file:
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RedHat
OpenShift

¢ Administrator Project: apigw-services v

Home
Configure via: '® Form view YAML view
Operators
Name *
Workloads det
inigue name for the Route within the project
Networkin
9 Hostname
Services det.delphixcom
Routes d F et erated
Path
Ingresses
NetworkPolicies
hat the router watches to route traffic to the service
Service *
Storage
© proxy -
Builds Service to route to
© Add alternate Service
Observe
Target port *
443 —» B443 (TCP) -
Compute "
Target port for traffic
User Management Security

Secure Route
Administration

Routes can be secured using several TLS terminat
TLS termination *

Passthrough -

Insecure traffic
Redirect -

4.2.2 OpenShift authentication

4.2.2.1 Introduction

DCT uses Nginx/OpenResty as an HTTP server and a reverse proxy for the application. Using the default
configuration, all connections to DCT are over HTTPS and require the user to authenticate. There are three
supported methods for authentication; APl keys, Username/Password, and OpenID Connect.

4.2.2.2 Enable OAuth2 authentication

By default APIKey authentication will be enabled and when DCT starts it will generate a new API key(see page 59) in
logs if you want to enable openld connect authentication then follow below procedure:

Update the below properties in the values.yaml file and restart DCT:
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# flag to enable api_key based authentication

apiKeyEnabled: false

# flag to enable OAuth2 based authentication

openIdEnabled: true

# URL of the discovery endpoint as defined by the OpenId Connect Discovery
specification. This needs to be set if 'openIdEnabled' is set to true
openIdServerUrl: https://delphix.okta.com/oauth2/default/.well-known/oauth-
authorization-server

# OAuth2 jwt claim name that should be used as client_id
jwtClaimForClientId: sub

# OAuth2 jwt claim name that should be used as client_name
jwtClaimForClientName: sub

4.2.3 DCT logs for OpenShift

AlLDCT containers log to stdout and stderr, so that their logs are processed by OpenShift. To view container level
logs running on the OpenShift cluster, use this command:

oc logs <pod_name> -n dct-services

Log aggregators can be configured to read from stdout and stderr for all of the pods as per the requirements.

4.2.4 Admin topics for OpenShift

4.2.4.1 Deployment upgrade for OpenShift

This article covers the upgrade process for DCT deployments on Kubernetes.

Create a new folder called dct-x.0.0 where x.0.0 should be changed to the version of DCT being installed (i.e. if
on 5.0.2, it would be 6.0.0).

$mkdir dct-x.0.0

Download the new version of chart using the following command in tandem with the newly created folder.

$cd dct-x.0.0
$curl -XGET https://dlpx-helm-dct.s3.amazonaws.com/delphix-dct-x.0.0.tgz -o delphix-
dct-x.0.0.tgz

a This command will download a file named delphix-dct-x.0.0.tgz in the folder dct-x.0.0.

The downloaded file is then extracted using the following command (where x.0.0 should be changed to the
version of DCT being installed):
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$tar -xvf delphix-dct-x.0.0.tgz

Which will extract into the following directory structure:

delphix-dct
|- values.yaml
|- README.md
|- Chart.yaml
|- templates
|-<all templates files>

Copy the values.yaml file from the previous version parallel to the dct-x.0.0 folder.
a This values.yaml file contains modified values from the existing previous version of deployment.

Since the Docker Registry (AWS ECR) expires after 12 hours, the Docker Registry should be modified in the
values.yaml (from the previous existing version) with the latest password. It can be obtained from https://
download.delphix.com!2, Here are some notes in regards to this step in the process:

« This password update in values.yaml is only required if the user using Delphix provided a Docker Registry
directly in the deployment (i.e. values.yaml).

« Incase a user is using their internal Docker Registry, they should first pull the next version of the Docker
images from the Delphix provided registry, using a new password.

+ Steps to pull Docker images from the Docker Registry:

13):

Docker login command (password from https://download.delphix.com

$docker login --username AWS --password [PASSWORD] 762392488304.dkr.ecr.us-west-2.ama
zonaws.com/delphix-dct

Pull Docker images of DCT Services:

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:nginx-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:app-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:data-bookmarks-x.0.0
$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:delphix-data-library-x.0.0
$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:graphql-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:ui-x.0.0

$ docker pull

12 https://download.delphix.com/
13 https://download.delphix.com/
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762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:jobs-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:postgres-x.0.0

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:virtualization-x.0.0

The last step is to run the helm upgrade command:

helm upgrade -f values.yaml dct-services delphix-dct

4.2.4.2 Factory reset DCT for OpenShift

To clean DCT installation run following command:

helm delete dct-services:

& This process will delete both services pod and database.

4.3 Docker Compose

4.3.1 Installation and setup for Docker Compose

& Docker Compose should only be used to deploy DCT in an evaluation/testing capacity, and production
DCT workloads in Docker Compose are not fully supported. Installations starting on Docker Compose may
be migrated to Kubernetes or OpenShift by using the steps in the technical documentation. In-place
upgrades from Docker Compose to Kubernetes or OpenShift are not supported.

4.3.1.1 Hardware requirements

The hardware requirements for Data Control Tower are listed below. In addition to these requirements, inbound
port 443 must be open for API clients, and outbound port 443 to engines.

CPU: 4-Core
Memory: 2GB
Storage: 50GB
Port: 443

4.3.1.2 Installation requirements (Docker Compose)

DCT requires Docker and Docker Compose to run, thus, Linux versions and distributions that have been verified to
work with Docker are supported. To see a list of supported distributions, please reference this Docker article®.

14 https://docs.docker.com/engine/install/#server
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This example uses a Docker installation!® and is completed on an Ubuntu 20.04 VM.

To begin, uninstall any old versions of Docker.

sudo apt-get remove docker docker-engine docker.io containerd runc

Next, update the package lists and install Docker.

sudo apt-get update
sudo apt-get install docker.io

Last, install Docker Composel®.

sudo curl -L "https://github.com/docker/compose/releases/download/1.29.1/docker—-
compose-$(uname -s)-$(uname -m)" -o /usr/local/bin/docker-compose
sudo chmod +x /usr/local/bin/docker-compose

8 Docker-Compose is packaged with Docker engine version 20.10.15 and up.

Running Docker as non-root (optional)

To avoid prefacing the Docker command with sudo, create a Unix group called docker and add users to it. When the
Docker daemon starts, it creates a Unix socket accessible by members of the Docker group. See Docker Post
Installation!” documentation for details.

sudo groupadd docker
sudo usermod -aG docker S$USER

4.3.1.3 Unpack and install DCT

Once Docker and Docker Compose are installed, DCT can be installed. Begin by downloading the latest version of
the tarball from the Delphix Download site'®. Next, transfer the file to the Linux machine where Docker is installed.
Run the following commands to extract the containers and load them into Docker (where x.0.0 should be
changed to the version of DCT being installed):

tar -xzf delphix-dct-x.0.0.tar.gz
for dimage in xtar; do sudo docker load --input $image; done

15 https://docs.docker.com/engine/install/

16 https://docs.docker.com/compose/install/

17 https://docs.docker.com/engine/install/linux-postinstall/
18 https://download.delphix.com/folder
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4.3.1.4 RunDCT

To run DCT, navigate to the location of the extracted docker-compose.yaml file from the tarball and run the
following command. Using —-d in the command will start up the application in the background.

sudo docker-compose up -d

Running docker ps should show 9 containers up and running:

sudo docker ps

CONTAINER ID IMAGE COMMAND CREATED
STATUS PORTS NAMES

75a9df0caed7 delphix-dct-proxy:x.0.0 "/sbin/tini -- /boot.." 7 seconds
ago Up 4 seconds 0.0.0.0:443->8443/tcp delphix-dct-proxy:x.0.0

a23f4fbe0220 delphix-dct-app:x.0.0 "java -jar /opt/delp.." 7 seconds
ago Up 5 seconds delphix-dct-app:x.0.0

96ba8018fab3 delphix-dct-data-library:x.0.0 "/Jusr/bin/tini -- ./." 7 seconds
ago Up 5 seconds delphix-dct-data-library:x.0.0
8e5ble671lacc delphix-dct-jobs:x.0.0 "/Jusr/bin/tini -- ./." 7 seconds
ago Up 5 seconds delphix-dct-jobs:x.0.0

96049058025 delphix-dct-data-bookmarks:x.0.0 "/Jusr/bin/tini -- ./." 7 seconds
ago Up 5 seconds delphix-dct-data-bookmarks:x.0.0
20d1782cb3bb delphix-dct-ui:x.0.0 "node ./index.js" 7 seconds
ago Up 5 seconds delphix-dct-ui:x.0.0

4fae43c79e8d delphix-dct-virtualization:x.0.0 "/Jusr/bin/tini -- ./." 7 seconds
ago Up 5 seconds delphix-dct-virtualization:x.0.0
83d7d661d8a0 delphix-dct-graphql:x.0.0 "/bin/sh -c 'BASE_UR.." 7 seconds
ago Up 6 seconds delphix-dct-graphql:x.0.0

3dded474e28b delphix-dct-postgres:x.0.0 "docker-entrypoint.s.." 7 seconds
ago Up 6 seconds 5432 /tcp delphix-dct-postgres:x.0.0

4.3.2 Bootstrapping APl Keys

& Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

There is a special process to bootstrap the creation of the first API key. This first API key should only be used to
create another key and then promptly deleted, since the bootstrap APl will appear in the logs. This process can be
repeated as many times as needed, for example, in a case where existing API keys are lost or have been deleted. It
also means that the Linux users with permissions to edit the docker-compose file implicitly have the ability to get
an APl key at any time. There is no mechanism to lock this down after the first bootstrap key is created.

Begin by stopping the application with the following command:

sudo docker-compose stop
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Once the application is stopped, edit the docker-compose.yaml file and modify the following lines to the DCT
section, to setthe API_KEY_CREATE to the string value "true":

services:
gateway:
environment:
API_KEY_CREATE: "true"

Start DCT again with sudo docker-compose up .You will see the following output in the logs for the app
container (the key will be different from this example):

NEWLY GENERATED API KEY: 1.0p9PMkZO4Hgy®ezwjhXOFi4lEKrD4pflejgqjdopfKtywlSWRIGOFIaWaj
uKcBT3

Copy the API Key and shut down the DCT app. The API key can now be used to authenticate with DCT. Remember
that the API Key value must be prefixed with apk. An example cURL command with the above API Key appears as
follows:

curl --header 'Authorization: apk
1.0p9PMkZ04Hgy0ezwjhXOFi41EKrD4pflejgqjdOpfKtywlSWROGOfIaWajuKcBT3"

Edit the docker-compose.yaml file to set the API_KEY_CREATE environment variable value back to "false" and

restart DCT again with sudo docker-compose up -d.

4.3.3 Custom configuration

Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

4.3.3.1 Introduction

DCT was designed for users to configure Delphix applications in a way that would meet their security requirements,
which handled with a custom configuration. This article provides background information on performing custom
configurations, which are referenced throughout DCT articles and sections.

4.3.3.2 Bind mounts

Configuration of DCT is achieved through a combination of API calls and the use of Docker bind mounts!®. A bind
mount is a directory or file on the host machine that will be mounted inside the container. Changes made to the
files on the host machine will be reflected inside the container. It does not matter where the files live on the host
machine, but the files must be mounted to specific locations inside the container so that the application can find
them.

The DCT and proxy containers can both be configured via separate bind mounted directories. Each container
requires all configuration files to be mounted to the /etc/config directoryinside the container. Therefore, it is

19 https://docs.docker.com/storage/bind-mounts/

Deployment - 46


https://docs.docker.com/storage/bind-mounts/
https://docs.docker.com/storage/bind-mounts/

Data Control Tower - Data Control Tower Home

recommended to create a directory for each container on the host machine to store all of the configuration files and
mountthemto /etc/config.Thisisdone by editingthe docker-compose.yaml . Under proxy services,
add a volumes section if one does not already exist; this is used to mount the configuration directory on the host to

/etc/config.Forexample,if /my/proxy/config isthe directory on the host that contains the
configuration files, then the relevant part of the compose file would look like this:

services:
proxy:
volumes:
- /my/proxy/config:/etc/config

To change the configuration of the DCT container, make a similar change under its service section, the only
difference being the directory on the host. After making this change, the application will need to be stopped and
restarted.

The structure of /my/proxy/config will need to match the required layoutin /etc/config.When each
container starts, it will create default versions of each file and place them in the expected location. It is highly
recommended to start from the default version of these files. For example, if /my/proxy/config isthebind

mount directory on the host, it could be populated with all the default configuration files by running the following
commands.

First, create an nginx directoryinside /my/proxy/config onthe host.

cd /my/proxy/config
mkdir nginx

Find the id of the proxy container with docker ps. Look for the container with a delphix-dct-proxy image name. To
determine the user and group ownership for any configuration files, start the containers and open a shell to the
relevant one (nginx in this example), then examine the current user/group IDs associated with the files (where

x.0.0 should be changed to the version of DCT being installed).

$ docker ps

CONTAINER ID IMAGE COMMAND CREATED
STATUS PORTS NAMES

ac343412492a delphix-dct-proxy:x.0.0 "/bootstrap.sh" 8 minutes ago Up
8 minutes 0.0.0.0:443->443/tcp, :::443->443/tcp dct-packaged_proxy_1

In the above example, ac343412492a is the id. Run the following command to copy the default files to the bind
mount.

docker cp <container id>:/etc/config/nginx /my/proxy/config/nginx

One can always go back to the original configuration by removing the bind-mount and restarting the container or
using docker cp as in the previous example to overwrite the custom files with the default versions.
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4.3.4 Docker logs

Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

DCT leverages the Docker logging?® infrastructure. All containers log to stdout and stderr so that their logs are
processed by Docker. Docker supports logging drivers for a variety of tools such as Fluentd, Amazon CloudWatch,
and Splunk to name a few. See Docker documentation here?! on how to configure them. These changes will need to
be made to the docker-compose.yaml file. This link?? explains how to alter the compose file to adjust the logging
driver. For example, if you want to use syslog for the proxy container then it would look like this:

services:
proxy:
logging:
driver: syslog
options:

syslog-address: "tcp://192.123.1.23:123"

4.3.5 Migration topics

4.3.5.1 Migrate to Kubernetes

Overview

Installations starting on Docker Compose may be migrated to Kubernetes by moving the persistent data store using
the following steps. In-place upgrades from Docker Compose to Kubernetes are not supported.

a8 During the migration process, there will be a downtime period where the service cannot be used.

Migration Process

Stop DCT services. In order to avoid a situation of losing data, stop serving the upcoming traffic with:

~$ docker-compose stop

Copy the Postgres Docker volume folder data on a local machine with:

~$ mkdir database
~$ docker cp {dbcontainer_Id}:/var/lib/postgresql/data ./database

Copy the encryption key Docker volume folder data on a local machine with:

20 https://docs.docker.com/config/containers/logging/
21 https://docs.docker.com/config/containers/logging/configure/
22 https://docs.docker.com/compose/compose-file/compose-file-v3/#logging
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~$ mkdir data_key
~$ docker cp {gateway_container_id}:/data ./data_key

a Mounted Docker volume folder content for database is copied in database folder on local machine.

Mounted Docker volume folder content for encryption key is copied in the data_key folder on local
machine.

Move the copied volume folders (database and data_key from the previous step) to the Kubernetes host machine
where DCT is up and running.

Update the values.yaml file to add the list of certificates which were used in the previous DCT version (present in
mounted trustStore). Update the deployment with the new values.yaml file.

Terminate the proxy pod to stop serving external traffic with:

~$ kubectl scale --replicas=0 deployment/proxy -n dct-services

Terminate the database to stop internal threads using the database with:

~$ kubectl scale --replicas=0 deployment/database -n dct-services

Create adummy pod to access the Persistent Volume. Use the Pod.yaml as an example:

apiVersion: vl
kind: Pod
metadata:
Namespace: dct-services
name: dummy-pod
labels:
app: dummy-pod
spec:
containers:
- image: ubuntu
command:

- "sleep"

- "604800"
imagePullPolicy: IfNotPresent
name: ubuntu

restartPolicy: Always
volumes:
- name: gwdatabase-data
persistentVolumeClaim:
claimName: gwdatabase-data

Followed by this command to actually create the dummy pod:
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~$ kubectl apply -f pod.yaml -n dct-services

Restore previous DCT version volume data with DCT deployed on the Kubernetes setup (in Persistent Volume).

Move the encryption key with:

~$cd data_key
~$ kubectl cp data dct-services/{gateway_pod_name}:/

Move the Postgres data with:

~$cd database
~$ kubectl cp data dct-services/{dummy_pod_name}:/var/lib/postgresql

Delete the dummy pod with:

~$ kubectl delete pod dummy-pod -n dct-services

Start the database pod (scale to 1) with:

~$ kubectl scale --replicas=1 deployment/database -n dct-services

Delete or patch the gateway pod with:

~ % kubectl delete pod {gateway_pod_name} -n dct-services

Delete or patch the data-library pod with:

~ % kubectl delete pod {data-library_pod_name} -n dct-services

Delete or patch the jobs pod with:

~ % kubectl delete pod {jobs_pod_name} -n dct-services

Delete or patch the data-bookmarks pod with:

~ % kubectl delete pod {data-bookmarks_pod_name} -n dct-services

Start the proxy service to serve the external service:
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4.3.5.2 Migrate to OpenShift

Overview

Installations starting on Docker Compose may be migrated to OpenShift by moving the persistent data store using
the following steps. In-place upgrades from Docker Compose to OpenShift are not supported.

a During the migration process, there will be a downtime period where the service cannot be used.

Migration Process

Stop DCT services. In order to avoid a situation of losing data, stop serving the upcoming traffic with:

~$ docker-compose stop

Copy the Postgres Docker volume folder data on a local machine with:

~$ mkdir database
~$ docker cp {dbcontainer_Id}:/var/lib/postgresql/data ./database

Copy the encryption key Docker volume folder data on a local machine with:

~$ mkdir data_key
~$ docker cp {gateway_container_id}:/data ./data_key

a « Mounted Docker volume folder content for database is copied in database folder on local
machine.

« Mounted Docker volume folder content for encryption key is copied in the data_key folderon
local machine.

Move the copied volume folders (database and data_key from the previous step) to the Kubernetes host machine
where DCT is up and running.

Update the values.yaml file to add the list of certificates which were used in the previous DCT version (present in
mounted trustStore). Update the deployment with the new values.yaml file.

Terminate the proxy pod to stop serving external traffic with:

~$ oc scale --replicas=0 deployment/proxy -n dct-services

Terminate the database to stop internal threads using the database with:
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~$ oc scale --replicas=0 deployment/database -n dct-services

Create a dummy pod to access the Persistent Volume. Use the Pod.yaml as an example:

apiVersion: vl
kind: Pod
metadata:
Namespace: dct-services
name: dummy-pod
labels:
app: dummy-pod
spec:
containers:
- image: ubuntu
command:

- "sleep"

- "604800"
imagePullPolicy: IfNotPresent
name: ubuntu

restartPolicy: Always
volumes:
- name: gwdatabase-data
persistentVolumeClaim:
claimName: gwdatabase-data

Followed by this command to actually create the dummy pod:

~$ oc apply -f pod.yaml -n dct-services

Restore previous DCT version volume data with DCT deployed on the Kubernetes setup (in Persistent Volume).

Move the encryption key with:

~$cd data_key
~$ oc cp data dct-services/{gateway_pod_name}:/

Move the Postgres data with:

~$cd database
~$ oc cp data dct-services/{dummy_pod_name}:/var/lib/postgresql

Delete the dummy pod with:

~$ oc delete pod dummy-pod -n dct-services

Start the database pod (scale to 1) with:
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~$ oc scale --replicas=1 deployment/database -n dct-services

Delete or patch the gateway pod with:

~ % oc delete pod {gateway_pod_name} -n dct-services

Delete or patch the data-library pod with:

~ % oc delete pod {data-library_pod_name} -n dct-services

Delete or patch the jobs pod with:

~ % oc delete pod {jobs_pod_name} -n dct-services

Delete or patch the data-bookmarks pod with:

~ % oc delete pod {data-bookmarks_pod_name} -n dct-services

Start the proxy service to serve the external service:

~$ oc scale --replicas=1 deployment/proxy -n dct-services

4.3.6 Admin topics for Docker Compose

4.3.6.1 Backup DCT on Docker Compose

& Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

This article discusses how to backup DCT. The data that needs to be backed up is the Docker volumes used by the
DCT container, gwdatabase container, and the configuration directories on the host that are bind mounted to the
containers.

The Docker volumes named {xxx}delphix-dct-data and {xxx}delphix-dct-database-data
should be backed up to prevent data loss. This Docker article?3 explains how to backup a data volume.

The bind mount directories containing the configuration files are standard directories that can be backed up as
desired. A simple approach would be to create a tar file of the contents. If /my/config is the bind mount directory
on the host, then this can be done with the following command:

tar -czf gateway-backup.tgz /my/config

23 https://docs.docker.com/storage/volumes/#backup-restore-or-migrate-data-volumes
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4.3.6.2 Deployment upgrade for Docker Compose

& Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

& DCT versions 2.0.0 through 6.0.2 running on Docker Compose, that are being upgraded to DCT 7.0.0 or
later, may experience potential failure to start post-upgrade, resulting in a "permission denied" error in
the logs. Operations post-upgrade may also fail with internal errors.

Theissue is due to the UID running the application containers changing from UID 1000 (in DCT 2.0.0
through 6.0.2) to UID 1010 (in DCT 7.0.0 and later). Resolving the issues requires the following one-time
change and no container restart is required:

1. Change ownership of the volume associated to the gateway container to the new UID:

docker exec -u 0 -1it <gateway-container-name> chown
delphix:delphix /data

2. If bind mounts have been used to configure DCT, they must grant permission to the user with UID
1010 (GUID 1010) to read/write files, for example:

chown 1010:1010 /path/to/nginx/bind/mount

Introduction

This article describes the procedure to upgrade the DCT version without losing any data. Docker Compose uses the
concept of ‘project’ to create unique identifiers for all of a project’s containers and other resources (like volumes,
etc.).

Get the current project name and note it down using the following command:

The volume name would be of the format {project-name}_gateway-data and {project-name}_gwdatabase-
data. In the below example, the project name is delphix-dct.

docker volume 1s

DRIVER VOLUME NAME

local delphix-dct_gateway-data
local delphix-dct_gwdatabase-data

Bring down DCT services using the following command:

docker compose down

Refer to the Installation and Setup article to download and extract the new release tarball, then load Docker
images.

Navigate to the extracted directory which contains the docker-compose.yaml file. By default, Docker Compose
uses the extracted folder name as project-name.

& Edit the docker-compose.yaml file. Changes made to the docker-compose.yaml prior to upgrade file must
be applied to the newly extracted docker-compose.yaml file.
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With that, either rename the extracted folder to match the project-name and run:

docker compose up -d

OR run the below command with the project-name noted above from step #1 above

docker compose -p <project-name> up -d

If the -p argument is used to deploy DCT services, then the corresponding command to bring down the
DCT services would be:

docker compose -p <project-name> down

4.3.6.3 Factory reset DCT for Docker Compose

& Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

This article explains how to factory reset DCT. Factory resetting means deleting all of the configuration and data
associated with DCT. Perform this step only if you are absolutely sure about this and understand the implications.

Bring all of the DCT services down with this command:

docker compose down

List all Docker volumes being used and note down the volume names:

docker volume 1s

DRIVER VOLUME NAME

local dct_gateway-data
local dct_gwdatabase-data

Delete the Docker volumes that are listed from the previous command:

docker volume rm dct_gateway-data
docker volume rm dct_gwdatabase-data

Deployment - 55



Data Control Tower - Data Control Tower Home

4.4 Engines: connecting/authenticating

4.4.1 Introduction

After DCT Authentication is complete, the HTTPS should be securely configured on DCT and able to be
authenticated against. The next step is to register an engine with DCT so that it can fetch results. DCT connects to
all engines over HTTPS, thus some configurations might be required to ensure it can communicate successfully.

4.4.2 Truststore for HTTPS

If the CA certificate that signed the engine's HTTPS certificate is not a trusted root CA certificate present in the JDK,
then custom CA certificates can be provided to DCT. If these certificates are not provided, a secure HTTPS
connection cannot be established and registering the engine will fail. The insecure_ssl engine registration
parameter can be used to bypass the check, however, this should not be used unless the risks are understood.

Get the public certificate of the CA that signed the engine’s HTTPS certificate in PEM format. IT team help may be
required to get the correct certificates. Base64 encode the certificate with:

cat mycertfile.pem | base64 -w 0

Copy the Base64 encoded value from the previous step and configure in values.yaml file under
truststoreCertificates section. e.g. section will look like this:

truststoreCertificates:
<certificate_name>.crt: <base64 encode certificate string value in single line>
<certificate_name> can be any logically valid string value for e.g. “engine”.

All the certificates configured in truststoreCertificates section will be read and included in the trustStore which
would be then used for SSL/TLS communication between DCT and Delphix Engine.

4.4.3 Authentication with engine

All authentication with the Delphix Engine is done with the username and password of a domain admin engine user.
There are two methods of storing these credentials with DCT. They can either be stored and encrypted on DCT itself
or retrieved from a password vault. We recommend fetching the credentials from a vault. Currently only the
HashiCorp vault is supported.

4.4.4 HashiCorp vault

There are two high-level steps to configuring a HashiCorp vault. The first is to set up authentication with the vault
and register the vault. The second is to tell DCT how to get the specific engine credentials needed from that
registered vault. A single vault can be used for multiple different Delphix Engines.
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4.4.4.1 Vault authentication and registration

First, DCT needs to be able to authenticate with the vault. DCT supports the Token?*, AppRole?®, and TLS
Certificates?® authentication methods. This is done by passing a command to the HashiCorp CLI?". Itis
recommended to first ensure that successful authentication is done and one can retrieve the credentials with the
HashiCorp CLI directly to ensure the correct commands are passed to DCT.

Adding a vault to DCT is done through API calls to the /v2/management/vaults/hashicorp endpoint. All
authentication methods requires the location of the vault is provided through the env_variables property in the
POST body like so:

"env_variables": {
"VAULT_ADDR": "https://10.119.132.40:8200"
}

4.4.4.2 Token

To use the token authentication method, this needs to be included as part of the env_variables field. The full
example to register the vault would appear as:

curl —--location —--request POST 'https://<hostname>/v2/management/vaults/hashicorp' \
-—header 'Content-Type: application/json' \
-—header 'Accept: application/json' \
--header 'Authorization: apk <your API key>' \
--data-raw '{
"env_variables": {
"VAULT_TOKEN": "<your token>"
"VAULT_ADDR": "https://10.119.132.40:8200"

} 1

A response should be received similar to the lines below:

{
"qd": 2,
"env_variables": {
"VAULT_TOKEN": "<your token>"
"VAULT_ADDR": "https://10.119.132.40:8200"
}
1

Note the id of the vault, this will be needed in the next step to register the engine.

24 https://www.vaultproject.io/docs/auth/token
25 https://www.vaultproject.io/docs/auth/approle
26 https://www.vaultproject.io/docs/auth/cert

27 https://www.vaultproject.io/docs/commands
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4.4.4.3 AppRole

To use the AppRole authentication method, this needs to be included as part the login_command_args field, as
shown below.

"login_command_args":
[ "write", "auth/approle/login", "role_id=1", "secret_id=123"]

The full example to register the vault would appear as:

curl --location --request POST 'https://<hostname>/v2/management/vaults/hashicorp' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
-—header 'Authorization: apk <your API key>' \
--data-raw '{
"env_variables": {
"VAULT_ADDR": "https://10.119.132.40:8200"
I
"login_command_args":
[ "write", "auth/approle/login", "role_id=1", "secret_id=123"]
}l

A response should be received similar to the lines below:

{
I|-id|l: 2,
"env_variables": {
"VAULT_TOKEN": "<your token>"
"VAULT_ADDR": "https://10.119.132.40:8200"
}
3

4.45 TLS certificates

The configuration of mutual TLS authentication requires an additional step. This feature currently is NOT supported
for Kubernetes deployment of DCT. This will be covered in later releases.

4.4.5.1 Retrieving engine credentials

Once DCT can authenticate with the vault, it needs to know how to fetch the relevant engine credentials. When
registering an engine, the user will need to provide the HashiCorp CLI commands through the

hashicorp_vault_username_command_args and hashicorp_vault_password_command_args
parameters.

The relevant part of the engine registration payload will look like the following:
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'{

"hashicorp_vault_id": 1

"hashicorp_vault_username_command_args": ["kv", "get", "-field=username", '"kv-
v2/delphix-engine-secrets/engineUser"]
b

"hashicorp_vault_password_command_args": ["kv", "get", "-field=password", '"kv-
v2/delphix-engine-secrets/engineUser"]

} 1

The hashicorp_vault_id will be the ID that was returned as part of the previous step. Note that the exact paths to
fetch the username and password will vary depending on the exact configuration of the vault.

4.5 Accounts: connecting/authenticating

There are 5 supported methods for authentication; APl keys, Username/Password, LDAP/Active Directory, SAML/
SSO0, and OpenlID Connect. These authentication methods are detailed on the corresponding pages in this section.

a DCT uses Nginx/OpenResty?® as an HTTP server and a reverse proxy for the application. Using the default
configuration, all connections to DCT are over HTTPS and require the user to authenticate. The Nginx/

OpenResty configuration files can be edited via /etc/config bind mounts, for the proxy container to
customize the HTTP server and change options (such as TLS versions).

4.5.1 APIlkeys

4.5.1.1 APl keys

APl keys are the default method to authenticate with DCT. This is done by including the key in the HTTP
Authorization request header?® with type apk. A cURL example using an example key of
1.0p9PMkZ04HgyOezwjhX0OFi41lEKrD4pflejgqjdopfKtywlSWRIGOfIaWajuKcBT3 would appear as:

curl —--header 'Authorization: apk
1.0p9PMkZ04HgyOezwjhXOFi41EKrD4pflejgqjdOpfKtywlSWRIGOfIaWajuKcBT3"

a cURL (like web browsers and other HTTP clients) will not connect to DCT over HTTPS unless a valid TLS
certificate has been configured for the Nginx server. If this configuration step(see page 75) has not been
performed yet and the risk is comprehended, you may disable the check in the HTTP client. For instance,
this can done with cURL using the --insecure flag. The cURL version must be 7.43 or higher.

28 https://openresty.org/en/
29 https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/Authorization
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Create and manage API Keys

The initial APl key created should be used to create a new admin secure key. This is done by creating a new Account
entity and setting the generate_api_key. The "username" attribute should be the desired name to uniquely identify
the account.

curl --location --request POST 'https://<hostname>/v2/management/accounts' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
-—header 'Authorization: apk
1.0p9PMkZ04Hgy0ezwjhXOFi41EKrD4pflejgqjdopfKtywlSWROGOfIaWajuKcBT3"' \
--data-raw '{

"username": "secure-key",

"generate_api_key": true

} 1
a If the cURL version being used is below 7.43, replace the --data-raw option with --data.

A response should be received similar to the lines below:

{
"id": 2,
"token": "2.vCfCOMnpySYZLshuxap2aZ7xqBKANQvV7hFnobe7xuNTHS9AF2NQnVIOXXw4UyET6"
"username":"secure-key"

}

Now that the new and secure API key is created, the old one must be deleted for security reasons since the key
appeared in the logs. To do this make the following request:

curl --location --request DELETE 'https://<hostname>/v2/management/api-clients/<id>"'
\

--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

--header 'Authorization: apk

2.vCfCOMnpySYZLshuxap2aZ7xqBKANQvVThFnobe7xuNTHS9AF2NQNVIXXw4UyET6'

The id referenced above is the numeric id of the Account. It is the integer before the period in the token. For
example, theid of 1.0p9PMkZ04HgyOezwjhXOFi41lEKrD4pflejgqjdopfKtywlSWROGOfIaWajuKcBT3
is 1.

Finally, to list all of the current Accounts, make the following request:

curl --location --request GET 'https://<hostname>/v2/management/accounts/' \
--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

--header 'Authorization: apk <your API key>'
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4.5.2 Username/password

When creating an account, a username and password combination can be associated with the account (whether an
API Key was generated for the account or not). To do so, specify the “username” and “password” properties in the
API request, for example:

curl -k --location --request POST 'https://<hostname>/v2/management/accounts' \
--header 'Content-Type: application/json' \
-—header 'Accept: application/json' \
-—header 'Authorization: apk
1.0p9PMkZ04Hgy0ezwjhXOFi41EKrD4pflejgqjdOpfKtywlSWROGOfIaWajuKcBT3" \
--data-raw '{
"username": '"some-username",
"password": "some-password",
"generate_api_key": false
"is_admin'": true

} 1

8 The is_admin property will create the account with admin privileges. Remove this property to create an
account without admin privileges.

The username and password combination can then be used to login via the Ul, or to fetch a temporary access token
valid for 24 hours. To do so, call the ‘login’ APl endpoint:

curl -k --location --request POST 'https://<hostname>/v2/login' \
--header 'Content-Type: application/json' \
-—header 'Accept: application/json' \
--data-raw '{
"username": '"some-username",
"password": '"some-password"

} 1

Aresponse should be received similar to the lines below:

"access_token":"eyJhbGciO0iJIUzI1INiJ9.eyIpc3MiOiJhcGlndylzZXJ2aWNlcylhcHATLCIzdWIA
0iI4I4wiZXhwIjoxNjYyNTUyMzI3LCIpYXQiOjE2NJIONjUSMjcsInVzZXJuYW1lIjoic29tZS11c2VybmFtZ
SJ9.Cx_hGU9noywWSemtK6gjsA85FTgIRQgyJizR5t_akNps",

"token_type":"Bearer",

"expires_in":86400

}

The access token can be used as HTTP Authorization request header3® with type Bearer. A cURL example using the
access token retrieved above would appear as:

30 https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/Authorization
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curl --header 'Authorization: Bearer
eyJhbGci07iIIUZIINTJ9.eyIpc3MiniIhcGlndy1zZXJI2aWNlcylhcHATLCIZdWIi0i I4TiwizZXhwIjoxNjYy
NTUyMzI3LCIpYXQi0jE2NjIONjU5MjcsInVzZXJuYW1lIjoic29tZS11c2VybmFtZSJ9.Cx_hGUInoyWSemtK
6gjsA85FTgIRQgyJizR5t_akNps'

The password for an account can be updated with the change_password APl endpoint, passing in both the old and
new passwords, such as in this example:

curl -k --location --request POST '<hostname>/v2/management/accounts/3/
change_password \

--header 'Content-Type: application/json' \

-—-header 'Accept: application/json' \

-—header 'Authorization: Bearer
eyJhbGci0i1JIUzI1INiJ9.eyIpc3MiOilhcGlndylzZXJ2aWNlcylhcHATLCIZzdWIi0iI4IiwiZXhwIjoxNjYy
NTUyMzI3LCIpYXQiOjE2NjIONjU5S5MjcsInVzZXJuYW1lIjoic29tZS11c2VybmFtZSJ9.Cx_hGU9noyWSemtK
6gjsA85FTgJRQgyJizR5t_akNps' \

--data-raw '{

"old_password": '"some-password",
"new_password": "new-password"

} 1

Following security best practices, the password is not stored on DCT and cannot be retrieved. If the password has
been lost, an account with admin privilege can reset the password for a particular account. It is recommended to
change the password reset by an admin account on the first login, or with the change_password API, as described
above.

curl -k --location --request POST '<hostname>/v2/management/accounts/2/
password_reset' \

--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

--header 'Authorization: Bearer
eyJhbGci0iJIUZzI1INiJ9.eyIpc3MiOiJhcGlndylzZXJ2aWNlcylhcHATLCIzdWIi0iI4IiwiZXhwIjoxNjYy
NTUyMzI3LCIpYXQiOjE2NFIONjU5MjcsInVzZXIuYWLlIjoic29tZS11c2VybmFtZSI9.Cx_hGUInoyWSemtK
6gjsA85FTgJRQgyJizR5t_akNps' \

--data-raw '{

"new_password": "new-password"

} 1

In the above example, the admin is resetting the password of an account with id 2 to “new-password”.

4.5.2.1 Password policies

The password policy feature allows users to enable and customize the password policy enforced for local
username/password authentication (does not apply to LDAP/Active Directory or SAML/SSO based authentication).

4.5.2.2 Understanding password policies

The password policy is a set of requirements that local passwords must satisfy.
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« min_length: A password must be longer than this length.

+ reuse_disallow_limit: The user should not reuse old passwords. This tells the number of last used
passwords disallowed to be reused as the new passwords.

« uppercase_letter: A password must have at least one capital letter.

+ lowercase_letter: A password must have at least one lower case letter.

« digit: A password must have at least one digit.

« special_character: A password must have at least one special character, such as #, $, !

« disallow_username_as_password: A password should not be the same as the user name.

« maximum_password_attempts: The number of allowed attempts for incorrect password, after which the
account gets locked.

4.5.2.3 Default password policy

By default, DCT does not enforce any password policy.

4.5.2.4 Changing the password policy

To change the current password policy, call the password policy APl endpoint, as shown in the example below:

curl --location --request PATCH 'https://<hostname>/v2/management/accounts/password-
policies' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
--header 'Authorization: apk <your API key>' \
--data-raw '{
"enabled": true,
"maximum_password_attempts": 2,
"min_length": 5,
"reuse_disallow_limit": 3,
"digit": true,
"uppercase_letter": true,
"lowercase_letter": true,
"special_character": true,
"disallow_username_as_password": true

} 1

Changing the password policy does not affect existing passwords.

4.5.2.5 Disabling local username/password authentication

Username/password authentication (with passwords locally in DCT) can be disabled for individual accounts by not
setting or unsetting their password property, or across the DCT instance using the global properties API. Disable
username/password authentication to force authentication to use an alternate authentication method (LDAP/
Active Directory, SAML/SSO, etc.) as shown in this example:

curl --location --request PATCH 'https://<hostname>/v2/management/properties' \
--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

--header 'Authorization: apk <your API key>' \
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--data-raw '{"disable_username_password": true}'

4.5.3 LDAP/Active Directory

4.5.3.1 Configuration

LDAP/Active directory can be used to authenticate login requests, and optionally to retrieve additional information
about accounts, thereafter referred to as LDAP Search.

Configuring authentication

The following attributes must be set to configure LDAP/Active Directory authentication.

Property Name Description
enabled Whether the LDAP/Active Directory feature is enabled.
auto_create_users Whether DCT must automatically create account

records for successful authentication attempts using a
username which does not match any accounts.

If this is disabled, an administrator must create a DCT
account with an ldap_principal attribute matching the
value from the LDAP/Active Directory server prior to
the first login attempt.

If this is enabled, any user with valid credentials in the
LDAP/Active Directory server can authenticate to DCT,
by default with an empty authorization set (i.e not
being able to view any data or perform any action).

hostname The host name or IP address of the LDAP/Active
Directory server.

port Port of the LDAP/Active Directory server. This is
usually 389 for non SSL, and 636 for SSL.

enable_ssl Whether the connection to the LDAP/Active Directory
server must be performed over SSL. It is highly advised
to use SSL. Without SSL, communication between DCT
and the LDAP/Active server can be intercepted.

insecure_ssl, unsafe_ssl_hostname_check, The SSL protocol requires the LDAP/Active Directory

trustore_file_name, truststore_password server to expose a certificate signed by a Certificate
Authority (CA) trusted by the JDK which is running
DCT. Refer to the dedicated section below to see how
to configure an Active Directory/LDAP server of which
certificate is not recognized.
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Description

Microsoft Active Directory only: The DNS name of a
domain in the same forest as the accounts which
login. DCT will append the msad_domain_name to the
username provided at login to form a user principal
name (UPN).

Example: if the msad_domain_name is http://
mycompany.co and a user logs in with username john,
DCT will perform an LDAP request to the Active
Directory server to authenticate
john@mycompany.co3L.

If the LDAP server is not Microsoft Active Directory, the
username_pattern is used to create a DN string for
user authentication. The pattern argument {0} is
replaced with the username at runtime.

Example: If the username_pattern is
uid={0},ou=People and a user logs in with username
john, DCT will perform an LDAP request with DN
uid=john,ou=People.

The LDAP/Active Directory Integration can be configured both via DCT Ul and API. The below image shows an
example of how the configuration can be set in the Ul as a way to Authenticate users, auto create new users, as well
as map group attributes for authorization within the DCT Access Control system.

31 mailto:;john@mycompany.co
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Edit LDAP Settings

Enabled

Auto-create Users
Hostnama

activedirectory.acme.com

Port

636

Domains

MEAD Domain Mama

acme.com

Username Pattern

Search Base
CN=Users,DC=acme,DC=com
Group Attribute

department

Email Attribute

mail 4

-

First Narne Attribute

givenName

Last Name Attribute

sn

Object Class Aftribute

person

Search Aftribute

sAMAccountName

The following example requests enable LDAP authentication over SSL with an Active Directory server at address
activedirectory.company.co usingthe us.company.co domain:

curl --location --request PUT 'https://<hostname>/v2/management/ldap-config' \

Deployment - 66



Data Control Tower - Data Control Tower Home

--header 'Content-Type: application/json' \
--header 'Accept: application/json' \

--header 'Authorization: apk <your API key>' \
--data-raw '{

"enabled": true,

"auto_create_users": true,

"hostname'": "activedirectory.company.co",
"enable_ss1": true,
"port": 636,

"domains": [{
"msad_domain_name":"us.company.co"

}]
}l

Validating the configuration

Updating the LDAP/Active Directory configuration does not guarantee that the provided values are correct, as
validating those requires a user to authenticate to DCT. This can be achieved with the ldap-config/validate API
endpoints, using the credentials valid for the LDAP/Active Directory server. When provided with a username/
password combination, the ldap-config/validate APl endpoint will authenticate with the LDAP server. If the
response status code is 200, the configuration is correct. Otherwise, the response code will be 400, and the
response body will provide information to resolve the configuration problems. For example:

curl --location --request POST 'https://<hostname>/v2/management/ldap-config/
validate' \

--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

-—header 'Authorization: apk <your API key>' \

--data-raw '{

"username'": "<ldap-username>",

"password": "<ldap-password>"

} '

a Because of a defect in version 3.0.0 of DCT, the above request might fail with a response similar to:

search failed for john.doe with search base null' ,search attribute
"null’

This indicates that authentication works, and search (see below) is not configured.

Login

One the configuration has been updated, accounts can login (via the Ul or API) using the same Ul form/API endpoint
they would be using for the local username/password authentication feature. For example:

curl -k --location --request POST 'https://<hostname>/v2/login' \
-—header 'Content-Type: application/json' \

-—header 'Accept: application/json' \

--data-raw '{
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"username'": "<ldap-username>",
"password": "<ldap-password>"

} ]

When LDAP/Active directory is enabled, DCT first attempts to validate passwords with the LDAP/Active Directory
server, and falls back to local password authentication in case of failure. Enabling LDAP/Active directory is thus a
non disruptive operation for existing accounts.

In order to force a transition to LDAP/Active Directory only password authentication, the DCT administrator must
either update the account records to remove the password, or disable local password authentication entirely.

4.5.4 SAML/SSO

The SAML 2.0 protocol allows DCT to delegate authentication to a SAML 2.0 compatible Identity Provider (Active
directory federation services, Azure active directory, Ping federate, Okta, OnelLogin, etc.). It only applies to web
browser based interaction, and cannot be used for APl access (scripting, integration).

Setting up SAML/SSO requires configuration changes both in the Identity Provider and DCT, so that trust can be
established across both products.

When using SAML/SSO, DCT will uniquely identify accounts by email address, so make sure that records at the
identity provider are configured with a unique email address.

DCT supports automatic account creation (or just in time account provisioning) when using SAML/SSO. When
automatic account creation is enabled, accounts are created automatically when users login for the first time.

DCT allows group membership to be retrieved from the Identity Provider, which can be used to control access
control authorization within DCT via DCT Access Groups. Using Identity Provider group membership allows DCT
authorization to be managed per account group, and guarantees that authorizations in DCT reflect the organization
structure which is expressed by group membership of the identity provider.

SAML/SSO is not mutually exclusive with other authentication methods, so enabling SAML/SSO is not disruptive
(accounts configured with local password or LDAP/Active Directory authentication can still authenticate). In order
to switch to SAML/SSO exclusively as authentication method for web browser interaction, perform the SAML/SSO
configuration steps below and disable LDAP/Active Directory and Username/Password authentication. Note that
API Key based authentication cannot be entirely disabled, but only administrators can create accounts with API
keys.

4.5.4.1 ldentity provider setup

Require that an administrator of the Identity provider used by your organization sets up a SAML 2.0 integration with
DCT (an integration is sometimes called a Relying party trust, or an application).

The exact instructions are product specific, but the following input values must be provided:

Name + Alternative name depending Value
on product
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Single Sign-on URL « SAML Assertion Consumer https://<dct-hostname>/v2/saml/
Service SSO
« ACS

+ Recipient URL
+ Destination URL
+ Relying party SAML 2.0 SSO

+ Service URL
+ Reply URL
Audience URI « SPEntity ID Any value can be selected, as long
« Relying Party trust identifier as the same value is set in the
Identify Provider configuration and
DCT configuration. We
recommend:
https://<dct-hostname>
Binding « POST
Protocol SAML 2.0 WebSSO protocol

The identity provider must be configured to include the email address as Nameld attribute, and DCT will use the
email attribute as a unique identifier for users when connecting via SAML/SSO.

4.5.4.2 DCT SAML/SSO setup

Once the configuration has been performed at the Identity provider, use the saml-config APl endpoint to configure
DCT accordingly. If DCT has network access to the Identity Provider server, and the Identity Provider provides a
“metadata URL”, you can point DCT directly to the metadata URL. Otherwise, for instance when a firewall blocks
network access from DCT to the Identity Provider, copy the metadata from the Identity Provider using a web
browser and provide it directly to DCT.

The Identity provider (IDP) metadata is a standardized XML document providing the SAML Service Provider (DCT)
with the necessary information to verify the validity of incoming login requests and initiate a SAML/SSO login flow.

The metadata URL is sometimes called “App Federation Metadata URL”, and is sometimes only known by reading
the Identity Provider’s product documentation (for instance Active Directory Federation Services, or ADFS,
publishes the metadata URL at https://<hostname>/federationmetadata/2007-06/federationmetadata.xml).

If auto_create_users isenabled, DCT will create accounts automatically when they login with SAML/SSO for

the first time. If this is disabled, an administrator must create a DCT account with an email attribute matching the
value from the SAML/SSO Identity provider before they can login. When auto_create_users is enabled, any user
configured to authenticate via the Identity provider can authenticate to DCT, by default with an empty
authorization set (i.e not being able to view any data or perform any action).

Example 1: With network access, point DCT to the metadata URL.

curl --location --request GET 'https://<hostname>/v2/management/saml-config' \
-—header 'Content-Type: application/json' \

-—header 'Accept: application/json' \

--header 'Authorization: apk <your API key>' \
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--data-raw '{
"enabled": true,
"auto_create_users": true,
"metadata_url": "<idp-metadata-url>",

} ]

Example 2: Without network access, provide the IDP metadata directly.

curl --location --request PUT 'https://<hostname>/v2/management/saml-config' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
--header 'Authorization: apk <your API key>' \
--data-raw '{
"enabled": true,
"auto_create_users": true,

"metadata": "<json-escaped-idp-metata-xml-blob>",
} !
The IDP metadata must be JSON escaped. On a terminal with ./jg3? installed, this can be achieved with
the following command: jq --slurp --raw-input <<< 'xml-metadata-here'
4.5.4.3 Login

The SAML 2.0 protocol defines two login procedures: The Service Provider initiated flow starts by having users point
their web browserto https://<dct-hostname>/v2/saml/login to login, while the Identity provider
initiated flow starts at the Identity provider (details specific to Identity provider vendor). DCT supports both flows.
The SAML/SSO authentication method is not intended for APl interaction, and cannot be used with the Swagger Ul.

After successful authentication, the web browser is redirected to the Ul landing page and the the navigation bar can
be used to go to the desired page. The session expires 24 hours after login.

4.5.4.4 Troubleshooting
There was an issue in SAML authentication: The assertion cannot be used before <timestamp>

The above error message, which is accompanied by com.coveo.saml.SamlException: The assertion cannot be
used before <timestamp=> error in the application logs, indicates that DCT was not able to validate the timestamp of
the authentication provided by the Identity Provider. This is usually due to the system clock of the machine running
DCT being incorrectly configured. Consider using NTP to maintain the machine’s clock up to date.

There was an error fetching data

The above error message indicates that the current account does not have permission to view the data displayed on
the page. Remember that, while DCT creates accounts automatically upon login when auto_create_users is
enabled, by default accounts are created without any authorization and thus cannot see any data. Review the
section below to see how SAML/SSO group membership can be assigned automatically at account creation.

32 https://stedolan.github.io/jq/
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4.5.4.5 Attributes mapping

As explained above, the only required attribute in the SAML Response (the message sent by the Identity Provider to
DCT during login) is the Nameld attribute which must be configured to a unique email address.

In addition to this, DCT allows for first name, last name, and group membership attributes to be included. The first
and last names attributes will be stored as properties of the account object. For each group membership found in
the SAML response attribute, an account tag is created with key=login_groups and value is the group name. These
tags are protected (i.e cannot be modified within DCT) and can be securely used to control access groups
membership.

In other to enable these optional attributes, update the Identity provider configuration to include them in the SAML
response, and use the saml-config AP| endpoint to configure DCT with the name of the attributes configured in the
Identity provider:

curl --location --request PUT 'https://<hostname>/v2/management/saml-config' \
-—header 'Content-Type: application/json' \
-—header 'Accept: application/json' \
--header 'Authorization: apk <your API key>' \
--data-raw '{
"enabled": true,
"auto_create_users": true,
"metadata": '"<json-escaped-idp-metata-xml-blob>",
"first_name_attr": "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/
givenname",
"last_name_attr": "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/surname",
"group_attr": "http://schemas.xmlsoap.org/claims/Group"

} 1

With the above configuration, and a SAML Response as the following produced by the Identity Provider during login:

<?xml version="1.0" encoding="UTF-8"7?>
<saml2:Assertion ID="1d97923983167603821157180516" IssueInstant="2022-12-01T10:07:12.
856Z" Version="2.0"
xmlns:saml2="urn:oasis:names:tc:SAML:2.0:assertion">
<saml2:Issuer Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity">http://
www . idp—demo.com/exklfupjwzlYcMo290h8</saml2:Issuer>
<saml2:Subject>
<saml2:NameID Format="urn:oasis:names:tc:SAML:1.1l:nameid-format:unspecified">
john.doe@company.co</saml2:NameID>
<saml2:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
<saml2:SubjectConfirmationData NotOnOrAfter="2022-12-01T10:12:12.857Z2"
Recipient="https://localhost/v2/saml/SS0" />
</saml2:SubjectConfirmation>
</saml2:Subject>
<saml2:Conditions NotBefore="2022-12-01T10:02:12.857Z" NotOnOrAfter="2022-12-01T1
0:12:12.857Z2">
<saml2:AudienceRestriction>
<saml2:Audience>https://dct-demo.delphix.com</saml2:Audience>
</saml2:AudienceRestriction>
</saml2:Conditions>
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<saml2:AuthnStatement AuthnInstant="2022-12-01T10:05:07.916Z" SessionIndex="id166
9889232855.2084756273">
<saml2:AuthnContext>
<saml2:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:Passwo
rdProtectedTransport</saml2:AuthnContextClassRef>
</saml2:AuthnContext>
</saml2:AuthnStatement>
<saml2:AttributeStatement>
<saml2:Attribute Name="http://schemas.xmlsoap.org/ws/2005/05/identity/claims/
givenname" NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml2:AttributeValue
xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi:type="xs:st
ring">John
</saml2:AttributeValue>
</saml2:Attribute>
<saml2:Attribute Name="http://schemas.xmlsoap.org/ws/2005/05/identity/claims/
surname" NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml2:AttributeValue
xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi:type="xs:st
ring'">Doe
</saml2:AttributeValue>
</saml2:Attribute>
<saml2:Attribute Name="http://schemas.xmlsoap.org/claims/Group" NameFormat="u
rn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml2:AttributeValue
xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi:type="xs:st
ring">Dev-Team
</saml2:AttributeValue>
<saml2:AttributeValue
xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi:type="xs:st
ring">QA
</saml2:AttributeValue>
</saml2:AttributeStatement>
</saml2:Assertion>

Would automatically create or update a DCT account with the following properties:

{
"jd": 94,
"username": "john.doe@company.co",
"firstName": "John",
"lastName'": "Doe",
"email": "john.doe@company.co",
"tags": [
{

"key": "login_groups",
"value": "Dev-Team"

I
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"key": "login_groups",
Ilvaluell: IIQAII

4.5.4.6 Configure LDAP/Active Directory groups

In addition to being an authentication method, the LDAP/Active Directory integration can optionally also be used to
retrieve additional attributes about the accounts authenticating: first name, last name, email address and group
membership.

DCT only supports retrieving groups which are exposed as an attribute of the LDAP/Active Directory user record.
DCT can not fetch groups membership from group records at the LDAP/Active Directory, and thus also does not
support nested groups.

Group memberships are retrieved at authentication time, using the account credentials. DCT does not need
credentials of an LDAP/Active Directory administrator, but will only be able to retrieve group memberships if LDAP/
Active Directory users have the right to read the corresponding attribute.

This can be enabled by setting additional arguments to the domain APl object.
search_base The Context name in which to search. Being specific
enables faster LDAP search.

To construct the search_base DN string according to
your LDAP/Active Directory server, using an LDAP
browser, navigate to a user, and then construct the
search_base DN in reverse order from the User, up the
folder hierarchy. For example:

If a User DN is:
CN=some-user-id,CN=Users,DC=mycompany,DC=co
The corresponding search base might be:

CN=Users,DC=mycompany,DC=co

email_attr Name of the attribute in the LDAP/Active Directory
server containing email addresses.

Example: mail

last_name_attr Name of the attribute in the LDAP/Active Directory
server containing last names
Example: sn

first_name_attr Name of the attribute in the LDAP/Active Directory

server containing first names

Example: givenName
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Name of the attribute in the LDAP/Active Directory
server containing group(s) membership. This can be a
multi-valued attribute.

Example: memberOf

Name of the attribute in the LDAP/Active Directory
server of which value corresponds to the username
provided to the DCT login requests.

For Active Directory, this is usually sAMAccountName.

Example: If the search base is
CN=Users,DC=mycompany,DC=co and the
search_attr is principalName, DCT will search for a
record with a principalName matching the username
provided to the login request under the
CN=Users,DC=mycompany,DC=co sub tree.

Restricts search to records with an objectClass
matching this value.

Example: person

The following requests enable LDAP authentication over SSL with an Active Directory server at address

activedirectory.company.co ,usingthe us.company.co domain, and configures optional attributes

to retrieve first name, last name, email address, and group membership from the users sub-tree.

curl --location --request PUT 'https://<hostname>/v2/management/ldap-config' \

--header 'Content-Type: application/json'
--header 'Accept: application/json'
-—header 'Authorization: apk <your API key>'

--data-raw '{
"enabled": true,
"auto_create_users": true,

"hostname":
"enable_ss1":

"port": 636,
"domains": [{

1

"msad_domain_name" :"mycompany.co",

"activedirectory.mycompany.co",
true,

\

"search_base":"CN=Users,DC=mycompany,DC=co",

"email_attr": "mail",
"first_name_attr": "givenName",
"last_name_attr": "sn",

"group_attr":

"object_class_

"'search_attr":

"memberOf",
attr":"person",
""'sAMAccountName"
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} ]

With the above config, when a user logs in with username John, DCT will:

1. Authenticate with the Active Directory server using the user principal name john@mycompany.co3® and
supplied password.

2. Search in the CN=Users,DC=mycompany,DC=co sub tree a record with objectClass=person and
sAMAccountName=john.

3. Create or update a DCT Account record with the attributes extracted from the Active Directory server.

4. Foreach group membership found in the memberOf of the Active Directory server, an account tag is
created with key=login_groups and value is the group name. These tags are protected (i.e cannot be
modified within DCT) and can be securely used to control access groups membership.

As explained above, the ldap-config/validate APl endpoint can be used to validate that each of the attributes
corresponding to LDAP/Active Directory attributes.

4.6 Replace HTTPS certificate for DCT

By default, to enable HTTPS, DCT creates a unique self-signed certificate when starting up for the first time. This
certificate and private key are configured in the values.yaml file under:

proxy:
crt:<certificate_value>
key:<key_value>

To use your own certificates, these default values need to be replaced. They are Base64 encoded values of the
certificate and key, respectively.
+ To generate the Base64 encoded value of the certificate:
cat mycertfile.pem | base64 -w 0
« To generate the Base64 encoded value of the key:
cat mykey.key | base64 -w 0

Generating a new TLS certificate and key could require the assistance of your Security or IT departments. A new key
pair (public and private key) will need to be created, in addition to a certificate signing request (CSR) for that key
pair. Your IT department should be able to determine the correct certificate authority (CA) to sign the CSR and
produce the new certificate. The common name of the certificate should match the fully qualified domain name
(FQDN) of the host, as well as the FQDN as a Subject Alternative Name (SAN).

4.7 External database support

4.7.1 Overview

DCT uses a PostgreSQL database to store all the persistent data powering the application (engines, VDBS,
compliance jobs, accounts, permissions, etc.). By default, a PostgreSQL container image is packaged along with the

33 mailto:john@mycompany.co
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DCT application and deployed along other pods onto the Kubernetes cluster, storing its persistent data into the
gwdatabase-data persistent volume.

Alternatively, DCT can be configured to use an external PostgreSQL database instead, to which DCT connects over

TCP and can then run anywhere (typically outside of the Kubernetes cluster).

& External database support is only available for Kubernetes and OpenShift deployments. Docker Compose
installations are not eligible.

4.7.2 Requirements

+ Database type: PostgreSQL
« Min supported version: 13.4
« Max supported version: 14.7

4.7.3 Setup

4.7.3.1 PostgreSQL database setup

The following databases must be created prior to connecting DCT: app, jobs, data-library, and bookmarks.

& Quotes must be used to create or connect to the "data-library" databases, since its name contains a
hyphen (-). Creating the database with a different name (such as data_library) will NOT work.

A PostgreSQL user must be created for DCT, with either the admin privilege or ALL privilege on the above databases.
The following SQL script exemplifies the creation of required databases, granting privileges to a pre-existing

dct_user (role) user.

Shell

CREATE DATABASE "bookmarks'";
GRANT ALL PRIVILEGES ON DATABASE "bookmarks" TO dct_user;

CREATE DATABASE "data-library";
GRANT ALL PRIVILEGES ON DATABASE "data-library" TO dct_user;

CREATE DATABASE "jobs";
GRANT ALL PRIVILEGES ON DATABASE "jobs" TO dct_user;

CREATE DATABASE "app";
GRANT ALL PRIVILEGES ON DATABASE "app" TO dct_user;

4.7.3.2 DCT setup

Edit the values.yamlfile to set useExternalDatabase totrue,and also provide the dbHost , dbPort,

dbUser ,and dbPassword ,then run the following.
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Shell

helm upgrade -f values.yaml dct-services delphix-dct

& Previous versions of DCT required the aforementioned properties to be base64 encoded, but the values
must be plain text values, as shown in the following excerpt:

useExternalDatabase: true

dbHost: "database-host.company.co"
dbPort: 5432

dbUser: "dct_user"

dbPassword: "dct_user_password"

& Ifthe password is stored as exemplified above in the values.yaml file, make sure to store this file in a
secure location. Alternatively, set the value using the --set option flag in the helm upgrade command, as
shown in the following excerpt:

helm upgrade -f values.yaml --set dbPassword=dct_user_password dct-

services delphix-dct

4.7.4 Backup and recovery

When using an external database, the gwdatabase-data persistent volume (created at default by DCT) to store

database data is not used. Backing up and restoring the external database is not managed by DCT. Frequent or
continuous backups are required, otherwise, DCT data will be lost.

The gateway-data persistent volume must still be backed up because it contains an encryption key, which is
used to encrypt sensitive data at the application-level, before being sent to the database. A backup of the external
database cannot be restored successfully without a corresponding backup of gateway-data ,as DCT would not

be able to decrypt some of the data in the database. The encryption key in gateway-data does not change after
having been initially created, so backups of it do not need to be scheduled at the same time as database backups.

4.7.5 External database migration or upgrade

The external database can be migrated to a different host, and/or upgraded to a different version at any time, as
long the version requirements above are met. If the database is unavailable for a period of time, the DCT application
will temporarily fail (internal server errors on all API calls), but will recover automatically without the need for a
restart. However, in case of planned maintenance, upgrade, or migration, the following procedure should be
followed:

Stop (shutdown) the DCT application.

Upgrade or migrate the database.

If necessary, set the updated database properties in values.yaml,and run helm upgrade .
Start the DCT application.

H w e
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4.7.6 DCT upgrade

Before upgrading to a new DCT version, review the documentation to identify if the external database version is
compatible. If the external database version is unknown, call the metadata-database APIendpointto get the
information.

curl -k --location --request GET 'https://<dct-server>/v3/management/metadata-
database' \

--header 'Accept: application/json' \

--header 'Authorization: apk <api-key>'

{
"external": false,
"version": "14.7",
"database_product_name'": "PostgreSQL",
"major_version": 14,
"minor_version": 7,
"min_supported_major_version": 13,
"min_supported_minor_version": 4,
"max_supported_major_version": 14,
"max_supported_minor_version": 7,
"compatible": true

3

If the version of the external database is not compatible with the requirements of the DCT version being upgraded
to, follow the instructions in the External database migration or upgrade section above before upgrading.

The selected PostgreSQL version to upgrade to must be compatible with both the currently running DCT
version and the upgrade version.

After the upgrade, verify if the external database is compatible with DCT by inspecting the compatible property

ofthe metadata-database APIendpoint (as shown above).

4.8 DCT data backup and recovery

(@ This method is only applicable for Kubernetes and OpenShift.
« For Kubernetes, use the kubectl command prefix.
« For OpenShift, use the oc command prefix.

4.8.1 Data backup of Persistent Volumes used by DCT

Based on customer need or backup policy, they need to take a backup of data in Persistent Volumes. In DCT,
gateway and database services are using Persistent Volume hence customer need to take backup of data folder
mounted on mounted path.
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Take the backup (copy) of the data folders for the gateway Persistent Volume:

kubectl cp {gateway_pod_name}:/data data -n dct-services

Take the backup (copy) of the data folders for the database Persistent Volume:

kubectl cp {database_pod_name}:/var/lib/postgresql/data/ dct_database -n dct-services

4.8.2 Restore data backup in a new DCT setup

Deploy DCT services with the same version for which data back-up was taken. This deployment will create a new
Persistent Volume data folder for the cluster.

Use the following steps to copy the backup data in this new deployment.

First, stop all services.

Terminate proxy pod to stop serving external traffic:

kubectl scale --replicas=0 deployment/proxy —-n dct-services

Terminate the database to stop internal threads using the database:

kubectl scale --replicas=0 deployment/database -n dct-services

Terminate the gateway to stop using Persistent Volume data:

kubectl scale --replicas=0 deployment/gateway -n dct-services

Createa dummy pod to access the Persistent Volume using pod.yaml, as shown below.

apiVersion: vl
kind: Pod
metadata:
Namespace: dct-services
name: dummy-pod
labels:
app: dummy-pod
spec:
containers:
- image: ubuntu
command:
— "S'Leep"
- "604800"
imagePullPolicy: IfNotPresent
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name: ubuntu
restartPolicy: Always
volumes:
- name: gwdatabase-data
persistentVolumeClaim:
claimName: gwdatabase-data

Create the dummy pod with:

kubectl apply -f pod.yaml -n dct-services

Copy the backup Persistent Volume data into a new cluster.

Move the encryption key:

kubectl cp data dct-services/{gateway_pod_name}:/data

Move the Postgres data:

kubectl cp dct_database dct-services/{dummy_pod_name}:/var/lib/postgresql/data

Delete the dummy pod.

kubectl delete pod dummy-pod -n dct-services

Startthe database pod (scaleto 1):

kubectl scale --replicas=1 deployment/database -n dct-services

Restart all services.

Delete or patch the gateway pod:

kubectl delete pod {gateway_pod_name} -n dct-services

Delete or patch the data-Tlibrary pod:

kubectl delete pod {data-library_pod_name} -n dct-services

Delete or patch the jobs pod:
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kubectl delete pod {jobs_pod_name} -n dct-services

Delete or patch the data-bookmarks pod:

kubectl delete pod {data-bookmarks_pod_name} -n dct-services

Start the proxy service to serve the external service:

kubectl scale --replicas=1 deployment/proxy -n dct-services

4.9 Exporting DCT logs to Splunk

49.1 Overview

This article provides some tips for configuring DCT (running on Kubernetes) to send logs to Splunk and extract
useful information in Splunk.

4.9.2 Settingup a Splunkinstance

Authenticate with Splunk via the web portal and install the third-party Monitoring Kubernetes3* app directly via the
Splunk Ul, then enable HTTP Event Collector in Splunk and save the HTTP Event Collector token for future use.

4.9.3 Enable Splunk log forwarding

Once the Splunk instance is setup, follow the instructions to install Splunk logic in the Kubernetes cluster to

forward logs to Splunk. This blog post3® is a useful resources to understand the log collection and configuration
options.

git clone https://github.com/splunk/splunk-connect-for-kubernetes.git
cd splunk-connect-for-kubernetes/helm-chart/splunk-connect-for-kubernetes
edit values.yaml

Edit values.yaml, at the minimum the host property (hostname of the Splunk collector) and token (of the HTTP Even
Collector) must be set.

global:
logLevel: info
splunk:

hec:

34 https://splunkbase.splunk.com/app/3743
35 https://faun.pub/logging-in-kubernetes-using-splunk-c2785948fdc0
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# host is required and should be provided by user

host: <insert-splunk-http-event-collector-hostname-here>
# port to HEC, optional, default 8088

port:

# token is required and should be provided by user
token: <insert-token-here>

Install the helm chart and and after a few minutes DCT logs will be visible in Splunk.

helm 1install splunk-connect-for-kubernetes . -f values.yaml --set splunk-kubernetes-
logging. fullnameOverride=splunk-logging

4.9.4 Search foreventsin Splunk

In the Splunk Cloud Ul, via the “Monitoring Kubernetes” App, you can “search” for data sent by Kubernetes, as
exemplified in the screenshot below. The bootstrap APl key can be found as shown.

« > C O & https://prd-p-h6jvj.splunkcloud.com/en-US/app/monitoringkubernetes/sc ¥y ® ¥ @ 1 E 95 =

splunk | Apps ¥ Messages v Settings Activity v Q Find 2 EyalKaspi v (7 32

Overview Workloads ¥ Monitoring v Top~ Events Logs Cluster » Review v Security ¥ Monitoring Kubernetes

Setup+ Search Alerts Dashboards

New Sea I‘Ch Save As v Create Table View Close
NEWLY Last 24 hours ¥ n
v 1event (2/5/23 9:00:00.000 AM to 2/6/23 9:46:47.000 AM) Job~ A B standard_perf (search ® Smart
default) » Mode ¥
No Event Sampling » +
Events (1) Patterns Statistics Visualization
Format Timeline v — Zoom Out 1 hour per column

> Show Fields List » # Format 20 Per Page
i Time Event
> 2/6/23 NEWLY GENERATED API KEY: 1.r2hSuyelRLY86GF1q7nPHIngQNo20rQLzVKzPZmsVTbbdBt44qpDz1c13N8XSWOT

9:38:33.646 AM host = docker-desktop : source = /var/log/containers/gateway-77bdbd85bc-8htfh_apigw-services_gateway-640fb...
sourcetype = kube:container:gateway

The example screenshot below shows a search for \”nginx\”, with use of the “extract new fields” wizard on the
bottom left, which has Splunk parse the Nginx access logs. A regexp is used to name some of the fields like
ipaddress, endpoint, accountid, etc. The example runs a search to return APl requests associated with accountid.
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<« - C QO B https://prd-p-h6jvj.splunkcloud.com/en-US/app/monitoringkubernetes/search? ¥ ® ¥ 0 1 E gy =

splunk Apps ¥  Messages ¥  Settings v  Activity v | Q Find 2 EyalKaspiv @~

Overview Workloads ¥ Monitoring ¥ Top~ Events Logs Cluster v Review v Security ¥ Monitoring Kubernetes

Setup v Search Alerts Dashboards

New SearCh Save As ¥ Create Table View Close

index=_* OR index=* sourcetype=kube:container:proxy AND account!="[:]" AND| endpoint!="\"POST /v2/management/accounts/search Last 24 hours ¥ n

?limit=50&sort=first_name HTTP/1.1\"200"
v 27 events (2/5/23 10:00:00.000 AM to 2/6/23 10:09:16.000 AM) Job A | B standard_perf (search ® Smart Mode
) default) v v
No Event Sampling v i

Events (27) Patterns Statistics Visualization

Format Timeline v —Zoom Out " hour per column

> Show Fields Table + # Format 20 Per Page v 2 Next >

i _time host = endpoint * account =

> 2/6/23 docker-desktop "POST /v2/management/accounts/5/tags HTTP/1.1"201 [4:admin-user-1]
9:51:49.353
AM

> 2/6/23 docker-desktop "POST /v2/management/accounts HTTP/11"201 [4:admin-user-1]
9:51:42.976
AM

> 2/6/23 docker-desktop "POST /v2/reporting/virtualization-storage-summary-report/search?limit=15&sort=-used_percentage HTTP/1.1"200 [4:admin-user-1]
9:51:35.547
AM

> 2/6/23 docker-desktop "POST /v2/reporting/virtualization-storage-summary-report/search?limit=50&sort=-used_storage HTTP/1.1"200 [4:admin-user-1]
9:51:35.547
AM

> 2/6/23 docker-desktop "POST /v3/access-groups/admin-user-1/policies HTTP/11"200 [1:-]
9:51:24.846
AM

4.10 Generating a support bundle

4.10.1 Find the “collect_bundle.sh” script

« The support bundle tar file is available on the downloads site3®.
+ Once the file is downloaded, untar the file to find the script.

dlpxuser@delphix:~/test$ tar -xzvf dct-support-bundle-1.0.1.tar.gz
X ./

x ./collect_bundle.sh

x ./README

X ./VERSION

36 https://download.delphix.com/folder/1144/Delphix%20Product%20Releases/DCT
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4.10.2 Execute the “collect_bundle.sh” script when DCT is running in Kubernetes

« Transfer the "collect_bundle.sh" script to the machine where you have permissions to execute kubectl
commands against the DCT pods.

& You mustinstall the bash shell to generate a DCT support bundle, if it is not already.

+ Execute the “collect_bundle.sh” script, which assumes a Kubernetes deployment by default. The script may
need to run with "sudo", if root permissions are needed to run the kubectl commands.
« If the namespace is not the default "dct-services", use the "-n" flag and pass the correct namespace.

dlpxuser@delphix:~/test/tools/support-scripts/$ ./collect_bundle.sh -n
<custom_namespace>

DCT support bundle collection started at Thu Jun 22 12:35:05 EDT 2023
Collecting logs from all DCT containers...

4.10.3 Execute the “collect_bundle.sh” script when DCT is running in Docker-
Compose

« Transfer the "collect_bundle.sh" script to the machine where you have permissions to execute docker
commands against the DCT Docker-Compose application.

& You mustinstall the bash shell to generate a DCT support bundle, if it is not already.

« Execute the “collect_bundle.sh” script with the "-d" parameter. The script may need to run with "sudo", if
root permissions are needed to run the docker commands.

dlpxuser@delphix:~/test/tools/support-scripts/$ ./collect_bundle.sh -d

DCT support bundle collection started at Thu Jun 22 12:35:05 EDT 2023
Collecting logs from all DCT containers...

4.10.4 Find the generated support bundle tar file

The resulting support bundle will be located at dct-support-*x**.tar.gz ,inside the currentdirectory.

dlpxuser@delphix:~/test$ 1ls -1ltr
total 316

-rw-r--r-— 1 65436 staff 104189 Feb 17 08:52 dct-support-<current_timestamp>.tar.gz

The support bundle tar file contains the following information:
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+ DCT logs for all of the containers.

« Ajava heap dump, .hprof, if one exists.

« Ajavathread dump and memory stats.

» The output of docker stats, if running in Docker-Compose.

+ The output of cpuinfo, meminfo, and mpstat for each container, if running in Kubernetes.
+ The output of kubectl get pods -0 json for each container, if running in Kubernetes.

® + The collect_bundle.sh generates a support bundle from a DCT engine running in Docker or
Kubernetes.

« The resulting support bundle willbe at . /dct-support-****.tar.gz inside the container.

+ The user must have privileges or permission to execute the docker or kubectl, commands in order
to generate the support bundle.
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5 Data governance

5.1 DCT administration

DCT delivers a management layer on top of all connected Delphix engines through surfacing object inventories,
instrumenting all common Delphix operations, delivering a business metadata layer with tagging, and using those
tags to drive attribute-based access control. This provides the ability for administrators to deliver a highly curated
and secure Delphix experience for automation and end-users.

Catalog Tagging Attribute-based Access Control
Database Action Data Tags Engineering Team Alpha
eCommerce_Customers Provision Network

warehouse_Inventory Teardown Priority Create Update

. West .
warehouse_catalog Environment Data Center Delete View

ERP_logistics SRE_Environment VDB Profile Refresh Rewind

ERP _Accounts Test_Environment Primary Owner

Analytic_Environment

Self-Service Access to Multicloud Tag Data for Protect Data with Global Attribute-Based
Data+Operations, Catalog, APls, Integrations Control & Visibility User Access Management

This section contains configurations handled under the Admin page in the DCT interface.
5.1.1 Operations page

5.1.1.1 Operations

An Operations page is available under the Admin menu to display the list of all the DCT Jobs across Delphix
infrastructures. It only shows operations that the user has access to.

This page displays the relevant details for the operation, such as status, type of job, target id (refers to the id of the
object on which the operation has been performed), start time, last updated time, etc.
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Home Data Compliance Insights  Admin jk-admin &

Accounts Operations

Operations shows you all the various operations and their status across Delphix infrastructure.

Access Groups

Roles Search

Authentication
Staws [ Start Time Last Updated Time Target 1D Type

Operations @ roandoned 2¢1f1847863443b79a7381 Jul 25, 2023 5:23 PM (Asi.. Jul 25, 2023 5:23 PM (Asi. 1-MSSQL_DB_GONTAIN. VDB Enable View >
@ Avandoned 55a01e45293a45378e720... Jul 25, 2023 5:22 PM (Asi.. Jul 25, 2023 5:23 PM (Asi. 1-MSSQL_DB_GONTAIN VDB Enable View >
@ HAoandoned 2b1080e1e52e43015748b Jul 25,2023 5:22 PM (Asi 1-UNIX_HOST_ENVIRO Environment Disable View >
@ Aoandoned St25aece183c4281a01107... Jul 25,2023 5:22 PM (Asi.. 1-UNIX_HOST_ENVIRO. Environment Disable View >
@ compieted 69210005118482006793. Jul 25, 2023 1:44 PM (Asi.. Jul 25, 2023 1:45 PM (Asi. 1-MSSQL_DB_CONTAIN VDB Enable View >
@ compisted a77230200b5403580a63 Jul 25,2023 1:41 PM (Asi Jul 25,2023 1:41 PM (Asi. 1-UNIX_HOST_ENVIRO. Environment Disable View >
@ complsted 6¢74112010474c2199¢63c... Jul 25, 2023 11:49 AM (As, Jul 25,2023 11:55 AM (As... 1-WINDOWS_HOST_EN. . Environment Enable View >
@ completed 7aal617b8a1baSace92ed. . Jul 25, 2023 11:48 AM (As... Jui 25,2023 11:49 AM (As... 1-WINDOWS_HOST_EN... Environment Disable View >
@ Completed 0209084308554b27a844e... Jul 25, 2023 11:47 AM (As... Jul 25,2023 11:48 AM {As... 1-WINDOWS_HOST_EN... Environment Disable View >
@ complsted 601927154d20451BactBle. . Jul 25, 2023 11:45 AM (As... Jul 25, 2023 11:47 AM (AS... 1-WINDOWS_HOST_EN... Environment Enable View >

) 16 age 1 o

The capture above represents an admin user view of the Operations page.

The capture below represents a non-admin user view of the same page.

Home Data Compliance Insights  Admin standard-user-1 &

Accounts Operations

‘Operations shows you all the various operations and their status across Delphix infrastructure.
Access Groups

Roles Search I Search (All)

Authentication

Status D Start Time Last Updated Time Target ID Type
Operations & completed 6c74112010d74c2199c63c. Jul 25, 2023 11:43 AM (As. Jul 25, 2023 11:55 AM (As.... 1-WINDOWS_HOST_EN... Environment Enable View >
@ Ccompleted 7aaf617bBaibd5ae892ed. Jul 25, 2023 11:48 AM (As. Jul 25, 2023 11:49 AM (As... 1-WINDOWS_HOST_EN. Environment Disable View >

Further details regarding the job, such as target id, error, or warning logs can be viewed by clicking on the View link,
which navigates to the details page.

Data governance - 87



Data Control Tower - Data Control Tower Home

Home Data Compliance Insights Admin jk-admin @
Operations » 6¢74f12010d74c2f99¢63¢55185bef3a
< Operations 6¢74f12010d74c2f99c63c55185bef3a
Details Errors Warnings
Status No error logs available. No warning logs available.
Completed
Environment Enable
Start Time
Jul 25, 2023 11:49 AM
Last Updated
Jul 25, 2023 11:55 AM
Target ID
1-WINDOWS_HOST_ENVIRONMENT-6
Engine
jK-2505
5.1.2 Tags

5.1.2.1 Tags management

DCT powers data governance with tags. These key-value pairs can be used to associate any business-level data with
any Delphix object, to drive greater intelligence in automation, administrative workflows, data access, and
reporting. Advanced search for tags is available.

Tags are individual attributes on every object exposed in DCT; from VDBs, to compliance jobs, and even users. There
are no limits on tag count per object and character limits are set for flexibility to enable robust grouping.

5.1.2.2 Administrative tagging

Tags can be managed from the Ul by selecting “View Tags” for a particular object on its global list page. The below
example shows the tag configuration screen for a dSource “AGDatabaseSQL2016” and multiple tags have been
added to characterize that particular object:
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Add Tags for "AGDatabaseSQL2016".

(App Team: Alpha Q> ¥ Remove
(Application: Finance Q) ¥ Remove
(Data Center: West Coast Q) # Remove
(Primary Owner: John Smith 0) ¥ Remove
CSecondary Owner: Jane Doe 0) ¥ Remove
Enter Tag Key Enter Tag Value + Tag

Cancel Add Tags

kDCT tags enable complex searching to enable intelligent reports. A demonstration using the above example
dSource and using expression-based search to filter dSources with the {App Team: Alpha} tag.

dSources
View Tags for "AGDatabaseSQL2016". x
An overview of data sources across your Delphix infrastructure.
App Team: Alpha
Search Application: Financo |«
[tags CONTAINS {key EQ 'App Team' AND value EQ 'AIpha'}IM Expression Search v
Data Center: West Coast
Primary Owner: John Smith
Expression Search
‘Secondary Owner: Jane Dos. v
Delphix supports expression-based searching. See below for examples of the se¢
w0
Status Name 1 Type ETgE \'_NB
UNKNOWN AGDatabaseSQL2016 MSSaql amit-engine View tags (5) > View >
UNKNOWN AppFS_cust_master Unstructured Files Test Engine View tags (1) > View »
UNKNOWN AppFS_master Unstructured Files Test Engine View tags (1) > View >

2022 Delphix. All Rights Reserved. Private and Cot
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5.1.2.3 Tags powering attribute-based Access Control

Tags also power the DCT permissions system for both Accounts (users) and Role Scopes (object entitlements). The
below example shows an Access Group (Alpha Team) with the Accounts tab on display. Notice that the accounts tab
has {App Team: Alpha} under “tag mapping”, which automatically attributes any users with the {App Team: Alpha}
tag.

Data Compliance Insights Admin

< Access Groups Alpha Team

Accounts Roles Access

-_—
Tag Mapping Edit Associated Accounts + Manually Add Accounts
e
App Team: Alpha Search Search (All) v
| S

D Username T Name Email Addition
—_—

4 John Smith John Smith johnsmith@company.com App Team: Alpha View >
| ——

The same goes for Scoped Roles under the “Roles” tab. The Alpha Team role has been mapped to the {App Team:
Alpha} tag and all dSources with that same tag are automatically attributed.

Data Compliance Insights  Admin

View Select dSources

< Access Groups Alpha Team

Accounts Roles Access

oo Teom: Alpha \ .
aoes ot . Alpha Team Role Scope P e e .
Alpha Team U Gopy # Edi
Alpha Team >
Object Tag Mappings J |
Give permissions to objects with dS ﬂ Preview |}
the following tags.

Ow= Manage Tags Ow Provision Ow Read Ow Refresh

Ow Set Tags at Object Creation Ow Snapshot

5.1.3 Access Control

Data Control Tower (DCT) fundamentally changes how application teams are governed across the Delphix Platform
to ease expansion and management burden. Previously, Delphix administrators were focused on managing
individual user-level access on each engine. This made it difficult as teams increased their data set requirements.
This inevitably led to more time managing engine access and not rolling out test data management (TDM) practices.
Now with DCT, all users are managed and access their data sets through a centralized server. This makes it easier
for administrators to manage the Delphix Platform and application teams to utilize the self-service capabilities.

To take advantage of DCT’s new capabilities, Delphix administrators will implement a centralized Attribute Based
Access Control (ABAC) model. This is performed by consolidating permission management from the engines to DCT,
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implementing Access Group policies, and assigning Object tags. The flexibility of this approach ensures your
company’s required security model can be maintained or even further refined.

The below picture attempts to show the shift in access models. In the original Engine Model, the engines were
isolated from one another. No access control mechanisms were shared between Engines. In the DCT Model, Delphix
administrators will manage applications teams directly through DCT. Those application teams will log directly into
DCT. Only administrators will log into the Engines for advanced usage.

Engine
Model

BE Active Directory
Supported —=
@SSO Local User

Engine Engine Engine

Managed & —

Enforced 4 N4 b

vV v v

5.1.3.1 Access model overview

DCT
Model

== Active Directory
Supported —
@SSO Local User

-
Managed & ;T?
Enforced b
Ad mInS - Engine Engine Ergisie
Only W W% W e

v v v

Data Control Tower implements a model that you might find in other types of software called Attribute Based
Access Control (ABAC). This model is incredibly flexible but requires detailed configuration to perfect your use
cases. In our model, there are four entity types which are defined below. Understand each entity as they are the

foundational blocks of DCT’s ABAC model.

Entity Description

Accounts
(aka Users)

Access Groups

Assingle or shared user who can
authenticate with DCT (Ul or API).

A collection of accounts that share one
or more characteristics, such as a Team

Managed By

Create manually or via Identity Provider
(1dP), such as SSO or LDAP. Accounts are
independent of Delphix Engines.

Manually created. Populated manually
or via the ‘login_groups’ tag.

or Permission set. Equivalent to an

Active Directory group.

Roles and Permissions

role.

The collection of read, write, and delete
permissions forms a reusable, named

Some roles are provided out of the box,
but Admins can build their own from the
available permissions. Individual
permissions are immutable.
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Units, such as VDBs, Bookmarks, and
Environments, that are managed across
the Delphix Platform.

Objects
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Managed By

Automatically identified by DCT from the
connected engines. Assigned to Roles via
various models. The CD and CC Engines

supply these objects.

Each entity is linked to another through manual or automated assignment. A manual (or direct) assignmentis a
good approach for early implementations. However, it can be challenging to maintain as teams grow. As an
alternative, Tagging is suggested as it performs automatic assignments based on your custom configuration. The
below diagram shows how each entity is linked together. The directions below start with Accounts creation to
Access Groups with Role assignments and finish with Object mappings.

Direct Assignment Roles

A
—

Access Groups

(Default and Custom)

Direct
Assignment

Tagging
(ex login_groups)

Direct

. Advanced
Assignment

Simple Tagging

Accounts
(Users and API Keys)

Manually
Created

580, LDAP,
AD, etc

—
/f/ ,J\ klser List
; dam
5‘ 3rd Party Service > j Betsy
N
1\_____)\___ J/._,

Understanding your team structure is imperative to identify the best access model. Usually, organizations have
existing groupings defined in their Identify Provider (IdP). These groups are typically organized in one of two ways
(a) ateam dedicated towards a central goal (such as a product development team) or (b) a group of individuals with
similar permissions (such as Security Administrators). Understanding the purpose of each group should be a guide
in how the Roles and Permissions are designed. For example, the Alpha product development team might have full
permission to manage existing VDBs and create new bookmarks for their team’s “Alpha” objects. On the other
hand, Security Admins might have sweeping read and disable access across the entire platform to ensure
compliancy. Iterating through each Access Group and designing custom, but re-useable roles, based on the
Principle of Least Privilege3’, will produce a streamlined rollout.

37 https://en.wikipedia.org/wiki/Principle_of_least_privilege
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5.1.3.2 Accounts: Manual, LDAP/AD, or SSO/SAML

Accounts: Manual, LDAP/AD, or SSO/SAML

Goal: Import or create user accounts. Complete either the Manual or LDAP/SOO configuration.

Access Groups

Tagging
(ex login_groups)

Roles

Direct
Assignment

-
-

Accounts

SS0, LDAP,
AD, etc

‘ A
¥ 3rd Party Service /
\\,___,\_//“

(Users and API Keys)

Manually
Created

User List
Adam
Betsy

Manual (User List)

(Default and Custom)

Direct

Simple Tagging Assignment

Advanced

Navigate to Admin > Accounts, click the “+ Account” button, and complete the form.

Home

Data

Insights Admin

secure-key

Accounts Accounts

IManage accounts that can access Data Control Tower,

Access Groups

Roles

Authentication

D

Search

Username

Search (All) v

Email Tags

Manual accounts are great for testing user access or providing a service account. Take note of the checkboxes by
which you want this user to access DCT.
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Create Account

Create an account and specify the authentication method.

Username

First Name Last Name

[J Add "admin" role to account access group
[0 Enable Authentication with usemame and password

[[] Generate API Key

Add Account Tags
Account tags help you group and organize DCT accounts

Enter Tag Key Enter Tag Value

Cancel

When you have specified all required values, select the “Create Account” button. By default, this user will have no
permissions.

LDAP/Active Directory or SSO/SAML (3rd Party Service)

Navigate to Admin > Authentication, click “Edit” for either LDAP/AD or SSO/SAML, and complete the form. Ensure
“Auto-create Users” is enabled. It can be disabled at any time.

If you need guidance on how to configure, follow the directions here:

« LDAP/AD Directions38
« SSO/SAML Directions3?

38 https://dct.delphix.com/docs/ldapactive-directory-3
39 https://dct.delphix.com/docs/samlsso-2
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Accounts Authentication Settings
Access Groups LDAP/AD Edit SSO/SAML Edit
Status status
Disabled Disabled
Roles
LDAP Server Entity ID
MNone None
Authentication Port First Name Attribute
MNone None
Auto-create Users Last Name Attribute
Enabled None
Enable SSL Group Attribute
Enabled None
Insecure SSL Response Skew
Disabled 120
Unsafe SSL Hostname Check Auto-create Users
Disabled false

Once configured, Accounts will be automatically created when a user successfully logs in.

This is functionally different from the old Engine model. Previously, the Account was created manually
before they could log in.

Recommended: LDAP/Active Directory Domains

Itis highly recommended that we also configure group membership during this stage. By defining the metadata
attributes in the option Domain fields, DCT can automatically assign users to Access Groups. If configured correctly,
you will see an automatically generated login_groups tagon recently logged-in accounts. If an Account does
not have the tag, then (a) the Domain configuration is invalid, or (b) they should re-login. The login_groups tag
is the only tag that cannot be specified on an Account manually.

LDAP/Active Directory Domain Groups Directions*

40 https://dct.delphix.com/docs/configure-ldap-ad-groups-2
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¢ Accouns - Test User
Overview ACCESS
Details Edit Access Groups Tags Edit
Email user@test.com Team Alpha oy
Username test login_groups: Alpha
First Name Test
Last Name User

Example Account with the login_groups tag.

Please test these new accounts out by logging in on another browser. By default, these accounts will not have any
permissions and not see anything. In the following steps, we will give them access. In addition, if configured, we’ll

take advantage of login_groups oracustom tag.

5.1.3.3 Access Groups: Creation and account assignment

Goal: Create an Access Group and assign Accounts directly or through Tags.

Direct Assignment Roles

A

Access Groups

(Default and Custom)

Direct
Assignment

Tagging
(ex login_groups)

Simple Tagging Elsr:i?nmen t Advanced

Accounts
(Users and API Keys)

SSO, LDAP, Manually
AD, etc Created

User List
Adam
Betsy

C 3rd Party Service \j
\-———-k_fdj

Access Group Creation
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Next, navigate to the Admin > Access Groups tab, select the “+ Access Group” button, and complete the presented
form. As described previously, these groups are based on existing teams or users with similar access. If you

successfully configured the Active Directory’s Domain Groups, you can specify the login_groups tagand value
here. Or specify a custom Tag, such as "Team: Alpha".

You can also select Roles if you already know which should be applied. Otherwise, ignore it.

Submit the form once you are happy with your new group.

Create Access Group

Access Group Name

Team Alpha

Select Role(s)
Select the roles for the access group which determing the permissions and objects
the group can access.

Select Roles

Select Account Tags
Select account tags that will automatically add corresponding accounts to this
Access Group.

(rom _ >
\Iogm_groups. Alpha Q,J # Remove

Enter Tag Key Enter Tag Value

Cancel Create Access Group

Unlike an Account, you can specify the " login_groups” tag on an Access Group shown in the picture
above.

On completion, you will be presented with a page similar to the one below. Unfortunately, it’s empty. Let’s add
some associated Accounts now.
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Access Group
< Access Groups Team Alpha .
01442306-1145-4a11-a920-1520fa503052
Accounts Roles AcCcess
Tag Mapping Edit Associated Accounts + Manually Add Accounts

Search Search (All)

D Usermame 1 Name Email Addition

No items.

Manual (Direct) Assignment

Select the “+ Manually Add Accounts” button, select the desired Account, and then “Add Account”. Immediately,
you’ll see it presented in the Associated Accounts list.

Add Account to Access Group

Account
[used

39: test (Test User)
43 userl (User One)
44 user2 (User Two)

46" user3 (User Three)

This is a good solution for quick management. However, it can be cumbersome as usage grows. Therefore, we
recommend tags!

Tag Assignment
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First, navigate to the Admin > Accounts tab and select an existing Account. (Feel free to create another one!) Once
selected, add a custom Tag such as ‘Team: Alpha”. If one already exists on the Account, such as “login_groups”,
remember it.

Add Tags for "test".

(Iogin _groups: Alpha Q) # Remove

Enter Tag Key Enter Tag Value

Team Alpha

Cancel Save

Next, navigate back to the Access Group, select the Tag Mapping’s “Edit” button, and specify that same Key: Value
pair. It might look similar to the below picture.
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Add Tags for "AccessGroup-0144e806-1146-
4a11-a929-f520fa503052".

(e . )
\Iogln_groups. Alpha ) ) # Remove

(o A
| Team: Alpha [x] ) ) # Remove

Enter Tag Key Enter Tag Value ‘ + Tag ‘

Cancel Add Tags

In this example, the “Team: Alpha” and “login_groups: Alpha” were added through the Access Group’s Tag Mapping
widget. If configured successfully, your Access Group might look similar to the below picture. If you remove the
Access Group or Account’s tag, you will see Account automatically removed from this listing.

@ The “login_groups” tag functions identically to a custom tag within the Access Group. Again, the only
difference is that it's automatically assigned to the Account.
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< Access Groups Team Alpha

Accounts Roles Access
Tag Mapping Edit Associated Accounts + Manually Add Accounts
login_groups: Alpha Search Search (All)
W
Team: Alpha
ID  Username ‘T Name Email Addition
2 secure-key Team: Alpha View >
39 test Test User user@test.com | login_groupsAlpha View >

This section taught us how to organize Accounts into different groups. This allows us to keep permission sets

separated. Feel free to experiment with new Access Groups, Tags, and Accounts. If you still need additional

pointers, review our Access Groups Documentation®L.

41 https://dct.delphix.com/docs/access-groups-2
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5.1.3.4 Roles: Creation and assignment

Direct Assignment Roles

Access Groups < :
P - (Default and Custom)
Tagging Direct
(ex login_groups) Assignment
. . Diract
Simple Tagaging Assignment Advanced
Accounts
(Users and API Keys)
§S0, LDAP, Manually
AD, etc Created

User List Data 1 Data 2 Data 3
Adam
Betsy

C 3rd Party Service j

—

Role Investigation and Creation

Navigate to the Admin > Roles tab. Here we see a list of DCT’s default Roles. Each role has its selection of
Permissions, such as Read VDB, Delete Bookmarks, Modify dSources, etc. Select “View” on the “devops” role to see
its permissions.

Home Data Compliance Insights Admin secure-key O

Accounts Roles

Roles contain a lisl of permissions

Access Groups

Search Search (Al v
Roles
Authentication Hame + Description Included Object Types
admin Grants unresiricted access 1o all operations All Objects View >
Granis permission 10 provision, manage and delele VDBs and  CDBs, VCDSs, VIRTUALIZATION_POLICY, VDS Greups, Environments, Dalasel Groups, Engines, Product Info, Dalabase Templales, dSources, VDBs,
devops " v
Iheir infrasiructure Sources, Bookmarks, Jbs iew >
masking Grants permission lo manage masking objects Masking Job Sets, Engines, Masking Jobs, Product Info, Jobs, MASKING_ENVIRONMENT. Conneclors T 5

Grants read access to engines, environments, sources
q CDB, VDS Inventory Report, VCO!

VIRTUALIZATION_POLICY, Environments, VDB Groups, 6Source Usage Report. Engines, dSource Consumption

menitorin; dsources, vdbs, and cdbs as well as access (o all reporting ) N N N . - N
9 APl Report, Product info, API Usage Report, Slorage Summary Repert, dSources, VDB, Sources, SMTF Conflg, Bookmarks, Jobs, Report Schedules View >
e Grants access {6 all operations on selecied el abjects CDBs, VCDBs, VDB Groups, Envirenments, Vaults, Engines, Database Templates, Accounts, dSources, Masking Job Sets, VDBs, Access Groups,
peraio e taget ook Sources, Masking Jobs, Bookmarks, Report Schedules, Connectors View »

On the left-hand side, you can see a description, the Access Groups it’s currently a part of, and any assigned Tags.
On the right-hand side, is the complete list of permissions. For example, you can see here that the “devops” role has
“Manage Tags” and “Read” permissions on the CDBs objects. These various permissions make up the Role’s
identity.

() DCT’s default roles are immutable.
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Role Creation

Now we understand what it’s composed of, let’s create one. Navigate back to the Admin > Roles tab and select the
“+ Role” button. Give the Role a custom name, sample description, and add all the permissions you want. In my
simple example, | gave it the “VDBs > Read, Refresh, and Manage Tags” permissions. If you need to grant
permission for the entire category, select the header checkbox, such as “Access Groups” or “Bookmarks”. If you
only want a portion of that Object group, then click the little arrow icon to open up the complete set of options and
select the targeted permissions.

Create Role

Name

Limited Monitoring

Description

Simple Blog Post Role

v [ Access Groups
v [ Accounts
~ B vDBs
Read
[ Provision
[ stop
[ start

[[] Disable

[ create
Refresh

Manage Tags

Once happy with your selection, click “Create”. You can modify your Permissions further on the presented page.

Role Assignment

Roles, by themselves, provide no access. You must first assign them to an Access Group and a set of Objects before
their permissions are applied to an Account. Let’s do the first part now. Navigate back to the Admin > Access
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Groups tab and “View” your previously created Access Group. Select the “Roles” subtab and then “Edit” within the
Roles widget.

< Access Groups Team Alpha

Roles Edit

Now you can assign default Roles, such as “devops”, and your newly created Role. You might recall that Role
assignment was also possible during Access Group creation. On Save, your Access Group might look like the

following.

< Access Groups Team A|Pha
Roles Edit devops Role Scope SIMPLE Actions ¢
v devops ctions }
Limited Monitoring >
Limited Manitoring Role
s ~ Scope SCOPED  Actions :

Limited Monitoring

Immediately on assignment, all users within the Access Group will now have the permissions assigned to them
through these roles. (Since you are currently an Admin user, you must log in as your test Account user.) However,
you might notice that this user has full access to every object on DCT. The following section will define the Role

scoping modes and refine the Account Object access.
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Direct Assignment

Access Groups

Direct
Assignment

Tagging
(ex login_groups)

Accounts
(Users and API Keys)

580, LDAP, Manually
AD, etc Created

— T
C -\:{ User List
3rd Party Service ) Adam
Betsy

Simple

Roles

(Default and Custom)

Direct

) Advanced
Assignment

Tagging

Every Access Group’s Role has its own set of Objects to which the permissions are applied. In the previous section,
we defined the permissions, and now we select the Objects. Objects are assigned in three different modes. They are

listed below with their method of application:

1. Simple - All Objects within DCT.
2. Scoped

a. Tags- Objects with matching Tags.
b. Direct- Objects manually assigned.

3. Advanced Scoped - Objects are assigned directly on the permission action (such as Read Bookmark, Edit
Bookmark, or Delete Bookmark) using Tags or Direct Assignment.
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Edit devops Role Scope X

Scope Mode
® Scope Mode
Select the mode that will determine what objects are affected by the role permissions
Add Tag Mappings
devops

Add Cbjects
O Simple
The permissions apply to every object applicable to the permissions found in the Role
@ Scoped

The permissions is set to objects that either match the mapped tags or have been manually
added.

(O Advanced scoped

The permission scope is set for each permission and gives the maximum level of granularity.

We will work through the first two in this post, Simple and Scoped. Advanced is easier to comprehend afterward
and a solid self-lead challenge. Before diving into this section, we recommend that your DCT server has a handful of
objects, such as Bookmarks or VDBs.

Simple

If you have been following the post steadily, you should have two Roles assigned to your Access Group. In my
example | have “devops” and “Limited Monitoring”. Both are given the “Simple” mode by default. We can see the
breadth at which this Role governs by selecting anywhere on its row and then the “Preview” button on the right-
hand side.

View Select Bookmarks

[ Search

< Access Groups Team Alpha

Name 4 Addition Method
Bookmark Test 123 All Bookmarks
Roles Edit
devops Role Scope
~ : CRIT-BUG-2 All Bookmarks
dEVOPS SIMPLE Actions ¥
Limited Monitering >
CRIT-BUG-4 All Bookmarks
deveps > Bookmarks Preview
CRIT-BUG-5 All Bookmarks

In this example, we select the “Preview” list for Bookmarks. It displays every Bookmark this role has access to and
the method to which they are applied. If we wanted to validate, we could log in as a user on this Access Group and
verify the permissions are applied. However, this is an easier way for Administrators to confirm without switching
logins. Because this is a “Simple” scope, every object is available, so this view is not particularly intriguing. In the
next part, we’ll refine our Role.
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@ Ifyou do not see any objects listed in the “Preview” widget, that object might not be available to DCT. This
could be because (a) engines are not connected, (b) the DCT-only object (such as Bookmarks or VDB
Groups) is not created, or (c) permissions are being enforced correctly.

Scoped - Direct

Let’s change the mode to “Scoped” and target a subset of VDBs. On the Access Group > Roles tab, select the Action
> Edit button of your chosen Role.

devops Role Scope

My . :
dEVDps SIMPLE Actions 3
Copy
Bookmarks
/ Edit

A new wizard will appear with the Simple, Scoped, and Advanced Scoped options. Change the Role’s mode from
“Simple” to “Scoped”. Skip the “Add Tag Mappings” for now and select “Next” to move to “Add Objects”. You will be
presented with a long list of the objects available to DCT. This is where you can manually assign specific DCT
objects.

Edit devops Role Scope X

Add Objects
Scope Mode

Manually select objects to include in addition to the objects being added dynamically from tag mappings

Add Tag Mappings (O No Manually Added VDBs
Bookmarks

®  Add Objects (® Manually add VDBs
CDBs

B Name

Database Templat
atabase Templates Mysgl_MASK

Dataset Groups MySQL_DEV
Mysgl_QA

dSources

[ Postgres MASK

Engines

[] Postgres_DEV
Environments

[] Posigres QA
Sources

] AppFS_MASK
VCDB!

s [0 AppFS_DEV

VDBs ] AppFsS_QA
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Scroll down the Object type list and select VDBs. Next, choose the “Manually add VDBs” radio button and, on the
right-hand list, select a couple of VDBs. Feel free to add other available Objects too. When happy with your
selection, press the “Submit” button. This set of actions should change the Role’s “Simple” mode to “Scoped”
mode. Let’s verify by, again, opening the Role’s row, scrolling to your chosen Object Type, and selecting the VDBs’
“Preview” button.

View Select VDBs

Search
[

Name 1 Addition Method

MySQL_DEV Manual

Mysgl_MASK

Mysgl_QA

ltems perpage: 50 ¥

In my example, the same three VDBs | selected during permission configuration are shown here. If you want to
verify manually, log in as your other test user and confirm.

(@ Any other Roles or Access Groups assigned to this user might affect its visibility. So if you do this test,
ensure it's not accidentally pulling in another permission set.

Scoped - Tags

Direct Assignment is a solid strategy for early onboarding and one-off requirements. However, as we expand our
consumption of Delphix, | suggest leveraging the Tagging mechanism to assign permissions quickly. Similar to the
Account & Access Group’s “login_groups” tag, we can assign tags to Objects and Roles to immediately grant or
restrict access. This is the recommended approach for a robust production implementation.

Before jumping back into a Role, navigate to the top-level Data >VDBs tab. (If you don’t have any VDBs, select
another tab with available objects.) Here identify a test object and select the “Add Tags” button.
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Add Tags for "AppFS_cust_QA".

Team: Alpha 3 ¥ Remove

Enter Tag Key Enter Tag Value

Environment Dev

Cancel Save

In this form, we assign a simple Key-Value pair. This pair helps govern access and maintain the organization of the
Delphix Platform. I've selected the “Team: Alpha” and “Environment-Dev” pairs in my example. Repeat the process
for a couple of other objects using similar or different Key-Value pairs. As | explained earlier in this post, we can
define and create an organizational structure in many ways. If you prefer other pairings, please experiment, such as
with Geography, Age, DB Type, or Importance.

Next, let’s take advantage of the created tags in the Access Model. Navigate back to your test Access Group, select
the Roles tab, and edit the Role we modified previously. Because “Scoped” is already chosen, press the “Next”
button, but this time stop on the “Add Tag Mappings” view. Similar to your Object’s tag assignment, specify one or
two of the same Key-Value pairs here.
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Edit devops Role Scope X

Scope Mode Add Tag Mappings

Select tags that will dynamically add objects that are assigned the mapped tag. In Advanced
Mode, you can select tags for each permission included in the role.
® Add Tag Mappings

| Team: Alpha €3 | # Remove
Add Objects

Enter Tag Key Enter Tag Value + Tag

In my example, this process will assign the Objects with the chosen “Team: Alpha” tag to this “devops” Role. Thus,
granting the set of permissions defined by “devops”. Finally, we can verify again by completing the form and
previewing the Role.
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View Select VDBs

Search

Name 1 Addition Method

AppFS_cust_DEV Team: Alpha

AppFS_cust_MASK Team: Alpha

AppFS_cust_QA Team: Alpha

MySQL_DEV

Mysgl_MASK Manual

Mysgl_QA Manual

CracleDEV_CHT Team: Alpha

ltems perpage: 50 ¥

In my example, we can see a mix of objects assigned to this role through Tags and Manual (direct) assignments.

At this point, challenge yourself by adding and removing tags to different Roles and Objects to understand the
flexibility of the ABAC model. If you need a deeper dive into Tags, read our documentation here.*?

5.1.4 VDB templates

For additional detail on VDB templates, visit the “Configuration Settings for Oracle VDBs” article in the
Continuous Data Engine documentation.

DCT has implemented a global VDB template system to centrally manage and apply VDB templates for any and all
VDB provisioning workloads. This feature works as an extension of the local VDB template system on Continuous
Data Engines as a means of enforcing VDB configuration standards and policies uniformly.

DCT Admins have the choice of either importing pre-existing VDB templates from a local engine or creating net-new
templates from within DCT.

42 https://dct.delphix.com/docs/dct-tags

Data governance - 111


https://dct.delphix.com/docs/dct-tags
https://dct.delphix.com/docs/dct-tags

Data Control Tower - Data Control Tower Home

5.1.4.1 Creatingtemplates

Users can create Database Templates directly via DCT, which can then be used on VDBs across their engines. The
DCT APl interface for creating templates is equivalent to that of on-engines, requiring a name and sourceType, and
optionally taking in a description and the list of config parameters. Here’s a sample CURL command:

curl =X 'POST' \
'<https://<APPLIANCE_ADDRESS>/v2/database-templates'> \
-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H 'Content-Type: application/json' \

_d l{

"name": "vdb-config-template-1",

"source_type": "OracleVirtualSource"

"parameters": {"configl": "valuel", "config2": "value2"}'}

This will result in a new DCT DatabaseTemplate object, which can then be viewed using the List/Get/Search APIs.

5.1.4.2 Importing templates

Unlike many other Delphix objects, DCT is not automatically pulling in all the Database Templates from registered
engines and creating DCT objects out of them. It is often the case that users have already made arrangements and
have copies of their templates across their engines. DCT does not blindly import the templates to avoid generating
duplicates, leading users to consolidating and clean up. Instead, DCT provides an import API that can be used to
selectively choose which engines they wish to import their templates from, along with an API to undo imports. The
import workflow has a couple of things to be aware of:

« The user cannot be selective of which individual templates to import from an engine. The import APl will pull
ALL templates from that engine.

« Import is allowed only one time per Engine. After an initial import, subsequent imports will be blocked, and
itis assumed that a user will use the DCT APIs to create more templates.

+ Inthe event that an import was done on accident or no longer desired, the undo import APl can be called to
delete all the imported templates from the selected engine. This will result in the removal of all DCT
Database Templates that were created as a result of the import.

« Ifanimported template is later used on a VDB running on a different engine than where it was originally
imported from, then the undo import flow is also prohibited, as DCT can no longer safely delete a template
that is in use elsewhere.

Import templates from the engine:

curl -X '"POST' \
'"https://<APPLIANCE_ADDRESS>/v2/database-templates/import"' \
-H 'accept: */*' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
_d l{
"engine_id": "3"

} 1

Undo the imported templates from engine:

Data governance - 112



Data Control Tower - Data Control Tower Home

curl -X 'POST' \
'https://<APPLIANCE_ADDRESS>/v2/database-templates/undo-import' \
-H 'accept: *x/x' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
_d l{
"engine_id": "3"

} 1

5.1.4.3 Using templates

DCT Database Templates can be used by specifying the template_id property at VDB provisioning time, or by
updating the template_id on an existing VDB. In either case, DCT will deploy the template to the respective engine
and bind the template with the VDB. When a DCT Database Template currently in use is updated or deleted, those
changes are propagated to the respective VDBs and engines.

If a VDB has the same parameter called out in both VDB template and individual setting, the value
specified in the template will take precedence. The individual parameter value will only be used if the
VDB template is removed.

Updating a VDB to use template_id:

curl =X '"PATCH' \
"https://<APPLIANCE_ADDRESS>/v2/vdbs/1-ORACLE_DB_CONTAINER-1' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d '{
"template_id": "319db966-961c-4977-a444-14d337aa3276"

}l

a Updates to a VDB template will propagate to all associated VDBs.

5.1.5 APl metering

5.1.5.1 APl metering instructions

DCT employs a per APl consumption model, which requires APl metering and periodic reporting to Delphix
Customer Success. To support reporting of APl consumption, DCT offers an APl consumption reporting endpoint
called, “api-usage-report”. This report will provide a list of all unique API endpoints and how often they were used
over the specified time period sorted by APl and method.

Required inputs

« File type: CSV or JSON (CSV file types are compatible with most spreadsheet-style software like Excel or
Google Sheets)
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« Start/end date: The default start date is “when DCT was installed” and the default end date is the “time
when the report was generated”.

Example cURL call

curl --location --request GET 'https://[Inser_DCT_Server]/v2/reporting/api-usage-
report/?end_date=2022-06-14T09:00-04:00&start_date=2022-06-01T00:00Z"' \

--header 'Content-Type: application/json' \

-—header 'Accept: text/csv' \

-—header 'Authorization: apk 1.xxxxxxxx'

Example output

api_endpoint,api_method,api_count
"/v2/management/api-clients",GET,2
/v2/management/engines,GET,1
"/v2/management/engines/search",POST,1
"/v2/reporting/api-usage-report",GET,2

5.1.6 Client telemetry
DCT provides complete flexibility to clients on how to attribute their API calls. DCT captures the value provided in an
optional HTTP header ( X-Dct-Client-Name ) and standard, mandatory HTTP header ( User-Agent ) for the

purpose of attributing an API call. These values are stored as client_name and user_agent inthe backend,
and can be queried in the report. Below are some examples of how this can be used.

Example one

Clients can view the report grouped on the basis of client name and API classification by providinga group_by
query parameter.

curl —-location 'https://[Inser_DCT_Server]/v3/reporting/api-usage-report?
group_by=client_name%2Ckind' \

--header 'Authorization: <api_key>' \

-—header 'Accept: text/csv'

api_endpoint,api_method,api_count,kind,client_name,user_agent,dct_version
,y2,management,client-1,,

,»5,management,client-2,,

,,20,management,client-3,,

The group_by parameter supports any combination of properties from api_endpoint, api_method,
kind, client_name, user_agent,and dct_version .All properties function as their name describes,

where kind corresponds to API classification.

Example two
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Clients filter the records for a list of particular client names, DCT versions, user agents, or classifications, by
providing corresponding query parameters.

1. Filter the API calls by client names.

curl --location 'https://[Inser_DCT_Server]/v3/reporting/api-usage-report?
group_by=client_name%2Ckind&client_name=clientl%2Cclient2"' \

-—header 'Authorization: <api_key>' \

--header 'Authorization: apk <api key>

2. Filter the API calls by API classification.

curl --location 'https://[Inser_DCT_Server]/v3/reporting/api-usage-report?
group_by=client_name%2Ckind&api_metric_kind=automation' \

--header 'Authorization: <api_key>' \

--header 'Authorization: apk <api key>'

a The API query parameters for this report are dynamic; depending on the number of records in the
backend and the granularity of the response requested, API response can be too large to be handled by
DCT. DCT can run out of memory and eventually crash if that is the case. To prevent this from happening,
this report has the maximum limit set to 10,000 records in the APl response. Thus, it is strongly
recommended to always ‘limit’ the scope of the usage response by filtering records on the basis of

start_date and end_date query parameters, or on the basis of client names and/or user agents.

5.2 Central governance workflows

Data Control Tower delivers the management layer for all connected Delphix engines by virtue of its converged
architecture. As such, DCT has the ability to simplify everyday administration of common engine admin tasks. This
section will go over various how DCT exposes object relationships and reports on meaningful use patterns under
insights.

5.2.1 Managing engines (Continuous Data)

5.2.1.1 Infrastructure

DCT provides a near real-time list of all connected Continuous Data engines and lists them in an aggregate view.
From the below screen, Delphix administrators can easily view and manage their engine connections.

Data governance - 115



Data Control Tower - Data Control Tower Home

Data Compliance Insights

dsources Infrastructure m

View all your connected Delphix engines.

voBs
Search Search (Al) v
Bookmarks
Environments status Nameruu 4 e Host Tags
Tost Engine Viaization
« onine el oSO vral WwoAyelphKmY7 v ol 5 Add Tags > View>
+ Oniine smarssh-enginel 083300, Unset ‘amaresh-engine.dcol1.delphix.com AddTags > View>
Sbic4asd-A9D1-a455-7873-79833008418a 10000
VDB Gonfig Templates
+ onine ravicangine Vruaizaion onavicangrne dpcdcco A Tage > view>

Administrators can manage engine connects via the “Connect Engine” button on the top right corner. By clicking
this button, the below dialogue will appear, asking for connection details.

DCT will access the engine as a registered user and, as detailed in the Deployment section, requires both
a username and password as well as admin-level access to the engine.

Connect Engine X

® Engine Details Engine Details

Name

Test Engine
Authentication
Hostname
Security uvolxyellphlkiwmhy?7.vm.cld.sr
Tags Choose Engine Type
@ Virtualization
Summary

(O Masking

5.2.1.2 Engine overview

Individual engine details can be seen and acted upon by clicking down on a particular engine detailed view. Once
clicked, users will be sent to an "Overview" tab that provides relevant metadata related to the engine.

Compliance Insights  Admin

< mfasructre €St ENgine

Overview Environments dsources VvDBs Access
Used Storage 5.30G8
7% . o
Used Remaining Storage 70.27GB.
Details Tags Edit
Type Data Engine
Version 9.000

Engine-connected environments

The "Environments" tab presents all environment connections to that particular engine.
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Data Compliance Insights  Admin

< mrasrucre €S ENgine

Overview Environments dsources VDBs Access
Search Search (Al) v
Name Hosts IP (Port) DBMS (Version) Config Engine ID Tags
10.160.1.21 Unstructured Files
Oracle_Source 10.160.1.21 mysql-plugin Standalone 3 AddTags >
10.160.1.21 Oracle (19.3.0.0.0)
10.160.1.61 Unstructured Files.
Oracle_Target 10.160.1.61 mysql-plugin Standalone 3 AddTags >
10.160.1.61 Oracle (19.3.0.0.0)
10.160.1.20 Unstructured Files.
Postgres_Source 10,1601 20 postgres-vadk Standalone 3 AddTags >
10.160.1.60 Unstructured Files
Postgres_Target 10,1601 60 postres-vadk Standalone 3 AddTags >
Salserver_Source 10.160.1.22 MSSql (14.0.2027.2) Standalone 3 AddTags >
10.160.1.62 Unstructured Files.
Salserver Target 10,1601 62 MSSal (14,0207 2) Standalone 3 AddTags >

Local dSources

The "dSources" tab presents all dSources associated with the selected engine. Clicking the "View" button will link
the user directly to the associated dSource page.

Data Compliance Insights  Admin

< mrastucwre €St ENgine

Overview Environments dSources VDBs Access
Search Search (AI) v
Status Name Type Tags
UNKNOWN ApPFS_cust_master Unstructured Files Add Tags > View >
UNKNOWN AppFS_master Unstructured Files Add Tags > View >
UNKNOWN Mysal_master mysql-plugin Add Tags > View >
UNKNOWN Oracle_master Oracle Add Tags > View >
UNKNOWN Postgres_cust_master postgres-vsdk Add Tags > View >

Local VDBs

The "VDBs" tab presents all VDBs associated with the selected engine. Clicking the "View" button will link the user

directly to the associated VDB page to take action.

Data Compliance Insights  Admin

< niastucwre 1€t Engiine

Overview Environments dSources VDBs Access
Search Search (AI) v
Status Name Type Tags
RUNNING ApPFS_DEV Unstructured Files Add Tags > View >
UNKNOWN APPFS_MASK Unstructured Files Add Tags > View >
UNKNOWN AppFS_OA Unstructured Files Add Tags > View >
UNKNOWN APPFS_cust DEV Unstructured Files Add Tags > View >
UNKNOWN APPFS_cust MASK Unstructured Files Add Tags > View >
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Engine-based Operations access

Users are able to audit which users have access to this particular engine, what access group they belong to, and the
associated permissions that each user has on this engine. Admins are able to click on the "View" button to access
further details under the access control screen related to that specific user.

Data Compliance Insights  Admin

< wrasmcws  Test Engine Engines

Ow Greale  Ow CreateEnvionment  Ow Deiete  Ow Manage Tags

Overview Envi dsources VDBs Access
O Read O SetTags at Object Greation O Update
s Access Group P
1> o- CREATE_ENVIRONMENT o= DELETE View >
John Smith
John Smith > o= CREATE_ENVIRONMENT o= DELETE View >

5.2.1.3 Infrastructure connection wizard

In the DCT interface, select the Home tab on the top navigation bar to see the Infrastructure Connections landing
view, which hosts the list of connections. In DCT versions before 9.0.0, these connections were listed under the
Environments section of the Data tab. Infrastructure Connections are the DCT equivalent of an environment. The +
Infrastructure Connections button will launch the wizard.

Data Compliance Insights  Admin

Infrastructure Connections Infrastructure Connections

An overview of your connected infrastructure.

Search Search (Al) v
Name Hosts IP (Port) DBMS (Version) Gonfig Engine ID Tags
y unix-stand.dcol1.delphix.com Unstructured Files
apna-connection unix-stand.dcol1.delphix.com Oracle (11.2.0.2.0) Standalone 1 AddTags > View >
i orc-tgt.deol1.delphix.com Unstructured Files
ore-tgt.dcol!.delphix.com ero-tut ool dalphix.com Oracle (19.14.0.00) Standalone 1 Add Tags > View >
win-src-1.deolt delphix.com MSSal (14.0.1000.169)
win-src-1.dcol1.delphix.com e M e MSScd (15.0.2000.5) Standalone 1 Add Tags > View >
win-tgt-1.dcel1.delphix.com MSSql (14.0.1000.169)
win-1gt-1.dcol1.delphix.com win-tgt-1.dcol1.delphix.com MSSal (15.0.2000.5) Standalone 1 AddTags > View >
win-tgt-1.dcol1.delphix.com Unstructured Files

The following connections are available:

« UNIX environment

« Standalone/Cluster
« Windows environment

+ Source/Target

« Standalone/Cluster

Infrastructure connection wizard steps

1. Connection Name
Enter the Connection Name in the corresponding field and select the Associated Engine from the
dropdown.
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Connection Name

® Host & Server

Settings

Summary

Host & Server

A Infrastructure Connection is a host or cluster with which Delphix will communicate.

Host OS
® Unix/Linux

(O Windows

Server Type
(® Standalone

O Cluster

Create Infrastructure Connection X
® Connection Name Connection Name
Give a name to your ion and select the engine that will be for this
Host & Server
Connection Name
Settings et heste g Please fill in this field.
5j-2903.dcol1 v
Summary
Cancel Next
Host & Server
Select the Host OS, Server Type, and Host Type (applicable to Windows).
Create Infrastructure Connection X

Cancel

-

1 Unix
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Create Infrastructure Connection X

) Host & Server
Connection Name

A Infrastructure Connection is a host or cluster with which Delphix will communicate.

® Host & Server
Host OS

. O Unix/Linux
Settings

@® Windows
Summary
Host Type

@® Source

QO Target

Server Type
(O standalone

@® Cluster

Cancel Back m

2 Windows

For Windows/Target/Standalone settings, a Delphix Connector download link has been added. Unlike the
engine, this link makes an API call to authenticate and download the connector exe file.

Settings

This step includes various connection setting options from basic items like the Host/IP Address and SSH
Port to advanced items like Discover SAP ASE, Provide my own JDK, and Set NFS. It includes a Validate
button to help confirm the environment user and prevents access to the next step if the credentials are not
valid.

Create Infrastructure Connection X

A Connection is a host or cluster with which Delphix will communicate.

Toolkit Path
Host & Server
® Settings Java Development Kit
O Provide my own JDK
Delphix will automatically provide a default JOK unless you elect to provide your own by checking ‘Provide my own JDK'
Summary v P v provide Y 9 y

Advanced Options

Discover SAP ASE
Login Settings

@ Username and Password
(O Password Vault

O Kerberos

ASE DB Username

ASE DB Password

[ set Network File System Addresses(NFS)

Setting NFS addresses is not normally needed. If the host has multile IP addresses, these can be added for NFS traffic by selecting this option to add additional host addresses.
[ set Delphix Session Protocol Options(DSP)

This option does not need to be selected unless you wish to configure Server/Client authentication for Delphix Session Protocol communication

Description

Cancel Back m
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A wide range of Login Settings are available for the OS user and to Discover SAP ASE (if applicable), like
username/password, username/public key, Password Vault, or Kerberos.
a. Forvaults, HashiCorp and CyberArk vaults are supported.
b. The Kerberos login option only shows up when the user selects a Kerberos enabled engine as the
target for environment creation.

Create Infrastructure Connection X

Settings
Connection Name 9

A Connection is a host or cluster with which Delphix will communicate.

Host & Server
Host/IP Address

® Settings
SSH Port

22
Summary

Login Settings

(® Username and Password
(O Username and Public Key
(O Password Vault

O Kerberos

OS Username

OS Password

Toolkit Path

Java Development Kit

Cancel Back m

Java Development Kit (only applicable if selected in Settings)
Set the custom JDK path in the corresponding text field.

Create Infrastructure Connection X

Connection Name Java Development Kit
The current Java Development Kit that is installed:
Default JDK

Host & Server

[Javs Development Kit (JDK) Path

path/to/jdK

Settings

Provide the full @absolute) path to the root of the JDK

® Java Development Kit

NFS Addresses

DSP Options

Summary

Cancel Back m

NFS (only applicable if selected in Settings)
Set NFS addresses in the corresponding text field (comma separated).
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Create Infrastructure Connection X

NFS Addresses

Connection Name
Set Network File System (NFS) Addresses

NFS Addresses
Host & Server

host1, host2.com, 1.12.21.32

Settings

Java Development Kit

® NFS Addresses

DSP Options

Summary

Cancel Back m

DSP (only applicable if selected in Settings)
Set DSP configurations in this step.

Create Infrastructure Connection X

DSP Options

Connection Name

These fields have no effect unless client and server authorization for remote connections is enabled. These can be enabled in the Network Security section of the associated engine's Setup application
dashboard.
Host & Server

DSP KeyStore Path

Settings DSP config!

JavaDevelopmentkit
NFS Addresses DSP KeyStore Alias

DSP config2

®  DSP Options
DSP TrustStore Path

DSP config3
Summary

Dsp

Summary.
Shows a comprehensive summary of the selected options in the previous configuration steps. Shows the

type of login being used for both the OS user and SAP ASE (if applicable).
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Create Infrastructure Connection

Connection Name Summary

Host & Server Host
Host 0S
Unix/Linux
Settings
Server Type
Standalone

Java Development Kit Connection Name

My IC

NFS Addresses Associated Engine
8j-2903.dcol1

Hosv/IP Address

DSP Options unix-stand.dcol1.delphix.com

NFS Addresses
® Summary host1, host2.com, 1.12.21.32

SSH Port
22

Toolkit Path
/work
path/to/jdk

DSP KeyStore Path
DSP config1

DSP KeyStore Alias
DSP config2

DSP TrustStore Path
DSP config3

Discover SAP ASE

Review the configuration for this Infrastructure Connection

Java Development Kit (JDK) Path

User

Login Type
Password authentication used

0S Username
sybase

Cancel  Back =

5.2.2 Managing dSources

5.2.2.1 Managing dSources

DCT provides the ability to view, search, sort, and filter all dSources within a connected Delphix ecosystem. This
page can be found under the Data section and is used to find and act upon all dSources, if they have the

appropriate access.
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Data Compliance Insights Admin

dSourees

dat your Delphix nfrastructt
VDBs
Search Search (Al) v

Bookmarks
Environments Status Name Type Engine Tags

UNKNOWN ADPFS_cust_master Unstructured Files. Test Engine AddTags > View >
Infrastructure

UNKNOWN AppFS_master Unstructured Files. Test Engine AddTags > View >
VDB Config Templates

UNKNOWN CDOMLOSR421FPDB1 Oracle. bhavik-engine AddTags > View >

UNKNOWN CDOMLOTGS813PDB1 Oracle bhavik-engine AddTags > View >

RUNNING dcol1. delph Oracle amaresh-engine’ AddTags > View >

UNKNOWN DBOMSRBA1718 Oracle. bhavik-engine AddTags > View >

UNKNOWN Mysal_master mysql-plugin Test Engine AddTags > View >

UNKNOWN Oracle_master Oracle. Test Engine AddTags > View >

UNKNOWN Postgres_cust_master postgres-vsdk Test Engine AddTags > View >

UNKNOWN Postgres_master postgres-vsdk Test Engine AddTags > View >

UNKNOWN Suitecrm_master Mssql Test Engine AddTags > View >

UNKNOWN flaskapp Mssql Test Engine AddTags > View >

5.2.2.2 dSource overview

Individual dSource details can be viewed and acted upon by clicking down on a particular dSource's detailed view.
Once clicked, users will be sent to an "overview" tab that provides relevant metadata related to the dSource.

Data Compliance Insights  Admin

¢ asouces  APPFS_cust_master

Overview Timefiow Access

Platform Status

Unstructured Files

Details Tags Edit Environment Details

Platform Unstructured Files Environment Name Postgres_Source
Version Type Single Instance
Enabled False os

size 5.20MB

Engine Test Engine

5.2.2.3 Timeflow visibility

Users are able to view snapshot information by tabbing over to the "timeflow" section, which lists all available
snapshots via a vertical timeline. Users are able to modify snapshot retention periods by clicking on the ellipsis
located to the right of the relevant snapshot.

Data Compliance Insights  Admin

< asouces  APPFS_cust_master

Overview Timeflow Access

N 2 months ago a
Jan 20, 2023

Snapshot
3:08 AM
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5.2.2.4 Access auditing

Users are able to audit what other users have access to a particular dSource, what access group they belong to, and
the associated permissions that each user has on that particular dSource.

(X) Data Compliance Insights  Admin e

¢ dgsouwces  APPFS_cust_master

Overview Timefiow Access
User Access Groups Permissions
1> o MANAGE TAGS o~ PROVISION o READ View >
John Smith
S, John Smith > o- MANAGE TAGS o~ PROVISION o READ View >

5.2.3 Managing VDBs

DCT provides the ability to view, search, sort, and filter all VDBs within a connected Delphix ecosystem. This page
can be found under the Data section and is used to find and act upon all VDB if they have the appropriate access.

Data Compliance Insights  Admin

dSources VDBs
An overview of VDB actoss your Delphix infrastructure.
VDBs
Search Search (Al) v
Bookmarks
Environments Status Name Type Engine Tags
RUNNING ApPFS_DEV Unstructured Files Test Engine Add Tags > View >
Infrastructure
UNKNOWN APPFS_MASK Unstructured Files Test Engine Add Tags > View >
VDB Config Templates
UNKNOWN AppFS_QA Unstructured Files Test Engine Add Tags > View >
UNKNOWN ApPFS_cust DEV Unstructured Files Test Engine Add Tags > View >
UNKNOWN APFS_cust MASK Unstructured Files Test Engine Add Tags > View >
UNKNOWN ApPFS_cust QA Unstructured Files Test Engine Add Tags > View >
UNKNOWN CDOMLOSR421FPDB1_93T Oracle bhavik-engine Add Tags > View >
RUNNING CDOMSHSR-GCGXEX-1679919625365 Oracle amaresh-engine1 Add Tags > View >

5.2.3.1 VDB overview

Individual VDB details can be seen and acted upon by clicking down on a particular VDB detailed view. Once clicked,
users will be sent to an "overview" tab that provides relevant metadata related to the VDB.
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Data Compliance Insights  Admin

< wss AppFS_DEV

Overview Active Timeflow Timeflow History Bookmarks Access

Platform Status

Unstructured Files

Details Tags Edit Environment Details

Type VDB Environment Name Postgres_Target
Platform Unstructured Files Type Single Instance
Version os Linux

Size 30.23MB

Engine Test Engine

5.2.3.2 VDB active timeline

Actionable snapshots are listed on the "active timeflow" tab - from this page, users can refresh, enable, disable,
start, stop, delete, and create bookmarks on the VDB. Navigate to the Continuous Data workflows section, then VDB
operations in the Ul, and see Active timeline Ul for more details.

Data Compliance Insights  Admin

< wss AppFS_DEV

Refresn
Overview Active Timeflow Timeflow History Bookmarks Access

Enable

Today Disable

Mar 27, 2023

Start
Snapshot
11:22 AM Stop

Delete

Create Bookmark

5.2.3.3 VDB timeline history

A chronological history of all non-active timelines (commonly referred to as timeflows) is shown under the
"Timeflow History" tab. From this page, developers can curate their QA or Development work by renaming
timeflows to match their testing history. Developers also have the ability to access old timeflow data by making a
particular timeflow "active". Navigate to the Continuous Data workflows section, then VDB operations in the Ul,
and see Timeline history UI*3 for more details.

43 https://portal.document360.io/docs/timeline-history
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Data Compliance Insights  Admin

< wes AppFS_DEV

Overview Active Timeflow Timeflow History Bookmarks Access

Based on source data from:
Jan 20, 2023 3:05 AM

Test 1.0.1
' Jgan 20, 2023 3:06 AM

Active

Based on source data from:
May 4, 2022 4:30 PM

Test 1.0.2
May 4, 2022 4:32 PM

4 Make Active
N 5 months ago

Nov 10, 2022 £ Rename
Snapshot Dok
@ 3a7am
ayear ago o
¥ May4,2022

5.2.3.4 VDB bookmarks

Alist of all bookmarks generated on the selected VDB can be found under the "Bookmarks" tab. This page provides
a list of all bookmarks allowing for general organization and actions (developers can use bookmarks as a refresh or
provision point from the API).

Data Compliance Insights  Admin

< wss AppFS_DEV

Overview Active Timeflow Timeflow History Bookmarks Access
Bookmark Creation Date Tags Actions

Finance-App-1.0.3.2 Mar 27, 2023 11:21 AM View Tags (1) >

5.2.3.5 VDB access

Users are able to audit which users have access to this particular VDB, what access group they belong to, and the
associated permissions that each user has on that VDB. Admins are able to click on the "View" button to access
further details under the access control screen related to that specific user.

Compliance  Insights  Admin

¢ wus  AppFS_DEV

Overview At Timefiow Timeticrer History Bankmaris Aezens

1% - CREATE BOOKMARS o GREATE VDEGROUP iew >

Jatin Smith > o= CREATE_BOOKMARK o CHEATE_VDBGROUP iow >

5.2.3.6 VDB templates

Importing and removing imported VDB templates from connected engines is an available action from the VDB
Config Templates page.
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Home Data Compliance Insights Admin

dSources VDB Conflg Templates e
An overview of VDB Config Templates across your Delphix infrastructure.
Create Template
VDBs
Import Templates
Search
Bookmarks
Remove Imported Templates
Infrastructure Name 1 Template Type Notes
Sample Template Oracle Virtual Source View >
VDB Config Templates
dj0404 template 2- Oracle Virtual Source View >
dj0404 template- Oracle Virtual Source View >
Items per page: 50 ¥ 1-30f3 < >
Import templates

« Toimport a template, select the engines from the list in the import dialog.

Import VDB Config Templates

Source Engine

di0404-1, dj1104-stage

- - |

Remove imported templates

+ To remove a template, select the engines from the list in the remove dialog.
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Remove Imported VDB Config Templates

Source Engine:

dj0404-1, dj1104-stage

Cancel

5.2.4 Managing environments (Continuous Data)

5.2.4.1 Global environments list

DCT provides the ability to view, search, sort, and filter all Continuous Data environments within a connected
Delphix ecosystem. This page can be found under the Data section and is used to find and act upon all environment
connections.

Data Compliance Insights  Admin (2]

dSources Environments

An overview of environments across your Delphix infrastructure.

vDBs
Bookmarks Seareh Search (Al) v
Environments
Name 4 Hosts IP (Port) DBMS (Version) Contig Engine ID Tags
bhavik-src.dipxde.co Unstructured Files
Infrastructure bhavik-src bhavik-src.dipxdc.co Oracle (19.3.0.0.0) Standaions 2 LEEER View >
. bhavik-tgt. dipxdc.co Unstructured Files
bhavik-igt bhavik-tgt.dipxdc.co Oracle (19.3.0.0.0) Standaions 2 LEEER View >
VDB Config Templates
o O 796 thel-79--0agg-qar-74961-27a4593a.dcol1.delphix.com Oracle (12.1.0.2.0)
thel-79--0agg-qar-74961-27 a4593a.dcol1.delphix.com hel-72Gocp. . 74981 274503 ool delphit.cam e turad oy Standalone 1 AddTags > View >
thel-79--e3ub-qar-74961-27a4593a.dcol1.delphix.com Unstructured Files
hel-79--e3ub-qar-74961-27 24593a.dcol1.delphix.com el 7o eauo-car 74561 27ad56%8 deoll detphicom oracle 121000 Standaone 1 AddTags > View >
temsperpage: 50w 1-dof4 < >

5.2.4.2 Manage environments

Selecting a standalone environment in the Data page shows an ellipsis in the top right corner. When the button is
selected, the option to Enable/Disable, Refresh, or Delete the environment appears.
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Data Compliance Insights  Admin

< envionments  bhavik-src

Environment Users Listeners Delete

* oracle Actions -

Host Details Edit Host Tags Edit

5.2.4.3 Edit host details

Selecting a standalone environment in the Data page shows an Edit Host option; it is not yet available for cluster
environments. When the button is selected, the host details window will open, showing the input fields that can be
edited. Select 'Save' to confirm the changes and close the window.

Data Compliance Insights  Admin

< Environments win

Overview Access
Edit Host
Environment Users [ delphix.coni
os
Windows
* \delphix
Version
Windows Server 2019 Standard
Java Development Kit
None
Host Details Edit Host Timezone Edit
Amencallos_Angeles,PST-0800
Total RAM
Host Address 4.00GB S
-delphix.com Processor Type
AMDS4
os
Windows DSP KeyStore Alias
Version
Windows Server 2019 Standard ——
5P KeyStore Path
Java Development Kit
None
SP TrustStare P
Timezone
America/Los_Angeles,PST-0800
e [
Total RAM
4.00GB

5.2.5 Managing bookmarks

5.2.5.1 Global Bookmarks List

DCT provides a near real-time list of all bookmarks across all VDBs and VDB-groups and their associated VDB(s).
From the below screen, Delphix administrators can easily view and manage their bookmark estate.
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Data ‘Compliance Insights Admin

dSources Bookmarks

An overview of Bookmarks across your Delphix infrastructure.
VDBs

Search Search (All) v
Bookmarks
Environments Bookmark vDB Creation Date Tags
BM1 1-ORACLE_DB_CONTAINER-4 Mar 27, 2023 7:29 AM View Tags (1) >
Infrastructure
Finance-App-1.0.3.2 3-APPDATA_CONTAINER-276 Mar 27, 2023 11:21 AM View Tags (1) >

VDB Config Templates

5.2.6 Replication management
5.2.6.1 Replication mappings

5.2.6.2 Introduction

DCT 9.0.0 introduces the feature to differentiate between the replicated objects and original objects in case of a
parent and replicated engines, both are registered with DCT.

5.2.6.3 Prerequisites

One parent and one replicated engine is required with few replicated dSources and VDBs.

5.2.6.4 User interface

« Convenient separation between the replicated objects(VDB/dSource/environments) and original objects.
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dSources

VDBs

Bookmarks

Infrastructure

VDB Config Templates

« Users can filter the replicated object using the advanced filter.

dSources

VDBs

Bookmarks

Infrastructure

VDB Config Templates

VDBs

An overview of VDBs across your Delphix infrastructure.

Search

Status Name +

RUNNING CDOMLOSR421FPDB1_MCD

A CDOMLOSR421FPDB1_MCD
Replica

RUNNING CDOMLOSR421FPDB2_BAF
CDOMLOSR421FPDB2_BAF

N/A ,
Replica

RUNNING DBOMSREA1718_LIS

WA DBOMSRBA1718_LIS

Replica

Home Data Compliance lInsights  Admin

VDBs

An overview of VDBs across your Delphix infrastructure.

Search

(is_replica EQ true)

Advanced Search

Delphix supports advanced-based searching. See below to use the query builder.

' © SEARCH

©  IsReplica - EQUAL TO

Status Name +

NIA CDOMLOSR421FPDB1_MCD
Replica

N/A CDOMLOSR421FPDB2_BAF
Replica

DBOMSRBA1718_LJS

NA Renlica

True

Type

Oracle

Oracle

Oracle

Oracle

Oracle

Oracle

Type

Oracle

Oracle

Oracle

Engine

amit-engine

replicated-engine

amit-engine

replicated-engine

amit-engine

replicated-engine

Engine

replicated-engine

replicated-engine

replicated-engine

Tags

Add Tags > View >
Add Tags > View >
Add Tags > View >
Add Tags > View >
Add Tags > View >
Add Tags > View >

Hems per page: 60 1-8ol6

Tags
Add Tags > View >
Add Tags > View >
Add Tags > View >

Hems per page: 50 1-30f3

« All the actions on the replicated objects are disabled.
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Home Data Compliance Insights  Admin

VDBs > CDOMLOSR421FPDB1_MCD

< voss CDOMLOSR421FPDB1_MCD

- onre T Actions ~
Overview Active Timeflow Timeflow History Bookmarks Access
Platform Status
Oracle
Details Tags Edit Environment Details
Type VDB No tags added Environment Name oracle-tgt
Platform Qracle Type Single Instance
Version 19.3.000 os Linux
Size 0.008
Engine replicated-engine
+ The status of the replicated objects are N/A.
» On the VDB provisioning wizard, replicated objects(VDB/dSources) are marked as replicated.
Provision VDB X

Source
® Source

Select an available Source or VDB from which to provision to your VDB.

Provision Point

dSources VDBs
Target Environment Somrch
Target Configuration
CDOMLOSR421FPDB1
Policies
CDOMLOSR421FPDB1
Replica
Summary
CDOMLOSR421FPDB2
CDOMLOSR421FPDB2
Replica
DBOMSR8A1718

DBOMSR8A1718
Replica

coon v (2

5.2.6.5 API

Below are the list and search APIs, updated to return three additional fields ( is_replica, namespace_-id,

namespace_name )Z

1. Sources
GET: /sources
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GET: /sources/{sourcelId}

POST: /sources/search
2. VDBs
GET: /vdbs

GET: /vdbs/{vdbId}

POST: /vdbs/search
3. dSources
GET: /dsources

GET: /dsources/{dsourceId}

POST: /dsources/search
4. CDBs
GET: /cdbs

GET: /cdbs/{cdbId}

POST: /cdbs/search
5. VCDBs
GET: /vcdbs

GET: /vcdbs/{vcdbId}

POST: /vcdbs/search
6. Environments
GET: /environments

GET: /environments/{environmentId}

POST: /environments/search
7. Dataset-groups
GET: /groups

GET: /groups/{groupId}

POST: /groups/search
8. Timeflows
GET: /timeflows

GET: /timeflows/{timeflowId}

POST: /timeflows/search
9. Policies
GET: /virtualization-policies

GET: /virtualization-policies/{policyId}
POST: /virtualization-policies/search

10. Snapshots
GET: /snapshots

GET: /snapshots/{snapshotId}
POST: /snapshots/search

Below are the three fields added in response of these APIs:
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1. is_replica :Boolean telling that this object id replicated or not.

2. namespace_id : This field will only come for replicated objects and is essentially the namespace -d
of the replicated object.
3. namespace_name : This field will only come for replicated objects and is essentially the namespace

name of the replicated object.

5.3 Insight reports

5.3.1 Central governance insights

DCT provides global reporting of real-time statuses. This section will break down all of the reports in the Insights
section of DCT.

(® Allinsight dashboards can be exported to CSV or JSON format.

5.3.2 VDB Inventory

The VDB Inventory report provides users with a comprehensive list of all the Virtual Databases (VDBs) created in the
DCT platform and their identification metadata.

5.3.3 dSource Inventory

The dSource Inventory report provides users with a comprehensive list of all the dSources created in the DCT
platform and their identification metadata.

5.3.4 Source Ingestion Metrics

The Data Source Ingestion Metrics dashboard is designed to help users find their virtualization source ingestion
metrics, which are often required for contract renewal purposes. The dashboard contains the data sources and
informs the user of the total size of that ingestion source.

5.3.5 Compliance Job Metrics

The Compliance Job Metrics dashboard offers a comprehensive overview of the compliance jobs executed within
DCT, by presenting key metrics that enable stakeholders to assess the efficiency and effectiveness of their data
governance efforts.

5.3.6 Block Storage

This report provides users with a comprehensive view of storage usage across different engines. With this report,
users can easily identify the engines that are utilizing the most storage and take necessary action to optimize
storage usage.
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5.3.7 Activity Audit Log Summary

The Activity Audit Log Summary provides a high-level audit log summary capturing the utilization of DCT by
displaying user activity and the historical count of actions executed within the platform. This concise report enables
stakeholders to quickly identify trends, monitor user engagement, and assess the overall effectiveness of data
governance processes.
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6 Continuous Data workflows

6.1 DevOps TDM

DCT delivers all of the Continuous Data and developer operations necessary to power DevOps and Test Data
Management use-cases. This includes a suite of APIs to drive automation.

DEV Environment

Provision

Refresh Test Environment

Bookmark

Rewind

Teardown

Share QA Environment

-

_—
'--.

~~

Branch

200000006

Integrate
Unified

AP| Gateway and
Central

Management

Using the above APIs, DCT can seamlessly integrate Delphix data into DevOps pipelines by providing a single point
of integration for a broad Delphix deployment.

Continuous Data workflows - 137



Data Control Tower - Data Control Tower Home

Production Data

Source Incremental Incremental Incremental
Dataset Snapshot Snapshot Snapshot

Dev/Test/QA Environment

Compliant Sync Sync
Dataset Update Update
Data Bookmark
G e Collaboration between
ad DeviTest/QA
Build Trigger
Rewind Post-Run
CI/ICD APIs Bookmark Bookmarks
e Link ephemeral test environment Test 1 @
s Provision test data

e Rewind test data Test 2
& Bookmark after failed test

e Share bookmark data

e Teardown test infrastructure

X @&
X @

Test 3

ONON®)

6.2 Developer experience

In addition to automation use cases, DCT provides the APIs and Ul to power developer access to Delphix data and
common Delphix operations. This section will detail all of the major capabilities that make up this revamped
Delphix developer experience.

6.3 Self-service vs. DCT developer experience

Data Control Tower now provides a central experience for developers. Whether a developer prefers to leverage
Delphix via API, integration, or Ul, DCT delivers the ability to quickly access data from any connected Delphix
engine, and the common capabilities to drive application development and testing.

Previously, Delphix offered a local addon application called Self-Service (or Jet Stream) that was attached to
applicable data engines. Self-Service provided an interface to access pre-provisioned datasets encapsulated in
"Self-Service containers", which would be made available by admin configuration.

Data Control Tower has taken the most common operations and use-cases, and has made this experience
accessible to developers via API, integration, and Ul. This article will describe the key use-case and operational
overlap, as well as the differences between the local engine Self-Service experience and DCT's developer
experience.

6.3.1 Key similarities

1. Developer access to Delphix Data
The DCT developer experience is geared toward driving access to data, with all of the same time-based

Continuous Data workflows - 138



Data Control Tower - Data Control Tower Home

operations to enable application development and testing. Operations (accessible via the API, integration,
or Ul) include refresh, rewind, start/stop, enable/disable, bookmark, bookmark share, and timeflow
visibility/access.

Developer timeflow history

A common Ul benefit in Self-Service is the ability to visualize past timeflows (see Timeline history(see page 155)
for more detail), which acts like a testing record. Every time a developer runs a test and rewinds/refreshes,
that past test results are stored in Delphix as a timeflow. DCT has both APl and Ul instrumentation to make
the visualization and curation of timeflows incredibly simple.

Data-as-Code

Developers can use DCT bookmarks to reference a point in time on a VDB (or group of VDBs) with a
developer-set retention period and human-readable name. This is valuable for development teams as they
evolve application code. Whenever a code change necessitates a new database schema, a developer can
bookmark a VDB that is formatted to work with that particular code branch. This empowers development
teams to always have access to a viable test data set for any and code branches of an application.

6.3.2 Key differences

1.

DCT delivers a central interface powered by its converged architecture

This means that developers have a single location to log into in order to access and manipulate their virtual
data sets.

User experience

The DCT developer experience Ul has completely been reworked to make developer access to Delphix data
easy and intuitive. This experience shows itself in three Ul tabs, Active Timeline, Timeline History, and
Bookmarks, that are located in each VDB's detail menu. This experience is meant to be used by all Delphix
users (admins and developers, especially) and will be tailored to the individual based on the DCT Access
Control system.

No template/container model

Previously, engine administrators needed to create templates encapsulating one or more related VDBs and
provision new VDBs into a developer-accessible container. This model required manual administration that
created bottlenecks for data access, which was especially prohibitive for automation use-cases. The benefit
of this model was two-fold: first, containers represented a miniature sandbox for developers (using a Self-
Service user role) and second, bulk operations could be performed on all container-grouped VDBs while
maintaining referential synchronicity, a valuable attribute for integration testing.

DCT Access Control replaces the developer sandbox enabled by Self-Service containers

Developers simply log into DCT and can view and act upon data that they are entitled to access with
operations tightly bounded by their defined role. DCT's Access Control system has the ability to automate
both user membership of access groups and entitlement access via attribute-defined scoped roles. In
addition, roles can be customized in DCT such that granular permissions can be extended and restricted
down to both access group and user levels.

DCT VDB Groups replace the Self-Service container grouping mechanism

Currently only available via API, VDB groups enable the association of one or more VDBs for bulk operations
while maintaining referential synchronicity.

Time operations consolidation

The developer experience Ul consolidates the many time-based operations across Continuous Data and Self-
Service (e.g. refresh, rewind, rollback, restore, reset, etc.) into a single operation; refresh. From the DCT Ul,
clicking refresh will take users to a contextualized screen that simplifies time operations by focusing on what
timeline (and what time) the user would like to align to (parent, self, or relative).

No "branching"

Branching in Self-Service introduced the notion of task-specific timelines, each with its own associated sets
of timeflows. This was a concept that was heavily tied to the "template/container" model and is obviated by
the DCT Access Control system that can enable gated provisioning access to a developer. If a new timeline is
needed for a separate task, you can provision a new VDB.
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DCT has a Delphix-supported integration with ServiceNow, which is commonly used as a developer
resource-request tool. Users can build custom developer-centric workflows with any operation currently
instrumented through the DCT API layer.

6.4 Creating and managing bookmarks

6.4.1 Create new Bookmark

Bookmarks are a critical developer tool that enables the creation of a namable time reference to a snapshot of a
VDB or VDB group. Bookmarks for single VDBs can be created from the DCT Ul by selecting a VDB and expanding
into its detailed view. From the Active Timeline view, users can select the ellipsis in the top right corner and
"Create Bookmark".

Data Compliance Insights  Admin

< VDBs AppFS_DEV

Qverview Active Timeflow Timeflow History Bookmarks Access

R Today

Mar 27, 2023

Snapshot

B 4122 AM Siop

2 months ago
¥ Jan 20,2023

Selecting the "Create Bookmark" button will open a window that enables bookmark naming, setting the custom
retention period for that bookmark, and assigning any relevant tags. Creating bookmarks this way will initiate a
new snapshot operation that will then be associated with that bookmark.
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Create Bookmark b4

Bookmark Narme

Finance-App-1.0.3.2

[C] Retention - Keep Forever

Select Retention Date

6/30/2023, 11:03:55 AM E

| AppTeam: Alpha # Remove

Enter Tag Key Enter Tag Value + Tag

Cancel Create Bookmark

Bookmarks relating to a specific VDB can be found under the bookmarks tab in a VDBs details page. This provides a
curated list of actionable snapshots that represent anything from a relevant test result to a transformed set of
schema that can be associated with a specific branch of code.

Data Compliance Insights  Admin

< voss AppFS_DEV

Overview Active Timeflow Timeflow History Bookmarks Access

Bookmark Creation Date Tags Actions

Finance-App-1.0.3.2 Mar 27, 2023 11:21 AM View Tags (1) >

6.4.2 Bookmark APl Documentation

Some advanced bookmark operations are only available via API at present, formal documentation can be found via
DCT's swagger docs or the Developer resources section. This portion of the bookmarks documentation will discuss

examples of advanced use-cases.
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6.4.3 Create a Bookmark at the current time for multiple VDBs

In cases such as integration testing, bundling multiple VDBs together to represent a complete set of data that a
complex application would run on is helpful. This APl example shows how a single bookmark reference can be
created off of multiple VDBs, to provide a provision point for new testing sets or the creation of a VDB Group that
can be used to maintain referential synchronicity from that bookmark point.

curl -X '"POST' \
'"https://<APPLIANCE_ADDRESS>/v3/bookmarks"' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \

-d |{
"name": "MyBookmarkl",
"vdb_ids": [

"1-ORACLE_DB_CONTAINER-2",
""2-ORACLE_DB_CONTAINER-2"

} 1

These API calls will return a DCT job to track the creation process. This job ID can then be used to poll the
status via the jobs API. Example response:

{
"bookmark": {
"id": "9e8c7223flaf4694al9ac2c2f7696eda",
"name": "MyBookmarkl",
"creation_date": "2023-03-27T20:56:13.916857Z2",
"vdb_1ids": [
"1-ORACLE_DB_CONTAINER-2",
""2-ORACLE_DB_CONTAINER-2"
1,
"retention": 30,
"expiration": "2023-04-26"
3,
Hjobll: {
"id": "8fe825f5635d45299915c3ch88a17623",
"status": "PENDING",
"type": "BOOKMARK_CREATE",
"target_id": "9e8c7223flaf4694al9ac2c2f7696eda",
"start_time": "2023-03-27T20:56:14.363549Z2"

Continuous Data workflows - 142



Data Control Tower - Data Control Tower Home

6.4.4 Create a Bookmark for a VDB from an existing Snapshot

DCT Bookmarks (as of the 6.0 release) can create bookmarks from existing snapshots. This is particularly useful for
users looking to migrate Self-Service bookmarks to DCT or any developer looking to retroactively create a
bookmark reference.

curl -X '"POST' \
'"https://<APPLIANCE_ADDRESS>/v3/bookmarks"' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d '{
"name": '"MyBookmark2",
"snapshot_ids": [

"1-ORACLE_SNAPSHOT-11"

]

}l

6.4.5 Create a Bookmark for a VDB from an existing Snapshot
Starting in version 7.0, the Ul has an option to create bookmarks from the existing snapshots.

On the VDB detail page, under the Active Timeline tab for each snapshot, a Create Bookmark action is available.
This opens a dialogue that shows a list of inputs for the user to select from, to create a bookmark.

Once the user clicks Create Bookmark in the dialogue, the bookmark will be created for that particular snapshot (if
all the mandatory fields are completed), else errors will be shown.

Data Compliance Insights Admin

< voss JK-VDB-1

Overview Active Timeline Timeline History Bookmarks Access

Mar 22, 2023

4 days ago
Mar 21, 2023

5 days ago

Mar 20, 2023

6 days ago
Mar 19, 2023

<

Snapshot

a 4:01 PM

C Refresh
7 days ago
v £

Mar 18, 2023 = Relention

8 days ago n@ Create Bookmark
Mar 17, 2023
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6.5 VDB operations

The developer experience will continue to see investment and additional capabilities over the next few
releases.

The VDB operations Ul serves as an actionable command center for admins and developers. With this Ul, users can
migrate from using the local engine Ul to leveraging DCT to do their daily VDB-related work. This encompasses both
continuous data as well as any developers leveraging Delphix Self Service. The core benefit of this Ul experience is
the breadth of access coupled with DCT's access control system. Using both together, a user can access and act
upon any data on any connected engine within the boundaries of the entitlement and permissions set by the
admin-driven access control system.

Home Data Compliance Insights Admin admin e

An overview of VDBs across your Delphix infrastructure.

VDBs

Search Search (All) v
Bookmarks
Infrastructure Status Name 1 Type Engine Tags
RUNNING Vdbd_9MO Oracle Ul Trunk Add Tags > View >
VDB Config Templates
RUNNING dbdhcp3_CRW Oracle Ul Trunk View tags (1) > View >

Items per page: 50 1-20f2

To access the VDB operations Ul, users only need to log into DCT and select the detailed view of any particular VDB.

g Users will only be able to see VDBs if they have been granted access via the Access Control system.
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VDB Permissions

( ‘D Create | | ‘9 Update

L

( ‘D Delete || f View
r) Refresh | [P Rewind |

b T TP

D e
A} I N
' i

B VG PP FuCo PP YOy

] D O© O D

From there, users can perform common operations such as refresh, rewind, and bookmark using the Active
Timeline tab. Developers have additional functionality with the Timeline History tab that exposes non-active
timelines (also known as timeflows).

J

6.5.1 VDB provisioning wizard

Users can provision VDBs from the DCT Ul using the Provision VDB button located under the action button on a VDB
details page.

6.5.1.1 Supported database platforms
For Oracle Multi Instance (Single Tenant)

« Editing the Oracle instance number and instance name is not supported, they are set to default values.
For Oracle Single Instance (Multi Tenant) with linked vCDB

« TDE is supported for Oracle versions greater than or equal to 12.2.
+ Only vCDBs with database versions greater than or equal to 12.1.0.2 can be linked.
+ Auto VDB restart is supported for Oracle versions greater than or equal to 12.1.0.2.

For MSSql Multi Instance
« Drive letters are not supported and are set to default values.

Extending the developer experience capabilities in DCT, users can now provision MSSQL single instance databases
or Oracle single instance multi-tenant databases with linked CDB data platforms from the user interface, using an
intuitive wizard workflow. Located on the VDB page is a Provision VDB button that opens the provisioning wizard.
(Note: non admin users will only be able to see provisionable sources (dSources and/or VDBs), environments, and
engines to which they are authorized to see and act upon).
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6.5.1.2 Step examples
The provisioning wizard will walk through the following steps:

« Source: search and select either a dSource or VDB to provision from.

@ localhost:4200/data/vdbs

[c2
g

Provision VDB X

Source
® Source

Select an available Source or VDB from which to provision to your VDB.

Provision Point

dSources VDBs
CDOMLOSR1EOFPDB1 Details
Target Environment Name
Search CDOMLOSR1EOFPDB1
) ) Version
Target Configuration Oracle 18.3.0.0.0
Biscuit Engine
Policies KM's Engine
CDOMLOSR1EOFPDB1 Group
Summary Oracle SIMT
CDOMLOSRCA3BPDB1 Environment
Oracle MT 18
DBOMSRB331B3
DBOMSRD914EA

SourceDB4-69963

db_rhel83_160_1

Items per page: 25 1-70f7

Cancel m

«+ Provision Point: three options for a provision point, similar to a refresh point.
+ Aselected snapshot
«+ Aspecific timestamp (closest snapshot to the timestamp)
+ Alocation ID/number (closest snapshot to the location number)
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@© localhost:4200/data/vdbs M (]
Provision VDB X
Provision Point
Source
The data from the parent will be copied to the target VDB.
@ Provision Point
Selected dSource:
CDOMLOSR1EOFPDB1
Target Environment
Select Provision Point Select Exact Time (Slower) SCN Number Refresh (Slower)
Target Configuration
Timeflow
Policies default
2 days ago
Summary o3 Vs ag 0
Jul 25, 2023
Snapshot
0] 4:01 PM
3 days ago 0
¥ Jul 24,2023
4 days ago o
¥ Jul 23, 2023
5 days ago 0
¥ oul 22, 2023

Cancel Back m

+ Target Environment: shows compatible environments with compatible repositories, and can optionally
provide privileged credentials.

<«

C @ localhost:4200/data/vdbs % *»O00@ :

Provision VDB %

Target Environment
Source

The target environment is the location where your VDB will be provisioned. Select a target environment from the list under "Environment" and complete the Home and User fields.

Provision Point
Selected dSource:

CDOMLOSR1EOFPDB1
@ Target Environment

User

Target Configuration .

Oracle MT 18 oracle

Policies Installation Home
/u01/app/oracle/product/18.0.0.0/dbhome_1 -

Summary

Create a new container database

[ Provide Privileged Credentials

« Target Configuration: should be prefilled with default configurations. One thing to note here are the tags
which are additive when “Include Tags from Parent” is checked, and you wouldn’t immediately see the tags
from the parent in the editor. Tags are added when the Include Tags from Parent box is checked, you
would not immediately see them from the parent in the editor.

+ Users can also select the engine group and register listeners by expanding the advanced section
below. In DCT, it is recommended to use tags instead of engine groups.
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< C @ localhost:4200/data/vdbs

Provision VDB

Provision Point

Target Environment

® Target Configuration

Policies

Summary

&< - C @ localhost:4200/data/vdbs
Provision VDB
Source

Provision Point

Target Environment

Target Configuration

vCDB Configure
Parameters

Policies

Summary

Set the various target configuration options for the newly provisioned VDB.

Mount Base *

/mnt/provision

Oracle Pluggable Database Name *

CDOMLOSR1EOFPDB1_HE8

VPDB Name *

CDOMLOSR1EOFPDB1_HE8

Oracle Virtual Container Database Name *

CDBCDOMLOSR1HE8_ECI

VCDB Name *

CDBC_ECI

Oracle Virtual Container Database SID *

CDBCDOMLOECI

Oracle Virtual Container Database Unique Name *

CDBCDOMLOSR1HE8_ECI

[J Transparent Data Encryption (TDE)

vCDB Configure Parameters

Default

Table Text

Name

max_pdbs

memory_target

log_archive_format

nls_territory

compatible

processes

nls_language

« Policies: choose a snapshot policy.

[J Include Tags from Parent dSource

Enter Tag Key Enter Tag Value

h % » 00 :

+ Tag

Cancel Back m

« VvCDB Configure Parameters: Applicable to Oracle Single Instance (Multi Tenant) with linked vCDB.

Save as New Template

Value

4098

1342177280

"%t_%s_%r.dbf'

'AMERICA'

'18.0.0'

300

'AMERICAN'

Cancel Back

6 % 0@ :

X

Next

Continuous Data workflows - 148



Data Control Tower - Data Control Tower Home

& > C @ localhost:4200/data/vdbs
Provision VDB
Source

Provision Point

Target Environment

Target Configuration

® Policies

Summary

Policies

Select the desired snapshot policy for the new VDB.

Source
CDOMLOSR1EOFPDB1

@ Default Snapshot

Snapshots will be taken:
At 03:30 AM, only on Sunday (US/Pacific)
At 03:30 AM, only on Monday (US/Pacific)

View all 7 schedules

H % 00 :

Target Environment
Oracle MT 18

None:SnapshotPolicy

Nothing scheduled for this policy.

Cancel Back m

« Summary: review the selections that have been made.

« > C @ localhost:4200/data/vdbs
Provision VDB
Source

Provision Point

Target Environment

Target Configuration

Policies

® Summary

6.5.1.3 Limitations

Summary

Review the configuration profile for this VDB

Source

Source dSource/VDB
CDOMLOSR1EOFPDB1_HE8

o % *»O00Q :

Target
Environment
Oracle MT 18

Installation Home
/u01/app/oracle/product/18.0.0.0/dbhome_1

Mount Base
/mnt/provision

vPDB Name
CDOMLOSR1EOFPDB1_HE8

Oracle Pluggable Database Name
CDOMLOSR1EOFPDB1_HE8

vCDB Name
CDBCDOMLOSR1HE8_ECI

Oracle Virtual Container Database Name
CDBC_ECI

Oracle Virtual Container Database SID
CDBCDOMLOECI

Oracle Virtual Container Database Unique Name
CDBCDOMLOSR1HE8_ECI

Transparent Data Encryption (TDE)
Off

VDB Tags
No tags added

Cancel Back m

TDE and Auto VDB restart are only supported for Oracle version 12.2 or higher.
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6.5.2 VDB refresh Ul

6.5.2.1 Overview
The VDB refresh wizard in the Data Control Tower Ul offers important engine refresh operations like:

+ Self-refresh by snapshot, timestamp, or location
« Refreshes a VDB back to a point in its own history.
« Refresh to parent by snapshot, timestamp, or location
« Datais pulled from the VDB provision parent (the dSource or VDB from which the VDB was
provisioned).
« Refresh to relative by snapshot, timestamp, or location
+ Allows selection of data from either the origin dSource of the VDB (which could be the immediate
parent, or parent of parent, etc.) or any VDB sharing the same origin dSource (which could be parent,
child, sibling, or similar relationship).
+ Refresh to bookmark snapshot
« Refreshes a VDB to a compatible bookmarked snapshot.

In order to refresh from a dSource or VDB, the account performing the action must have the REFRESH
permission on both the VDB being refreshed and the dSource (or VDB) from which the data is being
refreshed.

6.5.2.2 Userinterface

The self-refresh by snapshot operation can be initiated as an action from the VDB's own active timeline or
timeline history view, using the action menu for snapshots.
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< VDBs VDB

Overview Active Timeline Timeline History Bookmarks Access
Confirm Refresh X
a month ago
Feb 13. 2023 Are you sure you want to refresh to this snapshot? o
napshot
(O .
10:51 AM
' Refresh

2 months ago
N Jan 8, 2023 7] Retention

6 months ago °
v sep 20, 2022

3 years ago °
¥ Sep 19, 2019

All three refresh types can be performed by opening the refresh wizard on the VDB details page. In the first step,
select the refresh source:

Refresh " " X
Select Refresh Source
®  Select Refresh Source
Select the source of the data refresh,
Hetresn Pt Parent Selt Relative
Set the data state of this VDB to any available point from Set the data state of this VDB to any available point Set the data state of this VDB to any available point from any
the parent. on this VDB relative VDB
Summary

Next, select the snapshot or point in time to refresh to:

« For self-refresh, a timeflow from the VDB’s own history must be selected, and then a snapshot within the
selected timeflow.

« For parent refresh, a timeflow from the VDB’s provision parent’s history must be selected, and then a
snapshot within the selected timeflow.

« Forrelative refresh, first a relative dSource or VDB must be selected, then a timeflow, then a snapshot.
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For all three refresh types, review the summary page once configurations are complete, then click submit:

Summary

Review the following to confirm your action to refresh VDB "Vdbd_3LT" from the selected source.

This action will create a new timeline
This action will be non-destructive since the existing state will be preserved as an alternate timeline that can be found in Timeline History on the VDB.

Source of Data
VDB2SZ

> Selected VDB

Data Point
Vdbd_3LT

Snapshot 201

Origin DSource Time
Jul 24, 2019 3:00 PM

Refreshing happens asynchronously and takes a various amount of time. The DCT Ul does not currently
show asynchronous job progress or errors, please refer to the engine Ul for this function.

Refresh to Bookmark

Bookmark is available as a Select Refresh Source option in the refresh wizard, which allows you to refresh from
compatible bookmarks. Choose a bookmark from the list and click Next.

Refresh "VVWdb_MIK" X

® Select Refresh Source Select Refresh Source

Select the source of the data refresh.

Select Bookmark Parent Relative
Set the data state of this VDB to Self " Set the data state of this VDB to ook 0
" . Set the data state of this VDB to . . Set the data state of this VDB to
any available point from the " . . any available point from any q
any available point on this VDB. . any compatible bookmark.
Summary parent. relative VDB.

Canel m

Select Refresh Source Select Bookmark

Select a bookmark for data refresh.

®  Select Bookmark

Search Search (All) v
Summary
Bookmark Creation Date Tags
my-bookmark-1 Apr 25,2023 4:33 PM Add Tags >
my-bookmark-2 Apr 25,2023 4:34 PM Add Tags >
Tto20f2 ¢ < Pagelofl > I
Cancel Back Next

You can also refresh from a particular bookmark under the VDB details page, via the Bookmarks tab. Choose a
bookmark from the list as the one to refresh from, then click the Actions menu and select Refresh to Bookmark.
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Data Compliance Insights Admin

< voss VVdb_MIK

Overview Active Timeflow Timeflow History Bookmarks Access
Bookmark Creation Date Tags Actions
my-bookmark-1 Apr 25,2023 4:33 PM Add Tags > Actions :
my-bookmark-2 Apr 25,2023 4:34 PM Add Tags > Refresh to Bookmark

Update Bookmark

Delete

Tto2o0f2 Page 1 0of 1

6.5.3 Active timelines Ul

6.5.3.1 Active Timeline View

Active Timeline can be found by selecting “details” for any VDB located on the VDB list page in DCT and selecting
the “Active Timeline” tab. This view serves as an operations console for any user with the appropriate entitlements
to see and act upon the identified VDB granted by the DCT access control system.

This view shows a vertical timeline-based representation of all actionable points of interest (snapshots) for that
VDB. The snapshot list is chronologically grouped over blocks of time to easily identify relevant snapshots to act
upon. Once the right snapshot is found, users can access a contextualized action menu by selecting the
corresponding ellipsis to the relevant snapshot.

& Contextual snapshot menu: By selecting the ellipsis next to the VDB of interest, users can refresh to a
snapshot or create a bookmark (a nameable and shareable snapshot reference.

Data Compliance Insights  Admin

< woes ~CDOMLOSR421FPDB1_93T

Overview Active Timefiow Timefiow History Bookmarks

.. 5daysago
Mar 22, 2023 o
@ Sest
3:00 PM
C  FRefresh
6 days ago
¥ Mar21, 2028
7 days ago

Alternatively, users can perform common Continuous Data actions via the ellipsis in the top right of the Active
Timeline screen. This menu will offer VDB-wide, generalized operations including:

+ Refresh: This is a generalized operation to realign your VDB's timeline with another. More information can
be found in the Refresh a VDB(see page 151) article.
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« Start/Stop: A way to manage target host bandwidth.
+ Enable/Disable: An administrative operation required for upgrades/migrations.
« Create Bookmark: Create a special reference to a snapshot that has a custom name and retention period.

Data Compliance Insights  Admin

< wss ~CDOMLOSR421FPDB1_93T
ciive Timefiow Timefiow Histary Bookmarks

L5 days ago

napsho
B 300 pPm op

6 days ago

7 days ago

6.5.3.2 Additional notes

+ Refresh using the DCT Ul
Data Control Tower has consolidated all contextualized time-based operations (e.g. refresh, rewind,
rollback, restore, reset, etc.) across Continuous Data and Developer products into a general "Refresh". By
clicking refresh, users will be prompted on what timeline they would like to align: Parent, Self, or Relative.
From there, users will be taken to a wizard that will give relevant timeline options and points in time to
perform the refresh.

« Start/Stop
Starting and Stopping are geared toward bandwidth management in a target environment. Stopping a VDB
will place it in stasis such that it can't be accessed, but also won't consume bandwidth. Starting it back up
will re-enable it for regular activity.

« Enable/Disable
Enabling and Disabling are geared toward administrative operations such as VDB migration or upgrade.
Disabling a VDB removes all traces of it, including any configuration files, from the target environment to
which it was provisioned. Re-enabling the VDB will restore those configuration files.

+ Create Bookmark
Bookmarks serve as a human-referenceable representation of time that can work for a single VDBs or VDB
groups. Bookmarks also have the capability to be shared (Refresh to relative in the Refreshing a VDB(see
page 151) article). From the top level menu, users will be able to name the reference and set a unique
retention period.
Bookmarks do not appear in the Active Timeline, to access existing bookmarks, users will have to navigate to
the "Bookmarks" tab on the VDB detail view.

6.5.4 Timeline history Ul

6.5.4.1 Timeline History view

The timeline history view can be found by selecting “details” for any VDB located on the VDB list page in DCT and
selecting the “Timeline History” tab. This view serves as a developer-centric console that shows the complete
history of a VDB including non-active timelines, which is a critical resource for developers as these can contain
information like past test results. Using this page, developers can curate and access the complete chronology of
their testing efforts with operations such as renaming individual timeflows, make active, refresh to snapshot, and
create bookmark to drive organization and access.
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6.5.4.2 The Timeline History user interface

If entitled via the DCT Access Control system, developers can see and act upon VDBs in the VDB list view using the
timeline history tab under "details". The timeline history Ul is comprised of a vertical timeline-based representation
of all actionable points of interest (snapshots) for that VDB. The snapshot list is chronologically grouped over blocks
of time to easily identify relevant snapshots to act upon. Once the right snapshot is found, users can access a
contextualized action menu by selecting the corresponding ellipsis to the relevant snapshot.

< VDBs \

Overview Active Timeline Timeline History Bookmarks Access

Based on source data from:
Mar 12, 2023 3:31 AM

DB_ROLLBACK
Mar 20, 2023 3:30 AM

Timeflow-1 Active
Mar 12, 2023 3:31 AM

~ Today
Mar 23, 2023

Snapshot

B 330 AM

2 days ago
Mar 22, 2023

3 days ago
Mar 21, 2023

4 days ago
Mar 20, 2023

5 days ago
Mar 18, 2023

6 days ago
Mar 18, 2023

7 days ago
Mar 17, 2023

ltems per page: 60 ¥ -20f2

6.5.4.3 Non-active timelines

Non-active timelines (often referred to as “timeflows” in Self-Service) are a critical aspect of how Delphix
Virtualization works and an important Developer Tool. Whenever a time-based operation takes place, the previous
timeline (and associated data) becomes non-active and a fresh timeline takes its place.
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'
'
i
Snapshot B Snapshot C )
'
1
'
'
'

VDB 1
E Snapshot A Snapshot B Snapshot C :
(User Performs “Self Refresh” to Snapshot B)

VDB 1

i Snapshot A Snapshot B E
e o ISy
i

i

() Non-active timeline creation from "Self-Refresh"
In this scenario, a developer has performed a “self-refresh” (formerly referred to as a “rewind” or
“rollback”). In refreshing Snapshot B, the developer has created a new active timeline that represents a
clean slate starting with the data state of Snapshot B. If the developer wants to refer back to the past
results that are represented on the non-active Timeline, he or she can activate the past timeline by hitting
the “Make Active” button in the DCT User Interface or by refreshing to a point in time by referencing the
non-active Timeline’s ID.

For developers, having the ability to catalog (name and tag) and reference past timelines is a critical aspect of
application development such as performing ad hoc code validation or manual testing. The timeline history Ul in
DCT provides a home for single VDB visibility of all accessible timelines (note: timeline availability is controlled
through capacity management and snapshot retention policies).

6.5.4.4 Time concepts within the Timeline History Tab

DCT’s new user interface highlights different notions of time within Delphix (e.g. dSource, VDB, and VDB lineages)
and how they relate to one another. These time-based relationships are exposed in the Timeline History view to
drive accurate testing for developers.

The “Based on dSource time” designation helps to drive awareness of the relationship between a VDB and its
dSource provision point (in most cases this will equate to the production database’s state at that time), which is
helpful for use cases such as capturing data from a meaningful event. As a VDB refreshes to newer snapshots on a
dSource, those changes of data state are grouped separately on the Timeline History view as they represent
completely different data.

6.5.4.5 Timeflow operations

“Make Active”, a developer can reference any past timeflows and data represented therein by making a timeflow
“Active”. This can be done by simply clicking on the timeflow of interest and selecting “Make Active”.
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VDB 1
i Snapshot A Snapshot B E
: . . Active Timeline :
: :
; Snapshot B Snapshat C i
1 . NOT .',::l'!-‘:' “Ilili”il- E
VDE 1 l Make the Non Active Timeline, “Active”
i Snapshot B i
| o oy
i Snapshot A Snapshot B Snapshot C E
! . . Active Timeline ;
Refresh to snapshot

Included within each timeflow are snapshots that can be accessed via a dropdown menu under each timeflow. If
given the right permission, a developer can refresh the VDB to that snapshot. While this may seem similar to “Make
Active”, there are major underlying differences as a “Refresh” will reprovision the VDB based on that point in time,
whereas, “Make Active” simply changes the reference to different blocks of the underlying storage.

VDB 1

i Snapshot A Snapshot B i
: . Active Timeline '
i Snapshot B Snapshot C E
i WO i ¥ E
OB 1 1 Refresh to Snapshot “C” on Non Active Timeline

Snapshot B Snapshot C

Snapshot C ACTIVERlIMTENTE

Create bookmark

On a snapshot will enable developers to convert that snapshot into a DCT Bookmark (see page 131)that enables
developers to assign a name and special retention policy to that time reference. This also enables stronger
collaboration between developers as bookmark references can be used for a sibling refresh operation.
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Rename timeflow

Developers can curate time flows to correspond to tests such that they can easily reference results data. This action
can be performed by clicking the ellipsis on the time flow to reach a drop-down menu. This menu includes the
option to "rename" which will open a dialog box to input a new name. The input is prefilled with the current
Timeflow name by default. Saving the dialog kicks off a job to rename the timeflow. The changes may take a short
time to be reflected in the Ul.

Rename Timeflow

[ DB_PROVISION@2023-03-20T16:23:31

Delete timeflow

Developers have the option to delete time flows via the Ul by selecting the ellipsis next to the corresponding time
flow and selecting "delete". When clicked, this opens a confirmation dialog asking if the user wishes to delete the
timeflow. If the dialog is confirmed, a job is kicked off to delete the timeflow. Note: This menu item is disabled for
the currently-active timeflow.

A~ Test1.0.2
May 4, 2022 4:32 PM
4 Make Active

. 5 months ago

Nov 10, 2022 2. Rename

@ Snapshot W Delete
3:37 AM

a year ago 0

Y May 4, 2022

6.5.4.6 APl documentation

While the DCT Ul provides a visual aspect to timeflow chronology and grouping, the DCT API has all of the necessary
instrumentation to integrate these concepts into automation. The formal documentation can be found via DCT's
swagger docs or the developer resources documentation section. This portion of the timeflow documentation will
provide some general examples:

Get a list of a VDB's timeflows

This simple call will enable the listing of the entire timeflow roster underneath a VDB enabling a developer to take
inventory and action.

curl =X 'POST' \
'"https://<APPLIANCE_ADDRESS>/v3/timeflows/search?limit=50&sort=1id"' \
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-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H 'Content-Type: application/json' \

-d l{

"filter_expression": "dataset_id eq '\''1-ORACLE_DB_CONTAINER-2'\'""
}l

The UPDATE timeflow API can be used to change a timeflow's name

Once the appropriate timeflow is found, developers can rename the timeflow to align with a naming scheme or
other relevant designations such as a compatible code branch.

curl =X '"PATCH' \
'"https://<APPLIANCE_ADDRESS>/v3/timeflows/1-ORACLE_TIMEFLOW-7"' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d '{
"name": "Latest on refresh state"

} '

List all the snapshots for a timeflow

Developers can then use the snapshot API to find all relevant "actionable" points in time on the identified timeflow.
The below example shows how to only expose snapshots on a particular timeflow. From there, developers can feed
the relevant snapshot ID into refresh or provision endpoints or create a bookmark reference from that snapshot.

curl -X 'POST' \
"https://<APPLIANCE_ADDRESS>/v3/snapshots/search?limit=50&sort=1d"' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d '{
"filter_expression": "timeflow_id eq '\''1-ORACLE_TIMEFLOW-7"'\"'""

}l
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7 Continuous Compliance workflows

& Compliance Engines limit any syncing operations while a profiling or masking job is running. When using
DCT job move, execute, or migrate operations, please ensure that the target Compliance Engine is in an
idle state. Future Compliance enhancements to DCT will remove this limitation.

With the ability to distribute and run jobs, DCT enables advanced Compliance Engine architectures to be
orchestrated and monitored using DCT’s real-time, persistent relationships with connected Compliance Engines.
When syncing a Compliance Engine, DCT will create references for all Compliance jobs on that Engine. These will
show up as unique objects tracked by DCT that can now be leveraged with job move APIs.

7.1 Listing and searching compliance jobs

When a Compliance Engine is registered with DCT, compliance jobs (referred to as MaskingJobs within the DCT API)
on the Engine are automatically ingested and presented as DCT MaskingJob objects.

Example of listing all MaskingJobs:

curl -X '"GET' \
'https://<APPLIANCE_ADDRESS>/v3/masking-jobs' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>'

Example of searching for OnTheFly MaskingJobs:

curl =X 'POST' \
"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/search' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
_d l{
"filter_expression": "is_on_the_fly_masking eq true"

} 1

With the new job move APIs, DCT can now be used to power two advanced masking reference architectures*:
Software Development Lifecycle (SDLC) and Horizontal Scale architectures. SDLC enables the separation of
duties for the development, quality assurance, and production use of masking jobs whereas Horizontal Scale
enables the use of a central configuration engine with the movement of jobs to headless compute engines.

To enable these architectures, DCT has introduced three new operations: Job Copy, Job Execute, and Job Migrate:

« Copy: Supports SDLC by copying a job, but maintaining separate references in DCT.

+ Execute: Supports Horizontal Scale by copying a job, but maintaining the same reference between two
copies. DCT will also keep both of these copies in sync.

+ Migrate: Supports the movement of a single instance from one engine to another.

44 https://documentation.delphix.com/continuous-compliance/docs/working-with-multiple-masking-engines
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7.2 Consolidated operations (intelligent syncing)

DCT has simplified the set of operations required to move a job and its dependencies. Previously, orchestrating
movement of jobs required three separate API calls: Job Sync, Global Object Sync, and Credentials Update (on the
newly created job). DCT has now consolidated all three of these operations into each of the job move APIs. In
addition, if two jobs are held in sync (see Job Execute(see page 170)), DCT will auto update synced jobs whenever one
of those jobs has been modified (i.e. updated rule set, new algorithms, etc.).

B In order to transfer connector credentials with a job as part of the job move, you will need to associate
those credentials using the connector credentials API. See sample code below on how to update

credentials.

Example of updating a MaskingJob with connector credentials:

curl =X 'PATCH' \

'https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead'

\

-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H '"Content-Type: application/json'

_d l{
""connector_username": "userl23",
"connector_password": "passwordl23"

} '

7.3 Managing engines (Continuous Compliance)

DCT provides a near real-time list of all connected Continuous Compliance engines and lists them in an aggregate
view. From the below screen, Delphix administrators can easily view and manage their engine connections.

Data Compliance Insights  Admin

Compliance Engines Compliance EngineS
Overview of all compliance engines in your Delphix ecosystem.
Compliance Jobs

Search

Status Name/UUID 4 Type Running Jobs
Masking
9 o

» Online Test Engine 2 9.0.0.0

Masking

» Online Test Masking 9.0.0.0

Connect Engine

Search (All) v
Masking Usage/Total Masking Available Cores Tags
0% _ :
2.00GB 4 View tags (1) > View >
9
o 4 Add Tags > View >

2.00GB

From this screen, administrators can manage engine connects via the “Connect Engine” button on the top right
corner. By clicking this button, the below window will appear asking for connection details.
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DCT will access the engine as a registered user and, as detailed in the Deployment section, requires both
a username and password as well as admin-level access to the engine. For compliance engines, select
"Masking" type when registering an engine.

Connect Engine X

®  Engine Details Engine Details

Name.

R Test Engine 2
Authentication

Hostname

Security uvoltz4micpf5ex4dbg.vm.cld.sr
Tags Choose Engine Type

O Virtualization
Summary

@ Masking

7.3.1 Engine overview

Individual engine details can be seen and acted upon by clicking down on a particular engine detailed view. Once
clicked, users will be sent to an "overview" tab that provides relevant metadata related to the engine.

Data Compliance Insights Admin

< Compliance Engines Test Engine 2

Overview Access

Current Memory Usage
Number of Running Jobs

0 0% 0.00B of 2.00GB
Details Tags Edit
Type
Compliance Engine Data Center: West Coast

Version
9.0.0.0

7.3.2 Engine-based operations access

Users are able to audit which users have access to this particular engine, what access group they belong to, and the
associated permissions that each user has on this engine. Admins are able to click on the "View" button to access
further details under the access control screen related to that specific user.
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Data Compliance Insights  Admin

Engines

A

Compliance Engines TeSt Engine 2

Ow Create Ow Create Environment

Ow Delete  Ow ManageTags ~ Ow Read

johnsmith @company.com

Overview Access
Ow Set Tags at Object Creation ~ Ow Update
User Access Groups Permissions
13 o- CREATE_ENVIRONMENT o~ DELETE View >
John Smith B
John Smith > o= CREATE_ENVIRONMENT o= DELETE View >

7.4 Compliance jobs

7.4.1 Job Ul

7.4.1.1 Global compliance jobs list

When connected to a Continuous Compliance engine, DCT will sync and create references to every compliance job
on the engine. All of those job references can be found in the global compliance list, which is a taggable, filterable,
sortable, and searchable list of all compliance jobs across a connected Delphix ecosystem.

Data Compliance Insights  Admin

Compliance Engines COmplianCe Jobs

Compliance jobs are the configurations that enable you to mask data on your data sources.
Compliance Jobs

Search Search (All) v

Name/ID 1

Drupal 9 Custom App Masking

020e35d2-7d60-482¢-908b-7825¢89ed3e7 View >
Drupal 9 Custom App Masking Vi N
08edd39c-bbe2-4296-9e10-ac255fdc8722 rew
M1-sCRM-Dev View >
473b6938-106a-4969-bc53-d756{33845fa
M1-sCRM-Dev View >
4ed7691e-cab8-48aa-al4a-62339d9a0534 bl
Mask anagrafe View >
36bfd517-30d0-400f-b950-50a8985426eb ©
Mask f

lask anagrafe View >

bbfd11e9-3cc9-4998-bc40-a624f0a15241

7.4.1.2 Compliance job overview

Individual compliance job details can be seen and acted upon by clicking down on a particular compliance job
detailed view. Once clicked, users will be sent to an "overview" tab that provides relevant metadata related to the
VDB.
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Data Compliance Insights

¢ complance Jobs  Drupal 9 Custom App Masking

Overview Access Histary

Job Status : SUCCEEDED Run Time : 22sacs
Started at 3:09 AM

Initializing

Gollecting Gonfigurations

Preparing

>

Running Pra-exesution Gustom Driver Tasks
Starting

¥

Running PreSQL Scripts

»

Running PostSQL Scripts

»

Running Post-execution Customn Driver Tasks
Collecting Information

Job Complated

Details Tags Edit

Created
May 16, 2022 3:54 AM

Rule Set
Drupal 9 Gustom app

7.4.1.3 Accesstab

Users are able to audit which users have access to this particular compliance job, what access group they belong to,
and the associated permissions that each user has on this job. Admins are able to click on the "View" button to
access further details under the access control screen related to that specific user.

Data Compliance Insights  Admin

Masking Jobs
¢ Complancedons  Drupal 9 Custom App Masking

Om CANCEL Ow Copy  Ow Delste

Overview Access History O= Execute  Ow ManageTags  Ow MIGRATE
Ow Read Ow Update
User Access Groups Permissions
1% o= CANCEL o= COPY o= DELETE View >
John Smith
o. » .T“ @ I, John Smith > o= CANCEL o= COPY o= DELETE View >
johnemith@company.com

7.4.1.4 Execution history tab

The compliance jobs page also includes job execution history. Execution information will be recorded and
displayed on this tab, and includes the status (success, running, failed), run time, submit, and end timestamps, and
engine on which it ran. Additionally, clicking the “details” button for an execution will display its report.
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Home Data Compliance Insights

< Compliance Jobs Compl iancedJob1 .
Overview Access History
Search Search (All)
v
Run Time Submit Time End Time Engine Name
0 May 3, 2023 6:44 PM May 3, 2023 6:44 PM em-masking Details >
0 May 3, 2023 6:44 PM May 3, 2023 6:44 PM em-masking-6013.dc... Details >
0 May 3, 2023 6:44 PM May 3, 2023 6:44 PM em-masking-6013.dc... Details >
1to3of3 Page 1 of 1

7.4.1.5 Execution details

The execution details view includes a list of execution events and the execution log. This is particularly useful when
troubleshooting failed executions.

Details for successful executions may also have events and logs which include relevant information, such
as warnings.
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Error Report

Execution event Information
This section shows exceptions that occured during the job run. More detailed information may be available in Masking logs.

Execution Events

Event Cause Description
JOB_ABORTED UNHANDLED_EXCEPTION Listener refused the connection with the fall...
Logs

2023-05-05 04:44:13, [thread] INFO com.dmsuite.dmsApplicator.masking. XMLGenerator executeMarshalling - Generate request xml started
successfully.

2023-05-05 04:44:13, [thread] INFO com.dmsuite.dmsApplicator.masking. XMLGenerator executeMarshalling - Generate Request xml done
successfully.

2023-05-05 04:44:13, [thread] INFO com.dmsuite.dmsApplicator.masking.transformation.MaskingMarshalling createKettleXML - Generate
Transformation XML started successfully

2023-05-05 04:44:13, [thread] SEVERE com.dmsuite.dmsApplicator.masking.transformation.MaskingMarshalling handleJobGenerationException - An
exception occurred during job generation

java.sgl.SQLException: Listener refused the connection with the following error:

ORA-12505, TNS:listener does not currently know of SID given in connect descriptor

7.4.2 Copy job

& Compliance Engines limit any syncing operations while a profiling or masking job is running. When using
DCT job move, execute, or migrate operations, please ensure that the target Compliance Engine is in an
idle state. Future Compliance enhancements to DCT will remove this limitation.

The Masking Job Copy operation creates a duplicate of a job with a separate reference for that new copy. This

operation supports SDLC workflows as DCT will maintain unique references for each instance of a masking job,
enabling them to be managed independently.
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fCopy Separate Job
References in DCT
DEV QA PROD

DEV ENGINE ‘_,5\(\0 QA ENGINE PROD ENGINE

X)) 99 )

Delphix = .- ___ R Delphix Delphix
', \l ,’ ______________ \l ” ____________ \I
| 1 1 1
| I | 1 I 1
1 1 | 1
I 1 ! . ! ! _ 1
1 o T L 1
' DEV_MASK : : DCT_QA_MASK ! : DCT_PROD_MASK |
\ — e e e e 7 N L __— e ,’ N /,

7.4.2.1 Userinterface documentation

Job copy can be run via the DCT Ul by accessing a compliance job's detailed view and selecting the ellipsis in the
top right corner and clicking on "copy". This will open a window to select the target engine, the new name of the
transferred job, source and target environment details, and relevant tags.

Data Compliance Insights  Admin

¢ complancesors  Drupal 9 Custom App Masking

Bescute
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7.4.2.2 APl documentation

For input, the user must specify the target engine along with the environment on the target engine that the job will
be copied onto. The engine and environment pair is what uniquely identifies a copy of the Masking Job. Calling the
COPY API against the same target engine and environment effectively serves as a re-sync and does not create a new
DCT MaskingJob entity.
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Example of copying a MaskingJob to engine with ID 2 and environment named ‘prod-env’:

curl -X '"POST' \
'"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead/
copy' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \

_d l{
"target_engine_id": "2",
"target_environment_id": "prod-env"

} 1

MaskingJob sync will not copy connector credentials to another engine. In order to make a copied job executable
outside of DCT, the credentials must be set on the Connector itself. The connectors for a MaskingJob can be
searched for, updated, and tested directly via DCT.

Example of listing connectors for a MaskingJob:

curl -X 'GET' \
'"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead/
connectors' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>'

Example of updating a connector’s credentials:

curl -X '"PATCH' \
'<https://<APPLIANCE_ADDRESS>/v3/connectors/2-DATABASE-23'> \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \

_d l{
"username": "USER123",
"password": "passwordl23"

} !
Example of testing a connector:
curl =X 'POST' \
'<https://<APPLIANCE_ADDRESS>/v3/connectors/2-DATABASE-23/test'> \

-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
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7.4.3 Executejob

& Compliance Engines limit any syncing operations while a profiling or masking job is running. When using
DCT job move, execute, or migrate operations, please ensure that the target Compliance Engine is in an
idle state. Future Compliance enhancements to DCT will remove this limitation.

The Execute endpoint creates a duplicate of a job while maintaining a single reference for both job instances. This
operation supports Horizontal Scale workflows, as DCT will maintain a singular reference for all instances of a job
across any number of connected Compliance engines.

As part of this endpoint, DCT will maintain all of these job instances in sync, so they can all be controlled from a
single configuration point (it's recommended to dedicate a select engine or set of engines to the creation and
updating of masking jobs and dependencies) and any changes are automatically propagated to the other job
instances at the time of the next job execute operation. This enables users to identify a masking job on a
configuration engine, copy it over to a dedicated compute engine (or set of engines), and run that job at a regular
cadence through DCT. Whenever the job needs to be updated, the user simply updates the job on the configuration
engine.

Since all jobs connected via the job execute operation are under a single reference, every time a job is
run, its run statistics will report back to DCT and will be recorded under that singular job reference.

Executing a MaskingJob requires only a reference to a target engine as input. DCT will take care of syncing the job to
the target engine and executing it. DCT will create and manage the environment where the job is copied onto.

Example of executing a MaskingJob on engine with ID 2:

curl -X 'POST' \

'"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead/
execute' \

-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H 'Content-Type: application/json' \

_d l{

"engine_id": "2"

} 1

This will return a DCT job that can be further polled for status updates. The job will only transition to the
COMPLETED state when the entirety of the sync and execution has completed on the target engine.

When a MaskingJob is executed via DCT and the job is synced to the target engine, the default Connector is used for
execution. Masking job sync never copies credentials, for security reasons. Since having credentials set on the
target connector is required for execution, DCT enables this by allowing users to store connector credentials within
DCT itself. A DCT MaskingJob now contains properties for the connector credentials. The expectation is that users
will pre-store the credentials by using the UPDATE APl on the MaskingJob. MaskingJob execution has a hard
requirement that credentials be saved within a MaskingJob prior to allowing execution.

Example of updating a MaskingJob with connector credentials:

curl =X '"PATCH' \

Continuous Compliance workflows - 169



Data Control Tower - Data Control Tower Home

'https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead'
\

-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H 'Content-Type: application/json' \

_d l{
"connector_username": "userl23",
"connector_password": "passwordl23"

} ]

Once a MaskingJob execution has been initiated, the EXECUTION APIs can be used to view and cancel running
executions as well as search through execution history. Note that canceling an execution is a best-effort action that
does not interrupt any of the job sync that may occur prior to the execution.

Example of searching for executions of a particular MaskingJob:

"https://<APPLIANCE_ADDRESS>/v3/executions/search' \

-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H 'Content-Type: application/json' \

-d '{

"filter_expression": "masking_job_id eq '\''d53812ce-9186-485d-
a388-44bc52087ead'\'"'"
}l

Example of canceling an execution if and only if it is in the RUNNING state (denoted by the expected_status
query parameter):

curl -X 'POST' \
"https://<APPLIANCE_ADDRESS>/v3/executions/11397caa-6006-4eba-b575-ae3ad00c3762/
cancel' \
-H 'accept: */*' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d '{
"expected_status": "QUEUED"
}l

7.4.3.1 Userinterface

Execute a compliance job with the Execute action, available in the action menu on the top right corner of the job
details page. This will open a window that lists Compliance engines with which a job needs to be executed. Once
selected, click the "Execute" button to start the job on the selected engine. The screenshot below shows a selected
engine.
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7.4.4 Migrate job

& Compliance Engines limit any syncing operations while a profiling or masking job is running. When using
DCT job move, execute, or migrate operations, please ensure that the target Compliance Engine is in an
idle state. Future Compliance enhancements to DCT will remove this limitation.

The Migrate endpoint moves a job from one engine to another without any duplicates. This endpoint is useful for
consolidating masking jobs (i.e. moving jobs to a fresh engine ahead of the original being retired or consolidating
two development engines into a single one for administrative simplicity). This means that a job will continue to
have only a single instance with no additional jobs being created. This job will maintain its same reference within
DCT.

/Migrate
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Example of finding all MaskingJobs originating from engine with ID 2:

curl -X 'POST' \
'https://<APPLIANCE_ADDRESS>/v3/masking-jobs/source-engines/search' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d '{
"filter_expression": "source_enigne_id eq "\''2"\'"'"

} 1

Example of migrating a MaskingJob to new source engine with ID 3 and placing it in the ‘prod-env’
environment:

curl -X 'POST' \
'"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead/
migrate' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
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-H 'Content-Type: application/json' \

-d l{
"target_engine_id": "3",
"target_environment_id": "prod-env"

} ]

7.4.5 Deletejob

Calling the DELETE API on a MaskingJob will effectively remove the record from DCT (and its execution history) as
well as delete the actual masking job on the source engine and on any other engine where the job has been copied
to (as a result of execution). The APl includes a force option to prevent the action from failing in the event that an
engine is unreachable.

Example of deleting a MaskingJob with the force option:

curl -X 'DELETE"' \
"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead?
force=true' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>'

This will return a DCT Job that can be further polled for status updates. Note that if the force option is used and
there are ignored errors, details about those errors will be included in the error_details and warning_message
fields of the DCT Job as follows:

"job": {
"jd": "722ba51cf70e4e32adbd192b07304bb5",
"status": "COMPLETED",
"type": "MASKING_JOB_DELETE",
"error_details": "Unable to connect to the engine.",
"warning_message": "Failed to remove local MaskingJob, engineId: 3

localMaskingJobId: 7.",

"target_id": "d53812ce-9186-485d-a388-44bc52087ead",
"start_time": "2022-01-02T05:11:24.148000+00:00",
"update_time": "2022-01-02T06:11:24.148000+00:00"

}
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8 Integrations

Data Control Tower provides a global integration layer for a connected Delphix ecosystem, whether that is a single
or dozens of globally distributed engines, DCT drives a scalable approach to integrating Delphix into any custom
script or automation toolchain.

Aside from the comprehensive API layer (see API references(see page 187) for more detail), DCT powers automation
through Delphix-built and supported integrations with popular applications such as Terraform, ServiceNow, etc.

To see a current list of Delphix integrations, please visit Delphix Integrations*® for more detail.

45 http://ecosystem.delphix.com
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9 DCT concepts

9.1 Introduction

Data Control Tower (DCT) provides new and novel approaches to general Delphix workflows, delivering a more
streamlined developer experience. This article will introduce these concepts to Delphix and how they work with
DCT.

B For VDB Provisioning, the Ul supports these data platforms:
+ Oracle Single Instance Single Tenant
+ Oracle Single Instance Multi Tenant (for Linked CDB only)
+ MSSql Single Instance

For Infrastructure Connection Wizard, only UNIX standalone environments can be added via the Ul.

9.2 Concepts

9.2.1 Virtual Database (VDB) groups

Virtual Database (VDB) groups are a new concept to Delphix, which enable the association of one or more VDBs as a
single VDB group. This allows for bulk operations to be performed on the grouped VDBs, such as bookmark,
provision, refresh, rewind, and others. This will assist in complex application testing scenarios (e.g. integration and
functional testing) that require multiple data sources to properly complete testing.

With VDB groups, developers can now maintain data synchronicity between all grouped VDBs, which is particularly
useful for complex timeflow operations. For example, updating VDBs to reflect a series of schema changes across
data sources, or to reflect an interesting event in all grouped datasets. In order to maintain synchronicity among
grouped datasets, timeflow operations (refresh, rewind, etc.) must use a bookmark reference.

@ e Ol e el R S R i
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In the above example, a VDB Group reference is created for three VDBs. At the end of the above timeline group, a
developer decides to rollback those VDBs to a previous snapshot. By issuing a single command via the VDB groups
endpoint, DCT will move all three back, ensuring that they all maintain referential synchronicity.

Bookmarks and VDB groups are loosely related; a VDB group can exist in the absence of any bookmarks, and a
bookmark can exist without any VDB group. It is important to note that the bookmark represents data, while the
VDB group represents the databases to make this data available.

a DCT will automatically stop an operation from executing if one or more objects are incompatible (e.g.
provisioning a VDB group into a set of environments, where one of the VDBs is incompatible, such as an
Oracle on Linux VDB provisioned onto a Windows environment).

VDB groups based operations will return a single job to monitor the overall status of the series of
individual VDB operations. If one of those individual operations is unable to complete, DCT will report a
“fail”, but any individual operations that are able to successfully complete will still do so.

9.2.2 Comparing Self-Service containers to VDB groups

As mentioned above, VDB groups are a crucial DCT concept that enable Self-Service functionality outside of the
Self-Service application. Consider VDB groups acting similarly to Self-Service containers, in that it provides
grouping and synchronization among VDBs, but VDB groups can provide a more flexible approach for users. Here
are some additional points for example:

+ The same VDB can be included in multiple VDB groups

+ Including a VDB in a VDB group does not prevent operations on the VDB individually
+ VDBs can be added to or removed from VDB groups

+ VDB groups do not have their own timeline

9.2.3 Bookmarks

DCT Bookmarks are a new concept that represents a human-readable snapshot reference that is maintained within
DCT. This is not to be confused with Self-Service bookmarks, maintained separately within the Self-Service
application. With DCT Bookmarks, developers can now reference meaningful data (e.g. capturing a schema version
reference to pair with an associated code version, capturing test failure data so that developers can reproduce the
error in a developer environment, etc.) and use those references for any number of use-cases (e.g. versioning data
as code, quickly provisioning a break/fix environment with relevant data, etc.). DCT Bookmarks are compatible with
both VDBs and VDB groups, and can be used as a reference for common timeflow operations such as:

+ Provisioning a VDB or VDB group from a bookmark
+ Refreshing a VDB or VDB group to a bookmark
+ Rewinding a VDB or VDB group to a bookmark

(@ DCT Bookmarks have associated retention policies, the default value is 30 days, but policies can be
customized anywhere from a day to an infinite amount of time. Once the Bookmark expires, DCT will
delete the bookmark.

Bookmarks are compatible with individual VDBs and VDB groups. Bookmark Sharing is only available for
engines on version 6.0.13 and above.

DCT Bookmarks, when created, initiate a snapshot operation on each and every VDB in order to maintain
synchronicity between each VDB. In that same vein, bookmark-based VDB group operations will have each
VDB-specific sub-process run in parallel (as opposed to sequentially) to reduce drift between grouped
VDBs.

DCT concepts - 175



Data Control Tower - Data Control Tower Home

9.2.4 Jobs

Jobs in DCT are the primary means of providing operation feedback (PENDING, STARTED, TIMEDOUT, RUNNING,
CANCELED, FAILED, SUSPENDED, WAITING, COMPLETED, ABANDONED) for top-level operations that are run on DCT.
Top-level operations represent the parent operation that may have one or more child-based jobs (e.g. refreshing a
VDB group is the parent job to all of the individual refresh jobs for the grouped VDBs under the VDB group
reference).

Top-level jobs will report a “FAILED” status if one or more child jobs fail. For child jobs that can complete,
DCT will continue to complete those jobs even if a parent job reports a failure.

9.2.5 Tags

DCT Tags enable a new business metadata layer for users and consumers to filter, sort, and identify common
Delphix objects, to power any number of business-driven workflows. A tag is comprised of a (Key:Value) pair that
associates business-level data (e.g. location, application, owner, etc.) with supported objects. DCT 2.0 and above
support the following Tags:

« Continuous Data Engines
« Environments

« dSources

« VDBs

Developers and administrators add and remove tags using tag-specific object endpoints (e.g. /vdbs/{vdbId}/

tags ) and can leverage tags as search criteria when using the object-specific search endpoints (e.g. using filtering
language to narrow results).

Some sample tag-based use-cases include:

+ Refreshing all the VDBs owned by a specific App Team using an “Application: Payment Processing” tag. This
would be accomplished by querying “what VDBs have the (Application: Payment Processing) tag" and
feeding those VDB IDs into the refresh endpoint.

» Driving accountability for VDB ownership by tagging primary and secondary owners for each VDB (e.g.
(primary_owner: John Smith), (secondary_owner: Jane Brown)). That way, if a VDB is overdue for a refresh,
tracking down an owner is a simple tag query.

E Tags are registered as an attribute that is specific to an object as opposed to a central tagging service. As
a result, tag-based querying can only be done on a per-object type basis.

A supported object can contain any number of tags.

9.2.6 Tag-based filtering

All taggable objects support tag-based filtering for API queries that adhere to the search standards documented in
AP| References(see page 187). A few examples of how tag-based filtering can be used are as follows:

ListallVDBs of type 'Oracle' , of which IP address containsthe '10.1.100" string and which have been
tagged with the 'team' tag, 'app-dev-1'.
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database_type EQ 'Oracle' AND -ip_address CONTAINS '10.1.100' and tags CONTAINS { key
EQ 'team' AND value EQ 'app-dev-1'}

9.3 Nuances

9.3.1 Stateful APIs

All applicable DCT APIs are stateful so that running complex queries against a large Delphix deployment can be
done rapidly and efficiently. DCT accomplishes this by periodically gathering and hosting telemetry-based Delphix
metadata from each engine.

9.3.2 Local data availability

DCT currently relies on existing Continuous Data and Compliance constructs around data-environment-engine
relationships. This means that DCT operations require VDBs to live on the engine where the parent dSource lives
and so on.

9.3.3 Engine-to-DCT API mapping

Wherever possible, DCT has looked to provide an easier-to-consume developer experience. This means that in some
cases, an APl on DCT could have an identical APl on an engine. However, there are many instances of providing a
higher level abstraction for ease of consumption; one example is the data inventory APIs on DCT (sources,
dSources, VDBs), which are a simplified representation of data represented by the source, sourceconfig, and
repository endpoints on the local engine (source, dSource, and VDB detail are all combined under those three
endpoints).

9.3.4 Local references to global UUIDs

In order to avoid collision of identically-named and referenced objects, DCT generates Universally Unique
IDentifiers (UUID) for all objects. For existing objects on engines like dSources and VDBs, DCT will concatenate the

local engine reference with the engine UUID (e.g. 'Oracle-1' onengine '3cec810a-
eedf-1lec-8ea0®-0242ac120002"' will berepresentedas 'Oracle-1-3cec810a-
ee0f-11ec-8ea®-0242ac120002"' on DCT).

9.3.5 Environment representations

Environments within Delphix serve as a reference for the combination of a host and instance. This is coupled with
the fact that environments can be leveraged by multiple engines at the same time and that engines often have a
specific context to some of the elements that comprise an environment. For example, an environment could have
both an Oracle and ASE instance installed and that Engine A leverages an Oracle-based workflow and Engine B
leverages an ASE workflow. DCT will create two identifiers to represent the specific host and instance combinations.
Thus, in DCT, Engine A will be connected to a different uniquely identified Environment than Engine B.

As mentioned earlier with Engine-to-DCT APl mapping, DCT aims to simplify the user experience with Delphix APIs
by combining different Continuous Data endpoints into a simplified DCT API. The Environment API does this by
combining environment, repository, and host endpoints so that writing queries against Delphix data is a much
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simpler process. One example would be identifying all environments that have a compatible Oracle home for
provisioning;:

repositories CONTAINS { database_type EQ 'Oracle' and allow_provisioning EQ true AND
version CONTAINS '19.2.3'}

9.3.6 Supported data sources/configurations

DCT is compatible with all Delphix-supported data sources and configurations.

9.3.7 Process feedback

Whenever a DCT request completes, it will return a JOB ID as its response. This Job ID can be used in conjunction
with the jobs endpoint to query the operation status.
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10 DCT Toolkit

10.1 Introduction

DCT Toolkit (dct-toolkit) is the command line application specifically designed to interact with a particular DCT
instance. It aims to simplify and ease out interacting with DCT instances while making the process intuitive, with
minimal configuration and setup. dct-toolkit abstracts all of the API level implementation complexities and
provides a user friendly LINUX-like interface, which can be run from any terminal.

10.2 Compatibility

dct-toolkit is designed to be compatible with any DCT product version, but is fully supported from DCT version 8.0.0
onwards. While dct-toolkit can be used in testing or development environments against any DCT versions, Delphix
highly recommends at least DCT version 8.0.0 for using it in the production environment. Some of the value added
features are only supported from DCT 8.0.0 version onwards.

dct-toolkit does not need to be upgraded with every new version of DCT. All of the new APIs that are part of the
newer DCT releases will automatically be available in dct-toolkit. This is possible because dct-toolkit reads the api
specification from the DCT instance (configurable) it is configured to connect to and dynamically generates the list
of commands and their respective options.

10.3 Installation

Currently dct-toolkit is supported on Linux, Windows and macOS platforms. There are no special system
requirements for running dct-toolkit.

Installing dct-toolkit is as simple as downloading the executable binaries from the downloads URL*® and extracting
it to the machine from where it needs to run. Once the executable binary is extracted, grant the execute permission
to the binary file.

On Linux and macOS this can be done from Terminal via:

chmod 777 ./dct-toolkit

For Windows this can be done from cmd via:

CACLS files /e /p <username>:F

Where <username> isthe user to whom the permission must be granted, F is the Full Control permission that
needs to be granted.

B For macOS currently the binary is not verified hence macOS will give warning that the binary is untrusted.
To get around this issue for now you will need to open this binary and explicitly whitelist it. One easy way
to achieve this is to press CTRL key and click on the binary file and then select Open. On the resulting
warning message dialog box select Open. Now the binary is allowed to be executed from the terminal.

46 https://download.delphix.com/folder/4720/Delphix%20Product%20Releases/DCT/Toolkit%20(CLI)
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A plain text configuration file is needed to get started. The recommended way to create this configuration file is via

the create_config command, available in dct-toolkit.

For creating a typical configuration with only the required properties, the following command can be used:

dct-toolkit create_config dctUrl=<URL of DCT -dinstance> apiKey=<api key value>

This will create the configuration file in the default location under the user's home directory. The full path for
configuration file will be: <users home directory>/.dct-toolkit/dct-toolkit.properties

create_config command takes in below mentioned options:

Option name

dctUrl

apiKey

configFileOutputLoca

tion

apiVersion

apiYamlLocation

--insecureSSL

Required/Optional

Required

Required

Optional

Optional

Optional

Optional

Description

HTTP/S URL of the DCT instance.

API key of the account used to connect to the
DCT instance pointed by the dctUrl option.

Fully qualified path of the properties file. If this
option is not specified, the properties file will be
createdinthe .dct-toolkit folderunder
the user's home directory. If this option is
specified, the DCT_TOOLKIT_CONFIG_FILE
environment variable needs to be exported to

point to the config file, in order for the config file
to be effective.

APl version to be used for DCT APIs. If this is not
set then the latest API version from the DCT
instance.

Location of the local api.yamlfile. If this is not
set, the latest api.yaml file will be downloaded
from the DCT instance that is configured.

Whether to use insecure SSL connection to the
DCT instance. By default this will be set to false.
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S Optional Whether to disable hostname verifier checks for
SSL connection to the DCT instance. By default

unsafeHostnameCheck this will be set to false.

sslCertificate Optional PEM format SSL certificate path to be used for
SSL connection to DCT instance.

logLevel Optional Log level to set. Can be one of OFF, ERROR,
WARN, INFO, DEBUG, TRACE, ALL. By default log
level will be INFO.

logDir Optional Directory where the logs should be written. By
default, logs will be written to the logs directory

created underthe .dct-toolkit folderin
the user's home directory.

All of these options and help can also be requested via:

./dct-toolkit create_config -h

All of the above properties can also be individually specified using environment variables. Environment variable
mappings for each of the above properties is as follows:

Property Name Environment Variable Name

dctUrl DCT_TOOLKIT_DCT_URL

apiKey DCT_TOOLKIT_API_KEY

apiVersion DCT_TOOLKIT_API_VERSION
apiYamlLocation DCT_TOOLKIT_API_YAML_LOCATION
-—-insecureSSL DCT_TOOLKIT_SSL_INSECURE
—--unsafeHostnameCheck DCT_TOOLKIT_SSL_UNSAFE_HOSTNAME_CHECK
sslCertificate DCT_TOOLKIT_SSL_CERT

logLevel DCT_TOOLKIT_LOG_LEVEL
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logDir DCT_TOOLKIT_LOG_DIR

It’s acceptable to configure non-sensitive properties in a properties file and sensitive properties (like apiKey )via

an environment variable. Properties set via environment variable will take precedence over the ones specified in
the properties file.

Once the required properties are available via either the properties file or via the environment variable, dct-toolkit
is ready for use.

10.5 Usage guide

All of the DCT APIs are available as commands in dct-toolkit. To find the list of all commands which are available,
use the command:

./dct-toolkit -h

This will print the list of all commands grouped by the appropriate entity names.

10.6 Examples

1. Thelist of available options for a particular command can be requested via:

./dct-toolkit <command_name> -h

2. There are currently a lot of options for provisioning a VDB, some options are only valid for a particular DB
type. For example, the unique_name option is only applicable to Oracle DBs. For better ease of use, dct-

toolkit has subcommands created under the provisioning command, with options that are relevant to that
particular subcommand. For example, these are the subcommands under the

provision_vdb_by_snapshot command:

oracle
sybase
mssql
appdata
postgres

For provisioning an Oracle VDB, the following command can be used:

dct-toolkit provision_vdb_by_snapshot oracle source_data_id=<dsourceld> --
auto_select_repository unique_name=<uniqueName>

For provisioning a Sybase-ASE VDB, the following command can be used:
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dct-toolkit provision_vdb_by_snapshot sybase source_data_id=<dsourceld> --
auto_select_repository —--truncate_log_on_checkpoint

3. For getting the list of registered engines, the following command can be used:

dct-toolkit get_registered_engines

The above command will only print important fields in the response. For printing all of the fields in the response,
use:

-A/--all-columns

Option:

dct-toolkit get_registered_engines -A

There is also an option to list only the selected columns that are useful to the user:

--columns/-c

Option:

dct-toolkit get_registered_engines --columns=id,name,cpu_core_count...

For advanced use cases, dct-toolkit also provides an option to specify a jsonpath*’

objects from the JSON response. This can be requested with:

expression to extract required

--jsonpath/-jp

Option:

dct-toolkit get_registered_engines --jsonpath=<json path expression starting with $>
Note, these options are available for all of the commands available in dct-toolkit.

4. Forcommands that use a request body, dct-toolkit provides —-body , which can be used to specify a JSON
body (instead of using individual options).

dct-toolkit token_info --body=<JSON body to POST to DCT>

47 https://github.com/json-path/JsonPath
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Help regarding the exact structure of JSON request and response body can be requested for all of the commands
via:

-jh/--jsonhelp

Option:

dct-toolkit token_info -jh

5. dct-toolkit provides an easy to use and understand format for specifying tags. Example, this command to
add two tags: {key=purpose, value=testing} and {key=keyl, value=valuel}:

dct-toolkit create_environment_tags environmentId=<envId> tags purpose=testing
keyl=valuel

6. Some of the DCT APIs trigger an asynchronous job and return a jobld in response. dct-toolkit, by default, will
wait for the asynchronous job to get completed and will report the end state of the job. There is an option to

NOT wait for the completion of an asynchronous job. For example, to NOT wait, use the ——no-wait

option:

dct-toolkit refresh_environment environmentId=<envId> --no-wait

10.7 Logging

dct-toolkit has inbuilt logging support which will export all of the logs to a default location which is under the user's
home directory. The full path willbe <user home directory>/.dct-toolkit/logs .dct-toolkitcreatesa
separate log file for every date.

Log level and log directory are both configurable and can be specified in the configuration file or via the
environment variable. Please refer to the Setup section above for more information.
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11 Developerresources

11.1 APIrequests and reporting

11.1.1 Introduction

This article showcases example requests to the various data APIs supported by DCT.

DCT provides interactive APl documentation that allows users to experiment with the APIs in their web browser.
The interactive APl documentation can be accessed by entering the hostname for DCT and the /api path into a

browser's address bar. For example, if DCT is running on host gateway.example.com,thenenter https://

gateway.example.com/api intothe browser's address bar.

To simplify development, Python and Go programming libraries are available. The Python bindings can be found
on PyPi here*®, The latest version can be installed with the following command:

pip install delphix-dct

The Go bindings can be found on go.dev here®.

11.1.2 Engines

This section showcases some examples of querying the Engines endpoint for information about connected Delphix
Virtualization Engines. These examples leverage the generated Python bindings:

import delphix.api.gateway

import delphix.api.gateway.configuration

import delphix.api.gateway.api.management_api

cfg = delphix.api.gateway.configuration.Configuration()
cfg.host = "https://localhost/v2"

# For example purposes

cfg.verify_ssl = False

# Replace the string with your own API key

cfg.api_key['ApiKeyAuth'] = 'apk 3.tEd4DXFce'

api_client = delphix.api.gateway.ApiClient(configuration=cfg)

engines_api = delphix.api.gateway.api.management_api.ManagementApi(api_client)

print(engines_api.get_registered_engines())

The result should appear similar to the following:

48 https://pypi.org/project/delphix-dct-api/
49 https://pkg.go.dev/github.com/delphix/dct-sdk-go
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[{'connection_status': 'ONLINE',

'cpu_core_count': 2,
'data_storage_capacity': 23404216320,
'data_storage_used': 11589626880,
'"hostname': 'avm.delphix.com',

'id': 1,

"insecure_ssl': True,

'memory_size': 8589934592,

'name': 'vmname',

"password': 'kkkxkk!'

'status': 'CREATED',

"tags': [],

'type': 'UNSET',
'unsafe_ssl_hostname_check': False,
'username': 'admin',

'uuid': 'ec2fbfea-928b-07f8-94c4-29feab614624f"
'version': '6.1.0.0'}]}

11.2 API references

(Open APl documentation is only available to view online)
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